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Intr oduction

Welcometo theRedHat EnterpriseLinuxStepByStepGuide!

By now, you shouldhave readtheRedHat EnterpriseLinux InstallationGuideandsuccessfullyin-
stalledRedHat EnterpriseLinux. This manualis designedto helpnew andintermediateLinux users
navigateandperformcommontasks.Keepin mind thatLinux looks,feels,andperformsdifferently
from otheroperatingsystemsyoumayhaveused.Forgetabouttheconventionsof otheroperatingsys-
temsand,with anopenmind,approachRedHat EnterpriseLinux asa new, interesting,andversatile
alternative.

This manualis task-oriented.You will �nd usefultips,hints,warnings,andscreenshotsinterspersed
throughout.First, you will learnthebasicsof usingRedHat EnterpriseLinux, suchascustomizinga
desktop,con�guring a printer, andgettingonline.Oncethe basicsarecovered,the taskscoveredin
thismanualbecomeprogressively moreadvanced.

Mostuserschooseto work within eithertheGNOMEor KDE graphicaldesktopenvironments(other
desktopenvironmentsarealsoavailable).TheRedHat EnterpriseLinux StepBy StepGuidefocuses
primarily onhow to performtasksin thesetwo environments.

Topicsdiscussedinclude:

• Usingthegraphicaldesktopenvironment

• Managing�les anddirectories

• Workingwith documents

• UsingtheWebandemail

• Workingwith adigital camera

After conqueringthe basicsof your RedHat EnterpriseLinux system,you may needinformation
on more advancedtopics. You can �nd this information in the RedHat EnterpriseLinux System
Administration Guide, theRedHat EnterpriseLinux ReferenceGuide, theRedHat EnterpriseLinux
Introductionto SystemAdministration, andtheRedHat EnterpriseLinuxSecurityGuide.

HTML, PDF, andRPM versionsof themanualsareavailableon theRedHat EnterpriseLinux Docu-
mentationCD andonlineat http://www.redhat.com/docs/.

Note

Although this manual re�ects the most current information possible, read the Red Hat Enterprise
Linux Release Notes for information that may not have been available prior to our documenta-
tion being �naliz ed. They can be found on the Red Hat Enterprise Linux CD #1 and online at
http://www.redhat.com/docs/.

1. Chang es to This Manual
Thismanualwaspreviouslypublishedunderthetitle RedHat LinuxGettingStartedGuide. It hasbeen
renamedandincorporatedinto theRedHatEnterpriseLinux documentationset.It hasbeenmodi�ed
to includenew featuresin RedHat EnterpriseLinux 3 andre�ect changesin documentedprocedures
thatarenotsupportedin RedHatEnterpriseLinux. Changesto this manualinclude:
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GettingStartedWith GNUPrivacyGuard

Thisnew chapterdiscussessendingandreceiving secureemailusingGNU Privacy Guard(GPG).
Thechapterdiscussesthecon�gurationandusageof GPGwith anemailclient.

DiskettesandCD-ROMs

ThesectiondiscussingX-CD-Roast wasremovedasit is no longerincludedin RedHat Enter-
priseLinux.

EmailApplications

The sectiondiscussingpine was removed as it is no longer includedin Red Hat Enterprise
Linux.

2. Document Conventions
When you readthis manual,certainwords are representedin different fonts, typefaces,sizes,and
weights.This highlightingis systematic;differentwordsarerepresentedin thesamestyleto indicate
their inclusion in a speci�c category. The typesof words that arerepresentedthis way include the
following:

command

Linux commands(andotheroperatingsystemcommands,whenused)arerepresentedthis way.
This style shouldindicateto you that you can type the word or phraseon the commandline
andpress[Enter] to invoke a command.Sometimesa commandcontainswordsthatwould be
displayedin adifferentstyleontheirown (suchas�le names).In thesecases,they areconsidered
to bepartof thecommand,sotheentirephraseis displayedasacommand.For example:

Usethecat testfile commandto view thecontentsof a�le, namedtestfile , in thecurrent
workingdirectory.

file name

File names,directorynames,paths,andRPMpackagenamesarerepresentedthisway. Thisstyle
shouldindicatethataparticular�le or directoryexistsby thatnameonyour system.Examples:

The.bashrc �le in yourhomedirectorycontainsbashshellde�nitions andaliasesfor yourown
use.

The /etc/fstab �le containsinformationaboutdifferentsystemdevicesand�le systems.

Install thewebalizer RPMif youwantto useaWebserver log �le analysisprogram.

application

Thisstyleindicatesthattheprogramis anend-userapplication(asopposedto systemsoftware).
For example:

UseMozilla to browsetheWeb.

[key]

A key on thekeyboardis shown in thisstyle.For example:

To use[Tab]completion,typein acharacterandthenpressthe[Tab]key. Your terminaldisplays
thelist of �les in thedirectorythatstartwith thatletter.
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[key]-[combination]

A combinationof keystrokesis representedin this way. For example:

The[Ctrl]-[Alt]-[Backspace]key combinationexits your graphicalsessionandreturnyou to the
graphicallogin screenor theconsole.

text found on a GUI interface

A title, word, or phrasefoundon a GUI interfacescreenor window is shown in this style.Text
shown in this style is beingusedto identify a particularGUI screenor an elementon a GUI
screen(suchastext associatedwith acheckboxor �eld). Example:

SelecttheRequirePassword checkboxif youwouldlikeyourscreensaver to requireapassword
beforestopping.

top level of a menuon a GUI screenor window

A word in this styleindicatesthat theword is thetop level of a pulldown menu.If you click on
theword on theGUI screen,therestof themenushouldappear. For example:

Under File on a GNOME terminal, the New Tab option allows you to openmultiple shell
promptsin thesamewindow.

If you needto type in a sequenceof commandsfrom a GUI menu,they are shown like the
following example:

Go to Main Menu Button (on thePanel)=> Programming => Emacsto starttheEmacstext
editor.

button on a GUI screenor window

Thisstyleindicatesthatthetext canbefoundonaclickablebuttononaGUI screen.Forexample:

Click on theBack buttonto returnto thewebpageyou lastviewed.

computer output

Text in this styleindicatestext displayedto ashellpromptsuchaserrormessagesandresponses
to commands.For example:

The ls commanddisplaysthecontentsof a directory. For example:
Desktop about.html logs paulwesterberg.png
Mail backupfiles mail reports

The outputreturnedin responseto the command(in this case,the contentsof the directory)is
shown in this style.

prompt

A prompt,which is acomputer's wayof signifying thatit is readyfor you to inputsomething,is
shown in this style.Examples:

$

#

[stephen@maturin stephen]$

leopard login:

user input

Text thattheuserhasto type,eitheron thecommandline, or into a text box on a GUI screen,is
displayedin this style.In thefollowing example,text is displayedin this style:

To bootyour systeminto the text basedinstallationprogram,you musttype in the text com-
mandat theboot: prompt.
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replaceable

Text usedfor exampleswhich is meantto bereplacedwith dataprovidedby theuseris displayed
in this style.In thefollowing example,

�

version-number � is displayedin this style:

The directory for the kernel source is /usr/src/ � version-number � / , where
�

version-number � is theversionof thekernelinstalledon this system.

Additionally, we useseveral differentstrategiesto draw your attentionto certainpiecesof informa-
tion. In orderof how critical the informationis to your system,theseitemsaremarked asnote,tip,
important,caution,or awarning.For example:

Note

Remember that Linux is case sensitive. In other words, a rose is not a ROSE is not a rOsE.

Tip

The directory /usr/share/doc/ contains additional documentation for packages installed on your
system.

Impor tant

If you modify the DHCP con�gur ation �le , the changes will not take effect until you restart the DHCP
daemon.

Caution

Do not perform routine tasks as root — use a regular user account unless you need to use the root
account for system administration tasks.

Warning

Be careful to remove only the necessary Red Hat Enterprise Linux partitions. Removing other parti-
tions could result in data loss or a corrupted system environment.
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3. Copying and Pasting Text With X
Copying andpastingtext is easyusingyour mouseandtheX Window System.To copy text, simply
click anddragyour mouseover thetext to highlight it. To pastethetext somewhere,click themiddle
mousebuttonin thespotwherethetext shouldbeplaced.

4. Using the Mouse
RedHat EnterpriseLinux is designedto usea three-button mouse.If you have a two-buttonmouse,
youshouldhaveselectedthree-buttonemulationduringtheinstallationprocess.If you'reusingthree-
buttonemulation,pressingbothmousebuttonsat thesametime equatesto pressingthemissingthird
(middle)button.

In thisdocument,if youareinstructedto click with themouseonsomething,thatmeansclick theleft
mousebutton.If youneedto usethemiddleor right mousebutton,thatwill beexplicitly stated.(This
will bereversedif you've con�guredyourmouseto beusedby a left handedperson.)

Thephrase"draganddrop" maybefamiliar to you. If you're instructedto draganddropanitem on
your GUI desktop,click on somethingandhold the mousebutton down. While continuingto hold
down themousebutton,dragtheitem by moving themouseto anew location.Whenyou've reached
thedesiredlocation,releasethemousebuttonto droptheitem.

5. We Need Feedbac k!
If you spota typographicalerror in theRedHat EnterpriseLinux StepBy StepGuide, or if you have
thoughtof a way to make this manualbetter, wewould love to hearfrom you! Pleasesubmita report
in Bugzilla:http://bugzilla.redhat.com/bugzill a/) againstthecomponentrhel-sbs.

Whensubmittingabug report,besureto mentionthemanual's identi�er:

rhel-sbs(EN)-3-Print-RHI (2003-11-12T01:05)

If you have a suggestionfor improving thedocumentation,try to beasspeci�c aspossiblewhende-
scribingit. If youhavefoundanerror, pleaseincludethesectionnumberandsomeof thesurrounding
text sowecan�nd it easily.

6. Sign Up for Suppor t
If you have a variantof RedHat EnterpriseLinux 3, pleaserememberto signup for thebene�tsyou
areentitledto asaRedHat customer.

Registrationenablesaccessto the RedHat Servicesyou have purchased,suchastechnicalsupport
andRedHat Network. To registeryour product,go to:

http://www.redhat.com/apps/activate/

Note

You must activate your product before attempting to connect to Red Hat Network. If your product
has not been activated, Red Hat Network rejects registration to channels to which the system is not
entitled.
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Goodluck, andthankyou for choosingRedHatEnterpriseLinux!

TheRedHat DocumentationTeam



I. Star ting Out

To begin the journey of usingyour RedHat EnterpriseLinux system,you needto learnthe basics.
This part introducesthe conceptsand termsthat help you get the mostout of RedHat Enterprise
Linux, and learnsomeof its exciting features.From con�guring your systemwith SetupAgent to
usingyour graphicaldesktopandtheshellprompt,this parthelpsyou getacquaintedwith your Red
HatEnterpriseLinux system.

Table of Contents
1. Getting Started................................................................................................................................ 1
2. Using the Graphical Desktop....................................................................................................... 15
3. Shell Prompt Basics...................................................................................................................... 25
4. Managing Filesand Directories................................................................................................... 47





Chapter 1.

Getting Star ted

From bootingup to shuttingdown, whetheryou areworking or playing,RedHat EnterpriseLinux
provides tools andapplicationsto help you get the mostout of your computingenvironment.This
chapterguidesyou throughsomebasictasksthatyoucanperformon yourRedHat EnterpriseLinux
system.

1.1. Setup Agent
The �rst time you startyour RedHat EnterpriseLinux system,the Setup Agent is presented.The
SetupAgent guidesyou throughthecon�gurationof your RedHat EnterpriseLinux system.Using
this tool, you cansetyour systemtime anddate,addusersto your system,install software,register
your machinewith theRedHat Network, andmore.Setup Agent allows you to con�gure your en-
vironmentat thebeginning,so thatyou cangetstartedusingyour RedHat EnterpriseLinux system
quickly.

Figure1-1.SetupAgent

TheSetupAgent �rst promptsyouto readandagreeto theLicenseAgreement,whichdiscussesyour
rights in usingRedHat EnterpriseLinux. Click Yes,I agree to the LicenseAgreementandclick
Next to continue.

Impor tant

You must agree to the License Agreement to continue using Red Hat Enterprise Linux. If you choose
No, I do not agree at the License Agreement screen, the machine prompts you to either re-read the
agreement or decline and shutdown your system. You cannot use Red Hat Enterprise Linux without
�rst agreeing to the License Agreement.
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Figure1-2.LicenseAgreement

TheSetupAgent allowsyouto manuallysetyourmachine'sdateandtime,whichadjuststheclockon
your computer's BIOS(BasicInputOutputSystem).To settheday, month,andyearon your system,
usethe calendarinterface.To set your time in hours,minutes,andseconds,usethe provided text
boxes.

Youmayalsosynchronizeyourdateandtimeautomaticallywith anetworktimeserver— acomputer
that sendsaccuratedateandtime settingsto your systemthrougha network connection.Checkthe
box labeledEnable Network Time Protocol andusethedrop-down menuto selectthe time server
youwantto use.Onceyouhave setyour timeanddate,click Next to continue.

Figure1-3.Date and Time Con�guration

Next, you shouldcreatea useraccountto useon a routinebasis.It is not recommendedto log in to
your root accountfor commoncomputingtasks,asyou maydamageyour systemor unintentionally
deletea �le. TheSetupAgent letsyouenterausername,anoptionalfull namefor theaccount,anda
password (whichyou mustentertwice).This createsa useraccountthatyou canuseto log into your
RedHat EnterpriseLinux systemandwhichhasits own homedirectoryon thesystemto store�les.
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Figure1-4.User Account

TheSetupAgent probesyour systemfor soundcardsandattemptsto con�gure thecorrectsettings
for usewith RedHatEnterpriseLinux. Youcanthenclick thePlay testsoundbuttonto playasound
sample.If youcanhearthesample,selectOK andyour soundcardcon�gurationis complete.

Figure1-5.SoundCard

To registeryoursystemwith RedHatNetwork andreceive automaticupdatesof yourRedHatEnter-
priseLinux system,chooseYes,I would lik e to registermy systemwith Red Hat Network. This
will starttheRedHat UpdateAgent— a utility thatguidesyou step-by-stepthroughtheregistration
of your machinewith RedHat Network. SelectingNo, I do not want to register my systemskips
theregistration.For moreinformationaboutRedHat Network andregisteringyour machine,referto
theRedHat Network documentationat http://www.redhat.com/docs/manuals/RHNetwork/.
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Figure1-6.RedHat Network Registration Client

To installRedHatEnterpriseLinux RPMpackagesthatyoudid notinstallduringinstallation,software
from third-partyproviders,or documentationfrom theRedHatEnterpriseLinux DocumentationCD,
youcandosoat theAdditional CDsscreen.InserttheCD containingthesoftwareor documentation
youwantto install,click theInstall... button,andfollow theinstructions.

Note

If you are installing a package from the Red Hat Enterprise Linux Installation CDs, you must insert
CD 1, click the Install... button, choose the package(s) or component you want to install, and, if
prompted, change the CD.

Figure1-7. Installing Additional Software

Now thatyoursystemis con�gured,youarereadyto log in andstartusingRedHatEnterpriseLinux.
PressForward to exit theSetupAgent.

1.2. Introductor y Terms
Whenyou learnabouta new operatingsystem,you shouldalsolearnnew terminology. This section
de�nes a few basictermsyou shouldlearn.You will seethesetermsoften throughoutall RedHat
EnterpriseLinux documentationincludingtheRedHat EnterpriseLinux StepBy StepGuide:
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• Command: An instructiongivento thecomputer, mostoftenwith thekeyboardor mouse.

• Commandline: Thespaceat theshellpromptwherecommandsaretyped.

• Graphical Desktop: The mostvisible areaof a GUI. The desktopis whereyour userHome and
Start Here iconsarelocated.Youcancustomizeyourdesktopto havespecialbackgrounds,colors,
andpicturesto adda personaltouch.

• GraphicalUserInterface(GUI): A generaltermfor interactive windows, icons,menus,andpanels
which allow a userto initiate actionssuchasstartingapplicationsandopening�les usinga mouse
andkeyboard.

• Iconsaresmall imagesrepresentinganapplication,folder, shortcutor systemresource(suchasa
diskettedrive).Launcher iconsusuallyreferto applicationshortcuts.

• Man page andInfo page: Man (shortfor manual)andInfo pagesgive detailedinformationabout
a commandor �le (manpagestendto bebrief andprovide lessexplanationthanInfo pages).For
example,to readthemanpagefor thesu command,typeman su at a shellprompt(or type info
su for theinfo page).To closemanor Info pages,press[q].

• Panel: A desktoptoolbar, usuallylocatedacrossthebottomof your desktop(suchasFigure1-8).
The panelcontainsthe Main Menu buttonandshortcuticonsto startcommonlyusedprograms.
Panelscanalsobecustomizedto suit yourneeds.

Figure 1-8.The DesktopPanel

• Root: Rootis anadministrative useraccountcreatedduringinstallationandhascompleteaccessto
thesystem.You mustbeloggedin asroot to accomplishcertainsystemadministrationtasks,such
aschangingadministrative passwordsandrunningsystemcon�guration tools.Useraccountsare
createdsothattypicalusertaskscanbedonewithout usingtheroot account,which canreducethe
chanceof damagingyourRedHatEnterpriseLinux installationor applicationspermanently.

• RPM: RPM standsfor RPMPackage Manager andis how RedHatbuilds anddeliversits software
�les. An RPMisasoftwarepackage�le youcaninstallonyourRedHatEnterpriseLinux computer.

• Shellprompt: A commandline interfacebetweenthe userandtheoperatingsystem(Figure1-9).
Theshell interpretscommandsenteredby theuserandpassesthemon to theoperatingsystem.
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Figure 1-9.A Shell Prompt

• suandsu-: Thecommandsu givesyouaccessto therootaccountor otheraccountsonyoursystem.
Whenyoutypesu to switchto yourrootaccountwhile still insideyouruseraccountshell,youhave
accessto importantsystem�les thatyoucanchange(or damageif youarenotcareful).Loggingin
with thesu - commandmakesyou root within the root accountshell.Usecautionwhenyouare
logged in asroot.

• X or X WindowSystem: Thesetermsrefer to thegraphicaluserinterfaceenvironments.If you are
"in X" or "runningX", youareworking in aGUI ratherthanaconsoleenvironment.

Although the emphasisthroughoutthis book is on navigation andproductivity using the graphical
desktopenvironment,boththegraphicalandshellpromptmethodsof loggingin andusingyour Red
HatEnterpriseLinux systemarediscussedfor your reference.

1.3. Log ging In
Thenext stepto usingyour RedHat EnterpriseLinux systemis to log in. Whenyou log in, you are
introducingyourself to the system(alsocalledauthentication). If you type the wrongusernameor
password,you will not beallowedaccessto yoursystem.

Unlikesomeotheroperatingsystems,yourRedHatEnterpriseLinux systemusesaccountsto manage
privileges,maintainsecurity, andmore.Not all accountsarecreatedequal:someaccountshave fewer
rightsto access�les or servicesthanothers.

Note

Red Hat Enterprise Linux applications and �les are case sensitive, which means that typing root
refers to a different account than Root . By default, root refers to the root user (also known as the
superuser), or system administrator.

If youhavealreadycreatedandloggedin to auseraccount,youcanskipaheadto Chapter2 Usingthe
GraphicalDesktop. If youcreatedonly therootaccount,referto Section1.6Creatinga UserAccount
to learnhow to setupauseraccount.
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If youdid notcreateauseraccountusingtheSetupAgent, youmustlog in asroot.After youcreatea
useraccount,it is highly recommendedthatyoulog in asthatuserinsteadof rootto preventaccidental
damageto your RedHat EnterpriseLinux installation.

Caution

Because your Red Hat Enterprise Linux system creates the root account during installation, some
new users are tempted to use only this account for all of their activities. This is a dangerous idea,
because the root account is allowed to do anything on the system. You can easily damage your
system by accidentally deleting or modifying sensitive system �les . You may be tempted to forego
creating and using a user account during or after installation, but it is not recommended.

1.3.1. Graphical Login

Whenyour systemhasbooted,a graphicallogin screenis displayedasshown in Figure1-10. Again,
unlessyou havechosento give your machineits own hostname,which is primarily usedin anetwork
setting,your machinewill probablybecalledlocalhost .

Figure1-10.The Graphical Login Screen

To log in asroot from thegraphicallogin screen,typeroot at thelogin prompt,press[Enter], type
therootpassword thatyouchoseduringinstallationat thepasswordprompt,andpress[Enter].To log
in asa normaluser, typeyour usernameat the login prompt,press[Enter], type your password that
youselectedwhencreatingtheuserat thepassword prompt,andpress[Enter].

Loggingin from thegraphicallogin screenautomaticallystartsthegraphicaldesktopfor you.

1.3.2. Vir tual Console Login

During installation,if you selectedan installationtype otherthanWorkstationor PersonalDesktop
andchosetext asyour login type,you will seea login promptsimilar to the following afterbooting
yoursystem:

Red Hat Enterprise Linux release 3
Kernel 2.4.21-3.EL on an i686

localhost login:
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Unlessyouhavechosento giveyourmachineits own hostname,which is primarily usedin anetwork
setting,your machinewill probablybecalledlocalhost.localdomain .

To log in asroot from theconsole,type root at the login prompt,press[Enter], thentype the root
password that you choseduring installationat the password promptandpress[Enter]. To log in as
a normaluser, type your usernameat the login prompt,press[Enter], type your password that you
selectedwhencreatingtheuserat thepassword prompt,andpress[Enter].

After loggingin, youcantypethecommandstartx to startthegraphicaldesktop.

1.4. Graphical Interface
Whenyou installedRedHat EnterpriseLinux you hadtheopportunityto install a graphicalenviron-
ment.Onceyou starttheX Window System,you will �nd a graphicalinterfaceknown asa desktop
similar to Figure1-11.

Figure1-11.The Graphical Desktop

1.5. Opening a Shell Prompt
Thedesktopoffersaccessto ashellprompt, anapplicationthatallows you to typecommandsinstead
of usingagraphicalinterfacefor all computingactivities.While theRedHat EnterpriseLinuxStepBy
StepGuideprimarily focusesonperformingtasksusingthegraphicalinterfaceandgraphicaltools,it
is sometimesusefulandfasterto performtasksfrom a shellprompt.Referto Chapter3 ShellPrompt
Basicsfor furtherdetails.

Youcanopenashellpromptby selectingMain Menu => SystemTools=> Terminal.

You canalsostarta shellpromptby right-clicking on thedesktopandchoosingNew Terminal from
themenu.

To exit a shellprompt,click theX buttonon theupperright cornerof theshellpromptwindow, type
exit at theprompt,or press[Ctrl]-[D] at theprompt.
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1.6. Creating a User Account
Whenyou �rst startedyour RedHat EnterpriseLinux systemafter installation,you weregiven the
opportunityto createoneor moreuseraccountsusingtheSetupAgent. If you did not createat least
oneaccount(not includingtheroot account)you shoulddo sonow. Youshouldavoid working in the
rootaccountfor daily tasks.

Therearetwo waysto createnew and/oradditionaluseraccounts:usingthegraphicalUserManager
applicationor from ashellprompt.

To createauseraccountgraphicallyusingtheUser Manager:

1. Click the Start Here icon on the desktop.In the new window that opens,click the System
Settingsicon, andthenclick the Users& Groups icon. You canalsoselectMain Menu =>
SystemSettings=> Users& Groupsfrom thepanel.

YoucanalsostarttheUserManager by typing redhat-config-users atashellprompt.

2. If youarenot loggedin asroot,you will bepromptedfor your root password.

3. Thewindow shown in Figure1-12will appear. Click Add User.

Figure 1-12.The RedHat UserManager

4. In theCreateNewUserdialogbox,enterausername(thiscanbeanabbreviationor nickname),
thefull nameof theuserfor whomthisaccountis beingcreated,andapassword(whichyouwill
enterasecondtimefor veri�cation). Thenameof thisuser'shomedirectoryandthenameof the
login shell shouldappearby default. For mostusers,you canacceptthedefaultsfor theother
con�gurationoptions.Referto theRedHat EnterpriseLinux SystemAdministration Guidefor
detailsaboutadditionaloptions.

5. Click OK. Thenew userwill appearin theuserlist, signalingthat theuseraccountcreationis
complete.

To createauseraccountfrom ashellprompt:

1. Openashellprompt.

2. If youarenot loggedin asroot, typethecommandsu - andentertheroot password.

3. Typeuseradd followedby aspaceandtheusernamefor thenew accountyouarecreatingatthe
commandline (for example,useradd jsmith ). Press[Enter].Often,usernamesarevariations
on theuser's name,suchasjsmith for JohnSmith.Useraccountnamescanbeanything from
theuser's name,initials, or birthplaceto somethingmorecreative.

4. Typepasswd followedby aspaceandtheusernameagain(for example,passwd jsmith ).
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5. At theNew password: promptenterapassword for thenew userandpress[Enter].

6. At theRetype new password: prompt,enterthesamepassword to con�rm yourselection.

Impor tant

You should take precautions when you choose a password. The password is the key to your
account, so it should be both unique and easy for you to remember. Your password should be
at least six characters. You can use both uppercase and lowercase letters, as well as numbers
and characters. Avoid easy selections, such as qwerty or password . If you want to pick an
easy-to-remember but somewhat unique password, consider a variation of a word, such as
a1rPl4nE for airplane .

1.7. Documentation and Help
Thereareseveral resourcesavailableto get the informationyou needto useandcon�gure your Red
HatEnterpriseLinux system.Along with theRedHatEnterpriseLinux documentationthereareman-
ual pages, documentsthatdetailusageof importantapplicationsand�les; INFO pageswhich break
informationaboutan applicationdown by context-sensitive menus;andhelp �les that areincluded
in themainmenubarof graphicalapplications.You canchooseany methodof accessingdocumenta-
tion thatbestsuitsyour needs,asall of theseresourcesareeitheralreadyinstalledon your RedHat
EnterpriseLinux systemor canbeeasilyinstalled.

1.7.1. Manual Pages

Applications,utilities, andshell promptcommandsusuallyhave correspondingmanualpages(also
calledmanpages)thatshow thereaderavailableoptionsandvaluesof �le or executable.Man Pages
arestructuredin sucha way thatuserscanquickly scanthepagefor pertinentinformation,which is
importantwhendealingwith commandsthatthey havenever previously encountered.

1.7.1.1. Using man

Man Pagescanbeaccessedvia shell promptby typing thecommandman andthenameof the exe-
cutable.For example,to accessthemanpagefor the ls command,typethefollowing:

man ls

TheNAME�eld shows theexecutable's nameanda brief explanationof what functiontheexecutable
performs.TheSYNOPSIS�eld shows thecommonusageof theexecutable,suchaswhatoptionsare
declaredandwhattypesof input (suchas�les or values)theexecutablesupports.TheDESCRIPTION
�eld showsavailableoptionsandvaluesassociatedwith a �le or executable.See Also showsrelated
terms,�les, andprograms.
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Figure1-13.Readinga Man Pagewith the Shell Prompt

To navigatethemanpageyou canusethe[PageDown] and[PageUp] keys or usethe[Spacebar]to
movedown onepageand[B] to moveup.To exit themanpage,type[Q].

To searcha man pagefor keywords type [/] and then a keyword or phraseandpress[Enter]. All
instancesof thekeyword will behighlightedthroughoutthemanpage,allowing you to quickly read
thekeyword in context.

1.7.1.2. Printing a Man Page

Printingmanpagesis a usefulway to archive commonlyusedcommands,perhapsin boundform for
quick reference.If youhaveaprinteravailableandcon�guredfor usewith RedHat EnterpriseLinux
(refer to theRedHat EnterpriseLinux SystemAdministration Guidefor moreinformation),you can
print amanpageby typing thefollowing commandat ashellprompt:

man command| col -b | lpr

Theexampleabovecombinesseparatecommandsintooneuniquefunction.man commandwill output
thecontentsof thecommandmanpageto col , whichformatsthecontentsto �t within aprintedpage.
The lpr commandsendstheformattedcontentto theprinter.

1.7.1.3. The man Man Page

Justlike othercommands,man hasits own manpage.Type man man at the shell promptfor more
information.

1.7.2. Red Hat Enterprise Lin ux Documentation

If you have the RedHat EnterpriseLinux boxed set,rememberto take a look at the RedHat En-
terpriseLinux DocumentationCD. All of the Red Hat EnterpriseLinux manualsare on this CD.
Individual downloadsof our documentationin HTML, RPM, PDF, andcompressedtarball format
(.tar.gz ) arealsoavailableat http://www.redhat.com/docs/.Onceyou have loggedin to your user
account,insertingtheDocumentationCD in yourCD-ROM driveshouldautomaticallystartthePack-
ageManagementTool andallow you to install any of theRedHat EnterpriseLinux documentation.
Follow theinstructionsandchoosethedocumentationyouwould like to install.



12 Chapter 1. Getting Started

Figure1-14.PackageManagementTool Displaying DocumentationAvailable for Installation

After you have installedthedocumentationpackagesyou want,you canaccessthemat any time by
clicking Main Menu => Documentation.

If you have downloadedindividual documentationRPM packagesfrom the Red Hat websiteat
http://www.redhat.com/docs/you can install thesemanualsfrom a shell prompt. Open a shell
prompt,andtypethefollowing at thecommandline:

su -

Press[Enter].You will beaskedfor your root password. Enterthepassword at thepromptandpress
[Enter].Youarenow loggedin asroot.To installall of theRedHatEnterpriseLinux manuals,change
to thedirectorythatcontainstheRPM �les andtypethefollowing:

rpm -ivh rhl-*.rpm

Press[Enter].

To install only certainmanuals,replacerhl-*.rpm with the full �le nameof the manualthat you
wantto install.For example,the�le namefor theRedHat EnterpriseLinux StepBy StepGuidewill
look somethinglike rhl-gsg-en-3.noarch.rpm , soyou would type thefollowing to install it on
yoursystem:

rpm -ivh /mnt/cdrom/rhl- gs g- en-3 .n oarc h. rp m

Press[Enter].Typeexit at thecommandline andpress[Enter].This logsyououtof therootaccount
andbackto youruseraccount.

Now go to Main Menu => Documentationandselectthemanualyouwantto read.

1.8. Log ging Out

1.8.1. Graphical Logout

To log out yourgraphicaldesktopsession,selectMain Menu => Log Out.

Whenthe con�rmation dialog appearsasshown in Figure1-15, selectthe Logout option andclick
theYesbutton.To savethecon�gurationof yourdesktop,aswell asany programswhicharerunning,
checktheSave current setupoption.
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Figure1-15.Logout Con�rmation

1.8.2. Vir tual Console Logout

If youarenot usingtheX Window System,andyou loggedin at theconsole,typeexit or [Ctrl]-[D]
to log outof theconsolesession.

1.9. Shutting Down your Computer
Beforeturning off your computer, it is importantto properlyshutdown RedHat EnterpriseLinux.
Never turn your computeroff without shuttingdown �rst, asyou may loseunsaveddataor damage
yoursystem.

1.9.1. Graphical Shutdo wn

If you arein thegraphicaldesktop,log out of your sessionasdescribedin Section1.8 Logging Out.
From the graphicaldesktoplogoutscreenshown in Figure1-15, selectShutdown andclick OK to
con�rm.

Somecomputersautomaticallyturn the power off after shuttingdown RedHat EnterpriseLinux. If
yourcomputerdoesnot,youcansafelyturnoff thepower to yourcomputerafteryouseethemessage:

Power down.

1.9.2. Vir tual Console Shutdo wn

To shutdown your computerat ashellprompt,typethefollowing command:

halt

Somecomputersautomaticallyturn the power off after shuttingdown RedHat EnterpriseLinux. If
yourcomputerdoesnot,youcansafelyturnoff thepower to yourcomputerafteryouseethemessage:
System halted.
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Chapter 2.

Using the Graphical Desktop

RedHat EnterpriseLinux includesa powerful graphicaldesktopenvironmentwhereyou caneasily
accessyour applications,�les, andsystemresources.Both new andexperienceduserscantake full
advantageof theirRedHatEnterpriseLinux systemsusingthegraphicaldesktop.

This chaptercoversthefundamentalsof thedesktopandhow youcancon�gure it for yourneeds.

2.1. Using the Desktop
Your �rst view of thegraphicaldesktoplookssomethinglike Figure2-1.

Figure2-1.The Graphical Desktop

The graphicaldesktopgives you accessto the applicationsandsystemsettingson your computer.
Notice that it offers threemain tools to make useof the applicationson your system:panelicons,
desktopicons,andmenus.

The long baracrossthebottomof thedesktopis thepanel. Thepanelcontainsapplicationlauncher
icons, a noti�cation areafor noti�cation icons, and small applicationscalled appletsthat let you
controlsoundvolume,switchworkspaces,anddisplaysthestatusof yoursystem.

Theiconselsewhereon thedesktopcanbeshortcutsto �le folders,applicationlaunchers,andshort-
cutsto removabledevicessuchasCD-ROM anddisketteswhenthey have beenmounted.To opena
folderor launchanapplication,double-clickon its icon.

Themenusystemscanbefoundby clicking on theMain Menu button . They canalsobefound

by double-clickingon the Start Here icon on the desktopandthenclicking the Applications
icon.

Thedesktopworksin themanneryoumight expectit to whenworkingwith otheroperatingsystems.
Youcandraganddrop�les andapplicationiconsto areasthatareeasilyaccessible.Youcanaddnew
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iconsfor �les andapplicationsto thedesktop,panel,and�le manager. Youcanchangetheappearance
of mostof thetoolsandapplicationsandchangesystemsettingswith providedcon�gurationtools.

2.2. Using the Panel
Thedesktoppanelis thebarthatstretchesacrossthebottomof thescreenandholdsiconsandsmall
applicationswhich makes usingyour systemeasier. The panelalsoholds the Main Menu, which
containsshortcutsfor all of yourapplications.Appletsembeddedonthepanelallow youto runspeci�c
tasksor monitoryoursystemor serviceswhile remainingoutof yourway. Thenoti�cation areaholds
alerticonssuchastheonefor RedHatNetwork sothatyoucanbequickly alertedto critical messages.

Figure2-2.The Panel

2.2.1. Using the Main Menu

Youcanclick on theMain Menu button to expandit into a largesetof menusthatallow you to
accesstheapplicationsonyour system.

From here,you can start most applicationsincludedin Red Hat EnterpriseLinux. Notice that, in
additionto the recommendedapplications,you canalsoaccessadditionalapplicationswithin each
sub-menu.Thesesub-menusgive youaccessto a full rangeof applicationsonyoursystem.Fromthe
Main Menu, you canalsolog out, run applicationsfrom a commandline, �nd �les, andlock your
screen(which runsapassword protectedscreensaver).

2.2.2. Using Applets

Appletsaresmallapplicationsthatrun on thepanel.Appletslet you monitorvariousaspectsof your
system.Someappletsperformusefultaskswhile othersaredesignedto beentertaining.

Therearea few appletsthatrun on your panelby default. Theseappletsarefairly importantandare
coveredin thefollowing list.

WorkspaceSwitcher

Thegraphicaldesktopgivesyoutheability to usemultipleworkspacessoyoudonothaveto have
all of your runningapplicationscrowding oneviewabledesktoparea.TheWorkspaceSwitcher
representseachworkspace(or desktop)in small squaresandshow the applicationsrunningon
them.Click ononeof thesquareswith yourmouseto moveto thatdesktop.Youcanalsousethe
keyboardshortcut[Ctrl]-[Alt]-[up-arrow], [Ctrl]-[Alt]-[do wn-arrow], [Ctrl]-[Alt]-[right-arrow],
or [Ctrl]-[Alt]-[left-arrow] to switchbetweendesktops.

Figure2-3.WorkspaceSwitcher
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Taskbar

Next to the WorkspaceSwitcher is the Taskbar. The Taskbar is anappletwhich shows you
thetitlesof runningapplicationsonany onevirtual desktop.This is veryhelpful if youdecideto
minimizeanapplicationasit seemsto disappearfrom thedesktop.Onceit disappears,you can
bring it backby clicking on its title in theTaskbar.

Figure2-4.The Taskbar

2.2.3. Using the Noti�cation Area

RedHat Network Alert Noti�cation Tool

Partof theNoti�cation Ar ea, theRedHat Network Alert Noti�cation Tool providesyouwith
aneasyway to make sureyour systemis up-to-datewith currenterrataandbug �x esfrom Red
Hat. The appletshows you different imagesthat indicatewhetheryour systemis up to dateor
needsupgrades.If you click on theicon,a list of availableupdatesis displayed.To updateyour
system,click thebuttonto launchtheRedHat UpdateAgent. If youarenotregisteredwith Red
Hat Network, it launchestheregistrationcomponent.Right-click on theappleticon for a list of
optionsfrom which to choose.

Figure2-5.RedHat Network Alert Noti�cation Tool

TheAuthenticationIcon

The key icon that is sometimesdisplayedin the Noti�cation Ar ea is a securitynoti�cation
thatdisplayswhenever you have gainedroot authenticationfor your system(suchasrunninga
graphicalsystemcon�gurationtool). It disappearswhentheauthenticationtimesout.

Figure2-6.Authentication Icon

Printer Noti�cation Icon

ThePrinter Noti�cation Icon allows you to manageyour print jobs.Click on theicon to view
runningprint jobs,andcanceljobsby right-clickingonthejob andselectingCancel. ThePrinter
Noti�cation Icon only appearsduringanactive print job. If theprint job you have is small,you
maynotseetheiconappear.
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Figure2-7.The Printer Noti�cation Icon

Warning

If you cannot see any of the noti�cation icons, then the noti�cation area was removed from the
desktop panel. To add the it back to your panel, right-click on the panel and choose Add to Panel =>
Utility => Noti�cation Area.

2.2.4. Adding Icons and Applets to the Panel

To make thepanel�t yourneeds,youmaywantto addmoreappletsandlaunchericons.

To addan appletto the panel,right-click in an unusedareaon the panel,selectAdd to Panel, and
choosefrom the varioustypesof applets.Whenyou selectan applet,it appearson your panel.In
Figure2-8, theWeatherReport applethasbeenaddedto show thecurrentlocalweatherandtemper-
ature.

Figure2-8.The WeatherReport Applet on the Panel

To addalaunchericonto thepanel,right-click in anunusedareaonthepanelandselectAdd to Panel
=> Launcher.... This launchesa dialogbox thatallows you to enterthenameof theapplication,and
thelocationandnameof thecommandthatstartstheapplication(suchas/usr/bin/foo ). You can
evenchooseanicon for theapplication.Click OK andthenew launchericonappearson thepanel.

Tip

Another quick and easy way to add a launcher to the panel is to right-click on an unused area of the
panel and choose Add to Panel => Launc her from menu. Then select an application that appears
in the menu. This automatically adds a launcher icon based on the properties of the item in the Main
Menu.

2.2.5. Con�guring the Desktop Panel

You canhide the panelautomaticallyor manually, placeit on any edgeof your desktop,changeits
sizeandcolor, andchangethe way it behaves.To alter the default panelsettings,right-click in an
unusedareaof thepanelandselectProperties. You cansetthesizeof thepanel,its positionon the
desktop,andwhetheryou want thepanelto beautomaticallyhidden(Autohide) whennot in use.If
you chooseto hide thepanel,it doesnot appearon thedesktopuntil you move your mousepointer
over thepanelarea(calledhovering).
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2.3. Using Nautilus
The graphicaldesktopincludesa �le managercalled Nautilus that gives you a graphicaldisplay
of your systemand personal�les. Nautilus is designedto be much more than a visual listing of
�les, however. It allows you to con�gure your desktop,con�gure your Red Hat EnterpriseLinux
system,browseyourphotocollection,accessyournetwork resources,andmoreall fromoneintegrated
interface.In essence,Nautilus becomesashellfor your entiredesktopexperience.

Working in Nautilus is ef�cient andprovides an alternative to searchingthroughthe varioussub-
menusconnectedto theMain Menu or usingashellpromptto navigatethe�le system.Thefollowing
sectionsexplain how to usetheNautilus to enhanceyourdesktopexperience.

To startNautilus asa �le manager, double-clickonyourhomedirectoryicon:

OnceNautilus appears,you cannavigatethroughyour homedirectoryor therestof the �le system.
To returnto your homedirectory, click theHomebutton.

Thebrowserwindow containsfoldersand�les whichyoucandragwith yourmouseto moveandcopy
into new locations.YoucanopenanotherNautilus window by selectingFile => NewWindow. Once
you have anotherNautilus window, you candraganddrop �les to differentdirectories.By default,
dragginga�le from onedirectoryto anothermovesthe�le. To copy the�le to anotherdirectory, press
the[Ctrl] key while dragginganddroppingthe�le.

By default,image�les in yourhomedirectoryareseenasthumbnails. For text �les, thismeansyousee
aportionof theactualtext in theicon.For images,youseeascaled-down (or thumbnail) versionof the
image.To turnoff this feature,selectEdit => Preferences. SelectthePreview tab,thenselectNever
in thedropdown for Show thumbnails. Disablingthis (andother)previewing featuresincreasesthe
speedof Nautilus.

2.4. Star t Here

Figure2-9.The Start Here Window

Start Herewasdesignedto holdall of thetoolsandapplicationsyouneedto accesswhenusingyour
system.From your favorite applicationsto systemandcon�guration tools, the Start Here window
providesacentrallocationfor usingandcustomizingyoursystem.

You canaccessthe Start Here screenat any time by double-clickingon the desktopicon labeled
Start Here.
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The Start Here screenincludesicons that allow you to accessyour favorite applications,desktop
preferences,Main Menu items,server con�gurationtools,andsystemsettings.

Tip

You can add your favorite locations to the Bookmarks . Navigate to the location you want to book-
mark, and then select Bookmarks => Add Bookmark .

2.4.1. Customizing the Desktop

From the Start Here screen,you canselectthe Preferencesicon to con�gure your desktop,which
presentsyou with a wide selectionof con�gurationoptions.Thefollowing lists a few of theoptions
andtoolsin eacharea.

Background

You cancon�gure your backgroundwith new colorsor a new image.To learnmoreaboutcon-
�guring yourdesktopbackground,referto Section2.4.1.1ChangingyourDesktopBackground.

KeyboardShortcuts

You can con�gure shortcuts— pressinga combinationof keystrokes on the keyboard— to
perform actionswithin an applicationor on your desktop.For example,you can con�gure a
shortcutto move from yourcurrentWorkspaceto Workspace2 by pressing[Ctrl]-[F2].

Sound

In thissectionyoucancon�gure thesystemsoundsassociatedwith variousfunctions.For exam-
ple, to playasoundwhenyou log in to your desktop,youcancon�gure it.

2.4.1.1. Changing your Desktop Backgr ound

Oneway to dramaticallyalter theappearanceof your graphicaldesktopis to changethebackground
usingtheBackground Preferencestool. You canchoosefrom several backgroundimagesincluded
with RedHat EnterpriseLinux in the /usr/share/backgrounds/ directory, or you canuseyour
own image.To starttheBackground Preferencestool, right-click onthedesktopandchooseChange
DesktopBackground from themenu.You canalsodouble-clicktheStart Here icon,selectPrefer-
ences, and�nally selectBackground.
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Figure2-10.The Background PreferencesTool

The Background Preferencestool allows you to load a new backgroundfrom a directory of
provided images(/usr/share/backgrounds/images/ ). You can also drag an image into the
window from your own imagedirectory. Thereare several additionaloptionsfor displayingyour
backgroundimage.The Wallpaper option displaysmultiple instancesof your image acrossthe
desktop,which is useful if you use a small image or if you use a tile (or pattern)image from
/usr/share/backgrounds/tiles/ (or from your own imagecollection).The Centered option
placesyour imagein the centerof the desktop,leaving the default backgroundcolorsto �ll in any
remainingdesktopspace.To �ll the desktopwith an image without tiling it, use the Scaled or
Stretchedoptions.Figure2-11shows a backgroundimageof �o wersandplantsthat is stretchedto
�ll theentiredesktop.

Figure2-11.The Desktopwith a NewBackground

If you want to createa backgroundwith your own customcolors and no images,choosethe No
Picture option andadjustyour colorsusingthe Background Style options.Chooseyour own Top
Color andBottom Color andthecolor gradient(or theblendingof colors).Click Closeto save and
exit theBackground Preferencestool.
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2.4.2. Customizing your System

The Start Here screenin Nautilus containsadditionalcon�guration tools that help you with your
new RedHat EnterpriseLinux systemandtheserver applicationsincluded.

TheSystemSettingsicon includestoolsthathelpyou setup your systemfor personaleverydayuse.
Thefollowing lists someof thetoolsincludedin SystemSettingsandwhatyoucandowith them.

Date& Time

This tool allows you to set the dateand time of your machine.You can set your time zone
informationaswell. Refer to the RedHat EnterpriseLinux SystemAdministration Guide for
detailsonusingthis tool.

Printing

The Printer Con�guration Tool allows you to adda new printer to your system.The printer
maybeconnectedto your machineor availableon a network. Referto theRedHat Enterprise
LinuxSystemAdministration Guidefor details.

SoundcardDetection

The Sound Card Con�guration Tool tool probesyour machinefor availablesounddevices.
Refer to Section8.3 TroubleshootingYour SoundCard for more detailson con�guring your
soundhardware.

Users& Groups

TheUserManager tool allows youto addandremoveusersfrom yoursystem.Referto Section
1.6Creatinga UserAccountfor details.

You mayalso�nd server con�guration tools in theStart Here area,dependingon which variantof
RedHatEnterpriseLinux you installed.Thesetoolshelpyoucon�gure servicesandapplicationsyou
areusingon the local machineto serve othermachines.Theserver con�guration toolsarefoundby
clicking on theSystemSettingsiconandthentheServer Settingsicon.A few examplesof thetools
foundin thisareaaretheHTTP Con�guration Tool andtheDomain NameService Con�guration
Tool. Youmusthavethoseserverapplicationsinstalledbeforethesetoolsappearin thissection.Refer
to theRedHat EnterpriseLinuxSystemAdministration Guidefor details.

2.5. Log ging Out
Whenyou have �nished working andwant to quit GNOME, you arepresentedwith the choiceof
logging out of GNOME (leaving the systemrunning),restartingthe machine,or halting the system
completely.

Figure2-12.The DesktopLog Out Con�rmation
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To quit thegraphicaldesktop,selecttheLog Out menuitem from theMain Menu. This bringsup a
dialogwhichpresentsyouwith theoptionslistedabove.
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Chapter 3.

Shell Prompt Basics

3.1. Why Use a Shell Prompt
Graphicalenvironmentsfor Linux have comea long way in thepastfew years.You canbeperfectly
productive in theX Window Systemandonly have to openashellpromptto completea few tasks.

However, many RedHat EnterpriseLinux functionscanbe completedfasterfrom the shell prompt
thanfrom a graphicaluserinterface(GUI). In lesstime thanit takesto opena �le manager, locatea
directory, andthencreate,delete,or modify �les from a GUI, a taskcanbe �nished with just a few
commandsat ashellprompt.

A shell prompt looks similar to other commandline interfaceswith which you might be familiar.
Userstypecommandsat a shellprompt,theshell interpretsthesecommands,andthentheshell tells
theOSwhatto do.Experienceduserscanwrite shellscriptsto expandtheir capabilitiesevenfurther.

Figure3-1.A Shell Prompt

Thischapterexplainshow to navigatethe�le system,manipulate�les, performsimpleadministration
tasks,andothershellpromptbasics.

3.2. The Histor y of the Shell
WhenAT&T softwareengineersDennisRitchieandKen ThompsonweredesigningUNIX™, they
wantedto createaway for peopleto interactwith their new system.

Operatingsystemsat that time camewith commandinterpreters,which could take commandsfrom
theuserandinterprettheminto somethingcomputerscoulduse.

But Ritchie andThompsonwantedsomethingmore,somethingthatofferedbetterfeaturesthanthe
commandinterpretersavailableat thattime.This leadto thedevelopmentof theBourneshell(known
assh ), createdby S.R.Bourne.Sincethecreationof theBourneshell,othershellshave beendevel-
oped,suchastheC shell(csh ) andtheKornshell(ksh ).
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When the FreeSoftware Foundationsoughta royalty-free shell, developersbegan to work on the
languagebehindtheBourneshellaswell assomeof thepopularfeaturesfrom othershellsavailable
at thetime.

The resultwasthe BourneAgain Shell, or bash . Although your RedHat EnterpriseLinux system
includesseveral differentshells,bash is the default shell for interactive users.You canlearnmore
aboutbash by readingthebash manpage(typeman bash at ashellprompt).

3.3. Determining Your Current Director y with pwd

Onceyou start looking throughdirectories,it is easyto get lost or forget the nameof your current
directory. By default, theBashpromptin RedHatEnterpriseLinux shows justyourcurrentdirectory,
not theentirepath.

Figure3-2.The Commandpwd Shows You Where You Ar e

To determinetheexactlocationof thecurrentdirectoryat ashellpromptandtypethecommandpwd.

Theoutputshouldlook similar to:

/home/sam

This exampleshows thatyou arein theusersam'sdirectory, which is in the /home/ directory.

Thecommandpwd standsfor print workingdirectory. Whenyou typedpwd, you askedyour Linux
systemto displayyourcurrentlocation.Yoursystemrespondedby printing thefull pathof thecurrent
directory in the shell prompt window. When the systemrespondsto requestsfor information, the
responseis called standard output, and can be printed to the shell prompt,or redirectedto other
programsor to otheroutputdevicessuchasprinters.

Usingpwd is very helpful asyou learnto navigateyour RedHat EnterpriseLinux system.

3.4. Changing Directories with cd

Changingdirectoriesis easyaslongasyouknow whereyouare(yourcurrentdirectory)andhow that
relatesto whereyouwantto go.

To changedirectories,usethecd command.Typing thiscommandby itself returnsyou to yourhome
directory;moving to any otherdirectoryrequiresapathname.
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You canuseabsoluteor relativepathnames.Absolutepathsstartat the top of the �le systemwith /
(referredto asroot) andthenlook down for the requesteddirectory;relative pathslook down from
yourcurrentdirectory, wherever thatmaybe.Thefollowing directorytreeillustrateshow cd operates.

/
/directory1
/directory1/d ir ec to ry 2
/directory1/d ir ec to ry 2/d ir ec to ry 3

If youarecurrentlyin directory3 andyouwantto switchto directory1 , youneedto moveup in
thedirectorytree.

Executingthecommand

cd directory1

while you arein directory3 , presentsyou with anerror messageexplaining that thereis no such
directory. This is becausethereis no directory1 below directory3 .

To moveup to directory1 , type:

cd /directory1

This is anexampleof anabsolutepath.It tells Linux to startat the top of thedirectorytree(/ ) and
changeto directory1 . A pathis absoluteif the�rst characteris a / . Otherwise,it is a relative path.

Usingabsolutepathsallows you to changeto a directoryfrom the / directory, which requiresyou to
know andtype the completepath.Using relative pathsallows you to changeto a directoryrelative
to thedirectoryyou arecurrentlyin, which canbeconvenientif you arechangingto a subdirectory
within your currentdirectory.

Thecommandcd .. tells your systemto goup to thedirectoryimmediatelyabove theonein which
youarecurrentlyworking.To goup two directories,usethecd ../.. command.

Usethefollowing exerciseto testwhatyou have learnedregardingabsoluteandrelative paths.From
yourhomedirectory, typetherelative path:

cd ../../etc/X11

After usingthe full commandin the example,you shouldbe in the directoryX11, which is where
con�guration�les anddirectoriesrelatedto theX Window Systemareavailable.

Takea look at your lastcd command.You told yoursystemto:

1. Go uponelevel to your login directory's parentdirectory(probably/home )

2. Thengoup to thatdirectory's parent(which is theroot,or / , directory)

3. Thengodown to the /etc/ directory

4. Finally, go to theX11/ directory

Conversely, usinganabsolutepathmovesyouto the/etc/X11/ directorymorequickly. Forexample:

cd /etc/X11

Absolutepathsstartfrom therootdirectory(/) andmove down to thedirectoryyou specify.
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Note

Always make sure you know which working directory you are in before you state the relative path to
the directory or �le you want to get to. You do not have to worry about your position in the �le system,
though, when you state the absolute path to another directory or �le . If you are not sure, type pwd
and your current working directory is displayed, which can be your guide for moving up and down
directories using relative pathnames.

Command Function

cd Returnsyou to your login directory

cd ~ Also returnsyou to your login directory

cd / Takesyou to theentiresystem's rootdirectory

cd /root Takesyou to thehomedirectoryof theroot,or superuser,
accountcreatedat installation;you mustbetheroot user
to accessthisdirectory

cd /home Takesyou to thehomedirectory, whereuserlogin
directoriesareusuallystored

cd .. Movesyou uponedirectory

cd ~otheruser Takesyou to otheruser's login directory, if otheruserhas
grantedyoupermission

cd /dir1/subdirfoo Regardlessof whichdirectoryyouarein, thisabsolute
pathtakesyou directly to subdirfoo , a subdirectoryof
dir1

cd ../../dir3/dir2 This relative pathtakesyouup two directories,thento
dir3 , thento thedir2 directory

Table 3-1.cd Options

Now thatyouarestartingto understandhow to changedirectories,seewhathappenswhenyouchange
to root's login directory(thesuperuseraccount).Type:

cd /root

If youarenot loggedin asroot,youaredeniedpermissionto accessthatdirectory.

Denying accessto the root andotherusers'accounts(or login directories)is oneway your Linux
systempreventsaccidentalor malicioustampering.Referto Section3.13OwnershipandPermissions.

To changeto theroot login androot directory, usethesu - command.

su -

Tip

The command su means substitute users and it allows you to log in as another user temporarily.
When you type su by itself and press [Enter], you become root (also called the superuser) while still
inside your login shell (your user's home directory). Typing su - makes you become root with root's
login shell; it is as if you had logged in as root originally.
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As soonasyougive therootpassword, thepromptchangesto superuserstatus.For example:

[root@localhost root]$

Whenyouaredoneworkingasroot, typeexit at theprompt;you arereturnedto youruseraccount.

3.5. View Director y Contents with ls
Now that you know how to changedirectories,it is time to learnhow to view thecontentsof these
directories.Usingthe ls command,youcandisplaythecontentsof yourcurrentdirectory.

Many optionsareavailablewith the ls command.The ls command,by itself, doesnot show all the
�les in the directory. Some�les arehidden�les (alsocalleddot �les) andcanonly beseenwith an
additionaloptionspeci�edto the ls command.

Tip

To view all ls command options, read the man page by typing man ls at a shell prompt. To print the
man page, at the prompt type man ls | col -b | lpr .

Typethecommandls -a . Now youcanview �les thatbegin with dots.

Figure3-3. ls with the -a Option

Hidden�les aremostoftencon�guration�les whichsetpreferencesin programs,window managers,
shells,andmore.Thereasonthey arehiddenis to helppreventany accidentaltamperingby theuser.
Whenyou aresearchingfor somethingin a directory, you arenot usuallylooking for thesecon�gu-
ration �les. Keepingthemhiddenhelpsto avoid somescreenclutterwhenviewing directoriesat the
shellprompt.

Viewing all the �les usingthe ls -a commandcangive you plentyof detail,but you canview still
moreinformationby usingmultipleoptions.

If youwantto seethesizeof a�le ordirectory, whenit wascreated,andsoon,addthelongoption(-l )
to the ls -a command.This commandshows the�le creationdate,its size,ownership,permissions,
andmore.
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You do not have to bein thedirectorywhosecontentsyou wantto view to usethe ls command.For
example,to seewhatis in the/etc/ directoryfrom your homedirectory, type:

ls -al /etc

Figure3-4.Samplels Output for the /etc Directory

Thefollowing is abrief list of optionscommonlyusedwith ls . Remember, you canview thefull list
by readingthe ls manpage(man ls ).

• -a (all) — Lists all �les in thedirectory, includinghidden�les (.filename ). The .. and. at the
top of your list referto theparentdirectoryandthecurrentdirectory, respectively.

• -l (long) — Lists detailsaboutcontents,includingpermissions(modes),owner, group,size,cre-
ationdate,whetherthe�le is a link to somewhereelseon thesystemandwhereits link points.

• -F (�le type)— Addsa symbolto theendof eachlisting. Thesesymbolsinclude/ , to indicatea
directory;@, to indicateasymboliclink to another�le; and* , to indicateanexecutable�le.

• -r (reverse)— Lists thecontentsof thedirectoryin reversesortorder.

• -R (recursive) — Lists thecontentsof all directoriesbelow thecurrentdirectoryrecursively.

• -S (size)— Sorts�les by their sizes.

3.6. Locating Files and Directories
Theremaybetimeswhenyouknow a �le or directoryexistsbut youdonotknow whereto �nd it. To
searchfor a �le or directory, usethe locate command.

With locate , you canseeevery �le or directorywhosenamecontainsthesearchcriterion.For ex-
ample,to searchfor all �les with theword finger in thename,type:

locate finger

The locate commandusesa databaseto locate�les anddirectoriesthathave theword finger in
the �le or directoryname.The searchresultscould includea �le called finger.txt , a �le called
pointerfinger.txt , a directorynamed/fingerthumbnails/ , andsoon. To learnmoreabout
locate , readthe locate manpage(typeman locate at ashellprompt).
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The locate commandworks very quickly, as long asthe databaseis up to date.That databaseis
automaticallyupdatedonanightly basisthroughacron job. cron is asmallprogramthatrunsin the
background,performingvarioustasks(suchasupdatingthe locate database)at regularly scheduled
intervals.

Tip

As a daemon, cron executes tasks at regularly scheduled intervals. To read the cron man page, type
man cron at the shell prompt.

The cron taskperiodicallyupdatesthe slocate database,which is usedto catalog�le locations.
Switching betweenoperatingsystemsand shuttingdown your machineat the end of the day can
interferewith theautomaticdatabaseupdaterun by cron .

To updatethe databasemanually, log in as root (type su - at a shell prompt and then your root
password) andtypethecommandupdatedb .

After a few minutes,theslocate databasethatis usedby the locate commandis updated.

Whenyouaredoneworkingasroot, typeexit at theprompt;you arereturnedto youruseraccount.

Note

You can run anacron to have your system execute commands periodically, with a frequency speci�ed
in days. Unlike cron , it does not assume that the machine is running continuously. Hence, it can be
used on machines that are not running 24 hours a day to control daily, weekly, and monthly jobs that
are usually controlled by cron .

Refer to the man page on anacron (type man anacron at the command line) and the Red Hat Enter-
prise Linux System Administration Guide for more information.

3.7. Clearing and Resetting the Terminal
After even one ls commandin a shell prompt,the terminalwindow you areworking in canbegin
to look crowded.You canalwaysexit from the terminalwindow andopena new one,but thereis a
quicker andeasierway to remove thecontentsdisplayedin theterminal.

Try typing thecommandclear at theshellprompt.Theclear commanddoesjust what it implies:
it clearstheterminalwindow.

Tip

A useful shortcut to typing clear at a shell prompt is to press [Ctrl]-[L], which also clears terminal.
Refer to Appendix F Keyboard Shortcuts for more useful shortcuts.

Sometimes,youmayaccidentallyopenaprogram�le orsomeothernon-text �le in aterminalwindow.
Onceyou closethe�le, you could�nd that thetext you aretyping doesnot matchtheoutputon the
monitor.

In suchcases,typereset to returntheterminalwindow to its default values.
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3.8. Manipulating Files with cat

RedHat EnterpriseLinux hasa utility which canhelpyou keepshortlists, gatherlists together, and
evenshow you informationaboutyoursystem.

Theutility is calledcat , shortfor concatenate, whichmeansto combine�les.

The commandcat alsodisplaysthe contentsof anentire�le on the screen(for example,type cat
filename.txt ). If the �le is fairly long, it quickly scrollspastyou on the screen.To prevent this,
usethecat filename.txt | less command.

Usingthepipe(|) andthe less commandtogetherdisplaysthe�le onepageat a time.You canthen
usetheupanddown arrow keys to movebackwardandforwardthroughthepages.For moreonusing
pipesto combinetwo separatefunctions,referto Section3.9PipesandPagers.

3.8.1. Using Redirection

Redirectionmeanscausingthe shell to changewhat it considersto be standardinput or wherethe
standardoutputshouldbegoing.

To redirectstandardoutput,usethe � symbol.Placing � afterthecat command(or afterany utility
or applicationthatwritesto standardoutput)directsits outputto the�le namefollowing thesymbol.

For example,usingcat by itself outputswhatever you input to thescreenasif it wererepeatingthe
line you just typed.Thefollowing exampleshows cat repeatingevery line thatis entered:

Figure3-5.The cat Command

To redirecttheoutputof cat to a �le, type thefollowing at a shellprompt(pressingthe[Enter] key
takesyou to thenext blankline):

cat � sneakers.txt
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Figure3-6.Redirecting Output to a File

Press[Enter] to go to anemptyline andusethe[Ctrl]-[D] key combinationto quit cat .

Do you noticeanything different in Figure3-6? Thereareno repeatedentries.That is becausethe
standardoutput from cat wasredirected.That redirectionwasto a brandnew �le you madecalled
sneakers.txt .

Youcan�nd the�le in thedirectoryyou werein whenyou startedcat (type ls if you wantto seeit
listed).

As you learnedearlier, youcanalsousecat to readthe�le youhave created.At theprompt,type:

cat sneakers.txt

Caution

Be careful when you redirect the output to a �le , because you can easily overwrite an existing �le!
Make sure the name of the �le you are creating does not match the name of a pre-existing �le , unless
you want to replace it.

Useoutputredirectionagainfor another�le andcall it home.txt . For this example,type thecom-
mandcat > home.txt , then[Enter], followedby:

bring the coffee home
take off shoes
put on sneakers
make some coffee
relax!

Now, onanemptyline, usethe[Ctrl]-[D] key combinationagainto quit cat .

Next, usecat to join home.txt with sneakers.txt andredirecttheoutputof both�les to a brand
new �le calledsaturday.txt (asseenin Figure3-7). Typethefollowing:

cat sneakers.txt home.txt � saturday.txt
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Figure3-7.Joining Files and Redirecting Output

Youcanseethatcat hasaddedhome.txt wheresneakers.txt ended.

3.8.2. Appending Standar d Output

You canuseoutputredirectionto addnew informationto theendof anexisting �le. Similar to when
you usedthe � symbol,you tell your shell to sendthe informationsomewhereotherthanstandard
output.

However, whenyou use ��� , you areaddinginformationto a �le, ratherthanreplacingthecontents
of a �le entirely.

The best explanation is a demonstration.Take two �les which have already been created
(sneakers.txt and home.txt ) and join them by using the appendoutput symbol. To add the
informationin home.txt to theinformationalreadyin sneakers.txt , type:

cat home.txt 	
	 sneakers.txt

Now checkthe�le usingthecommandcat sneakers.txt . The�nal outputshows thecontentsof
home.txt at theendof the�le:

buy some sneakers
then go to the coffee shop
then buy some coffee
bring the coffee home
take off shoes
put on sneakers
make some coffee
relax!

Thecommandyou typedappendedtheoutputfrom the�le home.txt to the�le sneakers.txt .

By appendingthe output,you save yourself time (anda bit of disk clutter) by usingexisting �les,
ratherthancreatinganew �le.

Comparethe resultsof the �les sneakers.txt andsaturday.txt , andyou canseethat they are
identical.To make yourcomparison,type:

cat sneakers.txt; cat saturday.txt

Thecontentsof both �les aredisplayed— �rst sneakers.txt , thensaturday.txt (asshown in
Figure3-8).
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Figure3-8.Stringing Commandsand Comparing Files

3.8.3. Redirecting Standar d Input

Not only canyouredirectstandardoutput,youcanperformthesametypeof redirectionwith standard
input.

Whenyouusetheredirectstandardinputsymbol � , youaretelling theshellthatyouwanta �le to be
readasinput for acommand.

Usea �le you havealreadycreatedto demonstratethis idea.Type:

cat � sneakers.txt

Becauseyou usedtheless-thansymbol( � ) to separatethecat commandfrom the�le, theoutputof
sneakers.txt wasreadby cat .

Figure3-9.Redirecting Standard Input
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3.9. Pipes and Pagers
In Linux, pipesconnectthe standardoutputof onecommandto the standardinput of anothercom-
mand.

Considerthe ls commandthatwasdiscussedearlier. Thereareplentyof optionsavailablewith ls ,
but whatif thecontentsof adirectoryscroll by too quickly for you to view them?

View thecontentsof the /etc/ directorywith thecommand:

ls -al /etc

How doyougetacloserlook at theoutputbeforeit movesoff thescreen?

Oneway is to pipetheoutputto autility calledless , apagerutility thatallows you to view informa-
tion onepage(or screen)ata time.

Usetheverticalbar(| ) to pipethecommands.

ls -al /etc | less

Now you can view the contentsof /etc/ one screenat a time. To move forward a screen,press
[Space];to movebackascreen,press[B]; to quit, press[Q]. Alternatively, youcanusethearrow keys
to navigatewith less .

To searchtheoutputof a text �le usingless , press[/] andthentypethekeyword youwantto search
for within the�le. For example:

/Linux

Pipescanalsobeusedto print only certainlinesfrom a �le. Type:

grep coffee sneakers.txt | lpr

Thiscommandprintsevery line in thesneakers.txt �le thatmentionstheword"coffee"(readmore
aboutgrep in Section3.10.3Thegrep Command).

3.9.1. The more Command

Themaindifferencebetweenmore and less is that less allows backward andforwardmovement
usingthearrow keys,while more only usesthe[Spacebar]andthe[B] key for forwardandbackward
navigation.

List thecontentsof the /etc/ directoryusingls andmore .

ls -al /etc | more
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Figure3-10.Piping Output of ls to more

To searchtheoutputof a text �le usingmore , press[/] andthentypethekeyword youwantto search
for within the�le. For example:

/foo

Usethe[Spacebar]to move forwardthroughthepages.Press[Q] to exit.

3.10. More Commands for Reading Text Files
You have alreadybeenintroducedto several basicshell promptcommandsfor reading�les in text
editors.Herearea few more.

3.10.1. The head Command

Youcanusethehead commandto look at thebeginningof a �le. Thecommandis:

head 
 filename �

head canbeausefulcommand,but becauseit is limited to the�rst several lines,youcannotseehow
long the�le actuallyis. By default, you canonly readthe�rst ten linesof a �le. You canchangethe
numberof linesdisplayedby specifyinganumberoptionasshown in thefollowing command:

head -20 
 filename �

3.10.2. The tail Command

Thereverseof head is tail . Using tail , youcanview thelasttenlinesof a �le. Thiscanbeuseful
for viewing the last 10 lines of a log �le for importantsystemmessages.You canalsousetail to
watch log �les asthey areupdated.Using the -f option, tail automaticallyprints new messages
from anopen�le to the screenin real-time.For example,to actively watch /var/log/messages ,
typethefollowing ata shellpromptastherootuser:

tail -f /var/log/messages
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3.10.3. The grep Command

Thegrep commandis usefulfor �nding speci�c characterstringsin a �le. For example,if you want
to �nd every referencemadeto "coffee" in the�le sneakers.txt , youwould type:

grep coffee sneakers.txt

Eachline in that�le wheretheword "coffee" is foundis displayed.

Tip

Unless otherwise speci�ed, grep searches are case sensitive. That means that searching for Coffee
is different than searching for coffee. Among grep 's options is -i , which allows for a case-insensitive
search through a �le . Read the grep man page for more about this command.

3.10.4. I/O Redirection and Pipes

Youcanusepipesandoutputredirectionwhenyou wantto storeand/orprint informationto readata
latertime.

Youcan,for example,usegrep to searchfor particularcontentsof a�le, thenhavethoseresultseither
savedasa �le or sentto aprinter.

To print informationaboutreferencesto "coffee" in sneakers.txt , for example,type:

grep coffee sneakers.txt | lpr

3.10.5. Wildcar ds and Regular Expressions

What if you forget thenameof the �le you arelooking for? Usingwildcardsor regularexpressions,
youcanperformactionsona �le or �les withoutknowing thecomplete�le name.First typeoutwhat
you know, andthensubstitutetheremainderwith a wildcard. Wildcardsarespecialsymbolsthatcan
be substitutedfor letters,numbers,andsymbols.Wildcardsmake �nding particulardirectoriesand
�les easierthanexamininglongdirectorylistingsto �nd whatyouaresearchingfor.

Tip

To read more about wildcards and regular expressions, take a look at the bash man page (man bash ).
Remember that you can save the �le to a text �le by typing man bash | col -b � bash.txt . Then,
you can open and read the �le with less or with an editor such as vi (vi bash.txt ). If you want to
print the �le , be aware that it is quite long.

To �nd a �le is called"sneaksomething .txt," type:

ls sneak*.txt

Thenameof the�le appears:

sneakers.txt
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Youwill probablyusetheasterisk(* ) mostfrequentlywhenyouaresearching.Theasterisksearches
outeverythingthatmatchesthepatternyouarelooking for. By typing

ls *.txt

or

ls sn*

you would �nd sneakers.txt andany other�les whosenameendswith .txt or begins with sn .
Theasteriskhelpsto narrow your searchasmuchaspossible.

Anotherway to narrow asearchis to usethequestionmarksymbol(?). Like theasterisk,using? can
helplocatea �le matchinga searchpattern.

In this case,though, ? is useful for matchinga single character, so if you were searchingfor
sneaker?.txt , you would get sneakers.txt as a result,and/orsneakerz.txt , if therewere
sucha �le name.

Regularexpressionsaremorecomplex thanthestraightforwardasteriskor questionmark.

Whenanasterisk,for example,just happensto bepartof a �le name,asmight bethecaseif the �le
sneakers.txt wascalledsneak*.txt , thatis whenregularexpressionscanbeuseful.

Using thebackslash(\ ), you canspecifythatyou do not want to searchout everythingby usingthe
asterisk,but youareinsteadlooking for a �le with anasteriskin thename.

If the�le is calledsneak*.txt , type:

sneak\*.txt

Hereis a brief list of wildcardsandregularexpressions:

• * — Matchesall characters

• ? — Matchesonecharacter

• \* — Matchesthe* character

• \? — Matchesthe?character

• \) — Matchesthe) character

3.11. Command Histor y and Tab Completion
It doesnot take long beforethe thoughtof typing thesamecommandover andover becomesunap-
pealing.Oneminor typing errorcanruin linesof aseriesof commands.

Onesolutionis to usethecommandline history. By scrollingwith the[Up] and[Down] arrow keys,
youcan�nd plentyof your previously typedcommands.

Try it by takinga look againatsneakers.txt (createdin Section3.8.1UsingRedirection). The�rst
time,however, at theshellprompt,type:

cat sneakrs.txt

Nothinghappens,of course,becausethereis no sneakrs.txt �le. Usethe[Up Arrow] key to bring
backthecommand,thenusethe[Left Arrow] key to getto thepoint wherewe missedthe"e." Insert
theletterandpress[Enter] again.

Wenow seethecontentsof thesneakers.txt �le.
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By default,up to 500commandscanbestoredin thebash commandline history�le.

Tip

By typing the env command at a shell prompt, we can see the environment variable that controls
the size of the command line history. The line which reads, HISTFILESIZE=500 shows the number of
commands that bash stores.

Thecommandline history is actuallykept in a �le, called.bash_history in your login directory.
Wecanreadit in anumberof ways:by usingvi , cat , less , more , andothers.

Beawarethatthe�le canbelong.To readit with themore command,from yourhomedirectorytype:

more .bash_history

To move forwardascreen,press[Space];to movebackascreen,press[B]; to quit, press[Q].

Tip

To �nd a command in your history �le without having to keep hitting the arrow keys or page through
the history �le , use grep (refer to Section 3.10.3 The grep Command). Here is how you can quickly
�nd a previously used command: say you are searching for a command that is similar to cat sneak -
something . You have used the command before and you think it might be in your history �le . At the
shell prompt, type:

history | grep sneak

Anothertime-saving tool is known ascommandcompletion.If you typepartof a �le, command,or
pathnameandthenpressthe [Tab] key, bash presentsyou with eitherthe remainingportion of the
�le/path, or abeep(if soundis enabledonyoursystem).If youhearabeep,press[Tab]againto obtain
a list of the�les/pathsthatmatchwhathasbeentypedsofar.

For example,if you forget the commandupdatedb , but remembera portion of the command,you
cansu - to root andusethefollowing instructions.At theshellprompt,typeup andpressthe[Tab]
key twice. A list of possiblecompletionsis displayed,includingupdatedb anduptime . By typing
thepartialcommandupd andpressing[Tab]again,yourcommandis completedfor you.

Whenyouaredoneworkingasroot, typeexit at theprompt;you arereturnedto youruseraccount.

3.12. Using Multiple Commands
Linux allows you to entermultiple commandsat onetime.Theonly requirementis thatyou separate
thecommandswith asemicolon.

Supposeyouhavedownloadedanew �le calledfoobar-1.3-2.i386.rpm andyouwantto put it in
a new subdirectorywithin your homedirectorycalledrpms/ , but thesubdirectoryhasnot beencre-
ated.Youcancombineboththecreationof the rpms/ directoryandthemoving of your downloaded
�le into thedirectoryby typing thefollowing atashellprompt:

mkdir rpms/; mv foobar-1.3-2.i 386. rp m rpms/

Runningthecombinationof commandscreatesthedirectoryandmovesthe�le in oneline.
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3.13. Owner ship and Permissions
Earlier in this chapter, whenyou tried to changeto root's login directory, you received thefollowing
message:

-bash: cd: /root/: Permission denied

That wasonedemonstrationof Linux's securityfeatures.Linux, like UNIX, is a multi-usersystem
and�le permissionsareoneway thesystemprotectsagainstmalicioustampering.

Oneway to gainentrywhenyouaredeniedpermissionis to su - to root,asyou learnedearlier. This
is becausewhoever knows theroot password hascompleteaccess.

But switchingto the superuseris not always convenientor recommended,sinceit is easyto make
mistakesandalterimportantcon�guration�les asthesuperuser.

All �les and directories are "owned" by the person who createdthem. You createdthe �le
sneakers.txt (refer to Section 3.8.1 Using Redirection) in your login directory, so
sneakers.txt belongsto you.

Thatmeansyou canspecifywho is allowedto readthe�le, write to the�le, or (if it is anapplication
insteadof a text �le) whocanexecutethe�le.

Reading,writing, andexecutingarethethreemainsettingsin permissions.Sinceusersareplacedinto
a groupwhentheir accountsarecreated,you canalsospecifywhethercertaingroupscanread,write
to, or executea �le.

Takeacloserlook atsneakers.txt with thels commandusingthe-l option(referto Figure3-11).

Thereis a lot of detailprovidedhere.Youcanseewhocanread(r) andwrite to (w) the�le, aswell as
who createdthe�le (sam),andto which grouptheownerbelongs(sam).Rememberthat,by default,
thenameof yourgroupis thesameasyour login name.

Figure3-11.Permissionsfor sneakers.txt

Otherinformationto the right of thegroupincludes�le size,dateandtime of �le creation,and�le
name.

The�rst columnshows currentpermissions;it hastenslots.The�rst slot representsthetypeof �le.
Theremainingnineslotsareactuallythreesetsof permissionsfor threedifferentcategoriesof users.

For example:

-rw-rw-r--
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Thosethreesetsaretheownerof the�le, thegroupin which the�le belongs,and"others,"meaning
otheruserson thesystem.

- (rw-) (rw-) (r--) 1 sam sam
| | | |
type owner group others

The�rst item,whichspeci�esthe�le type,canshow oneof thefollowing:

• d — adirectory

• - (dash)— aregular�le (ratherthandirectoryor link)

• l — asymboliclink to anotherprogramor �le elsewhereon thesystem

Beyondthe�rst item, in eachof thefollowing threesets,youmayseeoneof thefollowing:

• r — �le canberead

• w — �le canbewritten to

• x — �le canbeexecuted(if it is aprogram)

• - (dash)— speci�c permissionhasnot beenassigned

Whenyou seea dashin owner, group,or others,it meansthat particularpermissionhasnot been
granted.Look againat the�rst columnof sneakers.txt andidentify its permissions.

ls -l sneakers.txt
-rw-rw-r-- 1 sam sam 150 Mar 19 08:08 sneakers.txt

The�le' s owner (in this case,sam)haspermissionto readandwrite to the �le. Thegroup,sam,has
permissionto readandwrite to sneakers.txt , aswell. It is not a program,soneithertheowneror
thegrouphaspermissionto executeit.

3.13.1. The chmod Command

Usethechmod commandto changepermissions.Thisexampleshows how to changethepermissions
on sneakers.txt with thechmod command.

Theoriginal �le lookslike this,with its initial permissionssettings:

-rw-rw-r-- 1 sam sam 150 Mar 19 08:08 sneakers.txt

If you aretheownerof the �le or areloggedinto theroot account,you canchangeany permissions
for theowner, group,andothers.

Right now, theownerandgroupcanreadandwrite to the�le. Anyoneoutsideof thegroupcanonly
readthe�le (r-- ).

Caution

Remember that �le permissions are a security feature. Whenever you allow anyone else to read, write
to, and execute �les , you are increasing the risk of �les being tampered with, altered, or deleted. As
a rule, you should only grant read and write permissions to those who truly need them.
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In the following example,you want to allow everyoneto write to the �le, so they canreadit, write
notesin it, andsave it. Thatmeansyoumustchangethe"others"sectionof the�le permissions.

Takea look at the�le �rst. At theshellprompt,type:

ls -l sneakers.txt

Thepreviouscommanddisplaysthis �le information:

-rw-rw-r-- 1 sam sam 150 Mar 19 08:08 sneakers.txt

Now, typethefollowing:

chmod o+w sneakers.txt

The o+w command tells the system you want to give others write permission to the �le
sneakers.txt . To checktheresults,list the�le' s detailsagain.Now, the�le lookslike this:

-rw-rw-rw- 1 sam sam 150 Mar 19 08:08 sneakers.txt

Now, everyonecanreadandwrite to the�le.

To remove readandwrite permissionsfrom sneakers.txt usethechmod commandto take away
boththereadandwrite permissions.

chmod go-rw sneakers.txt

By typing go-rw , you aretelling thesystemto remove readandwrite permissionsfor thegroupand
for othersfrom the�le sneakers.txt .

Theresultlookslike this:

-rw------- 1 sam sam 150 Mar 19 08:08 sneakers.txt

Think of thesesettingsasa kind of shorthandwhenyou want to changepermissionswith chmod,
becauseall you reallyhave to do is remembera few symbolsandletterswith thechmod command.

Hereis a list of whattheshorthandrepresents:

Identities

u — theuserwhoownsthe�le (thatis, theowner)

g — thegroupto which theuserbelongs

o — others(not theowneror theowner's group)

a — everyoneor all (u, g, ando)

Permissions

r — readaccess

w — write access

x — executeaccess

Actions

+ — addsthepermission

- — removesthepermission

= — makesit theonly permission
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Wantto testyour permissionsskills?Remove all permissionsfrom sneakers.txt — for everyone.

chmod a-rwx sneakers.txt

Now, seeif you canreadthe �le with the commandcat sneakers.txt , which shouldreturnthe
following:

cat: sneakers.txt: Permission denied

Removing all permissions,includingyourown, successfullylockedthe�le. But sincethe�le belongs
to you,youcanalwayschangeits permissionsbackwith thefollowing command:

chmod u+rw sneakers.txt

Usethecommandcat sneakers.txt to verify thatyou, the�le owner, canreadthe�le again.

Herearesomecommonexamplesof settingsthatcanbeusedwith chmod:

• g+w — addswrite accessfor thegroup

• o-rwx — removesall permissionsfor others

• u+x — allows the�le ownerto executethe�le

• a+rw — allows everyoneto readandwrite to the�le

• ug+r — allows theownerandgroupto readthe�le

• g=rx — allows only thegroupto readandexecute(not write)

By addingthe-R option,you canchangepermissionsfor entiredirectorytrees.

Becauseyou can not really "execute"a directory as you would an application,when you add (or
remove) the executepermissionfor a directory, you arereally allowing (or denying) permissionto
searchthroughthatdirectory.

For instance,if youdonot allow othersto have theexecutepermissionon the /tigger/ directory, it
doesnot matterwho hasreador write access.No onecanaccessthedirectoryunlessthey know the
exact�le name.

For example,type

chmod a-x tigger

to remove everyone's executepermissions.

Hereis what happenswhenyou try to changedirectoriesusingthe cd tigger commandafter re-
moving everyone's executepermissions:

bash: tigger: Permission denied

Next, restoreyourown andyourgroup's access:

chmod ug+x tigger

If you checkyour work with ls -l , youcanseethatonly othersaredeniedaccessto the /tigger/
directory.
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3.13.2. Changing Permissions With Number s

Rememberthereferenceto theshorthandmethodof chmod? Hereis anotherway to changepermis-
sions,althoughit mayseema little complex at �rst.

Go backto theoriginalpermissionsfor sneakers.txt :

-rw-rw-r-- 1 sam sam 150 Mar 19 08:08 sneakers.txt

Eachpermissionsettingcanberepresentedby anumericalvalue:

• r = 4

• w = 2

• x = 1

• - = 0

Whenthesevaluesareaddedtogether, thetotal is usedto setspeci�c permissions.For example,if you
wantreadandwrite permissions,youwould have avalueof 6; 4 (read)+ 2 (write) = 6.

For sneakers.txt , herearethenumericalpermissionssettings:

- (rw-) (rw-) (r--)
| | |

4+2+0 4+2+0 4+0+0

Thetotalfor theuserissix, thetotalfor thegroupissix,andthetotalfor othersis four. Thepermissions
settingis readas664 .

If you want to changesneakers.txt sothosein your groupdo not have write access,but canstill
readthe�le, remove theaccessby subtractingtwo (2) from thatsetof numbers.

Thenumericalvaluesthenbecomesix, four, andfour (644).

To implementthesenew settings,type:

chmod 644 sneakers.txt

Now verify thechangesby listing the�le. Type:

ls -l sneakers.txt

Theoutputshouldbe:

-rw-r--r-- 1 sam sam 150 Mar 19 08:08 sneakers.txt

Now, neitherthe groupnor othershave write permissionto sneakers.txt . To returnthe group's
write accessfor the�le, addthevalueof w (2) to thesecondsetof permissions.

chmod 664 sneakers.txt

Warning

Setting permissions to 666 allows everyone to read and write to a �le or directory. Setting permis-
sions to 777 allows everyone read, write, and execute permission. These permissions could allow
tampering with sensitive �les , so in general, it is not a good idea to use these settings.
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Hereis a list of somecommonsettings,numericalvaluesandtheirmeanings:

• -rw------- (600)— Only theownerhasreadandwrite permissions.

• -rw-r--r-- (644)— Only theownerhasreadandwrite permissions;thegroupandothershave
readonly.

• -rwx------ (700)— Only theownerhasread,write, andexecutepermissions.

• -rwxr-xr-x (755)— Theownerhasread,write, andexecutepermissions;thegroupandothers
have only readandexecute.

• -rwx--x--x (711)— Theownerhasread,write, andexecutepermissions;thegroupandothers
have only execute.

• -rw-rw-rw- (666)— Everyonecanreadandwrite to the�le. (Becarefulwith thesepermissions.)

• -rwxrwxrwx (777)— Everyonecanread,write, andexecute.(Again, this permissionssettingcan
behazardous.)

Herearesomecommonsettingsfor directories:

• drwx------ (700)— Only theusercanread,write in this directory.

• drwxr-xr-x (755) — Everyonecanreadthe directory;usersandgroupshave readandexecute
permissions.



Chapter 4.

Managing Files and Directories

Your desktop�le manageris a powerful andimportanttool for managing�les anddirectoriesusing
the graphicaldesktop.This chapterdiscussesvariousshell prompt commandsthat canbe usedto
manage�les anddirectorieson your RedHat EnterpriseLinux system.This chapteralsodiscusses
compressiontoolsto createarchivesof your �les for backupor to convenientlysendto others.

Note

Due to system security, unless you are root, you are not allowed to gain access to all system-level
�les and directories. If you do not have the permission to open, delete, or execute a �le , an error
message is displayed showing your access has been denied. This is normal behavior and is used to
prevent non-privileged users from modifying or deleting important system �les .

4.1. A Larger Picture of the File System
Every operatingsystemhasa methodof storingdatain �les anddirectoriessothat it cankeeptrack
of additions,modi�cations,andotherchanges.

In Linux, every �le is storedin a directory. Directoriescanalsocontaindirectories;thesesubdirecto-
riescanalsocontain�les andothersubdirectories.

Youmightthink of the�le systemasatree-likestructureanddirectoriesasbranches.Thesedirectories
may contain,or be the "parent"of, directorieswithin it (calledsubdirectories)which hold �les and
maycontainsubdirectoriesof theirown.

Therewouldnotbeatreewithoutaroot,andthesameis truefor theLinux �le system.No matterhow
far away thedirectoriesbranch,everythingis connectedto theroot directory, which is representedas
asingleforwardslash(/ ).

Tip

Red Hat Enterprise Linux uses the term root in several different ways, which might be confusing to
new users. There is the root account (the superuser, who has permission to do anything), the root
account's home directory (/root ) and the root directory for the entire �le system (/ ). When you are
speaking to someone and using the term root, be sure to know which root is being discussed.

Unlessyou areasystemadministratoror have root (superuser)access,you probablydonothave per-
missionto write to the �les anddirectoriesoutsideof your homedirectory. Certaindirectoriesare
reserved for speci�c purposes.For example,/home/ is thedefault locationfor users'homedirecto-
ries.

Usersthatdo not have superuseraccessmight �nd the following directoriesusefulfor �nding their
homedirectories,readingdocumentation,or storingtemporary�les.

• /home/ — Default location for users'homedirectories.For example,a userwith the username
foo hasthehomedirectory/home/foo/ .
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• /usr/share/doc/ — Location of documentationfor installed packages.For example, the
documentationfor the redhat-config-date software packageis located in the directory
/usr/share/doc/redhat-config-date- � version-number � / .

• /tmp/ — The reserved directory for all usersto storetemporary�les. Files storedherearenot
permanent.A systemprocessremovesold �les from thisdirectoryonaperiodicbasis.Do notwrite
any �les or directoriesthatyouwantto keeppermanentlyhere.

YourRedHat EnterpriseLinux systemis compatiblewith many otherLinux distributionsbecauseof
the FilesystemHierarchyStandard(FHS). The FHS guidelineshelp to standardizethe way system
programsand�les arestoredonall Linux systems.

To learnmoreabouttheFHS,refer to theRedHat EnterpriseLinux ReferenceGuide. You canalso
visit theFHSwebsiteathttp://www.pathname.com/fhs/.

4.2. Identifying and Working with File Types
If you arenew to Linux, you may seecertain�le typesthat you do not recognizebecauseof their
unfamiliar extension. A �le' s extensionis the lastpart of a �le' s nameafter the �nal dot (in the �le
sneakers.txt , "txt " is that�le' s extension).

Hereis a brief listing of �le extensionsandtheir meanings:

4.2.1. Compressed and Archived Files

• .bz2 — a�le compressedwith bzip2

• .gz — a�le compressedwith gzip

• .tar — a�le archivedwith tar (shortfor tapearchive), alsoknown asa tar �le

• .tbz — atarredandbzipped�le

• .tgz — atarredandgzipped�le

• .zip — a�le compressedwith ZIP compression,commonlyfoundin MS-DOSapplications;most
compressed�les for Linux usethegzip compression,so�nding a .zip archive for Linux �les is
rare

For informationon working with bzip2 , gzip , andtar �les, referto Section4.3File Compression
andArchiving.

4.2.2. File Formats

• .au — anaudio�le

• .gif — aGIF image�le

• .html/.htm — anHTML �le

• .jpg — aJPEGimage�le

• .pdf — anelectronicimageof adocument;PDFstandsfor PortableDocumentFormat

• .png — aPNGimage�le (shortfor PortableNetwork Graphic)

• .ps — aPostScript�le; formattedfor printing

• .txt — aplain ASCII text �le

• .wav — anaudio�le
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• .xpm — animage�le

4.2.3. System Files

• .conf — acon�guration�le; con�guration�les sometimesusethe .cfg extension,aswell

• .lock — alock �le; determineswhetheraprogramor device is in use

• .rpm — aRedHatPackageManager�le usedto install software

4.2.4. Programming and Scripting Files

• .c — aC programlanguagesourcecode�le

• .cpp — aC++ programlanguagesourcecode�le

• .h — aC or C++ programlanguageheader�le

• .o — aprogramobject�le

• .pl — aPerlscript

• .py — aPythonscript

• .so — alibrary �le

• .sh — ashellscript

• .tcl — aTCL script

But �le extensionsarenot alwaysused,or usedconsistently. Sowhat happenswhena �le doesnot
have anextension,or the�le doesnot seemto bewhattheextensionsaysit is supposedto be?

Thatis whenthefile commandcanbehelpful.

For example,you �nd a �le calledsaturday without anextension.Using the file command,you
cantell whattypeof �le it is by typing:

file saturday

In theexample,thecommandfile saturday displaysASCII text , telling youit is atext �le. Any
�le thatis designatedasatext �le shouldbereadableby usingthecat , more , or less commands,or
by usinga text editorsuchasgedit or vi .

Tip

To learn more about file , read the man page by typing man file .

For moreinformationonhelpful commandsfor reading�les, referto Chapter3 ShellPromptBasics.
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4.3. File Compression and Archiving
Sometimesit is useful to storea group of �les in one �le so that they can be backed up, easily
transferredto anotherdirectory, or eventransferredto adifferentcomputer. It is alsosometimesuseful
to compress�les into one�le sothatthey uselessdiskspaceanddownloadfastervia theInternet.

It is importantto understandthedistinctionbetweenanarchive�le andacompressed�le . An archive
�le is acollectionof �les anddirectoriesthatarestoredin one�le. Thearchive �le is notcompressed
— it usesthe sameamountof disk spaceas all the individual �les and directoriescombined.A
compressed�le is acollectionof �les anddirectoriesthatarestoredin one�le andstoredin awaythat
useslessdisk spacethanall theindividual �les anddirectoriescombined.If you do not have enough
disk spaceon your computer, you cancompress�les thatyou do not usevery oftenor �les thatyou
wantto savebut donot useanymore.Youcanevencreateanarchive �le andthencompressit to save
diskspace.

Note

An archive �le is not compressed, but a compressed �le can be an archive �le .

4.3.1. Using File Roller

RedHat EnterpriseLinux includesa graphicalutility calledFile Roller that cancompress,decom-
press,andarchive �les anddirectories.File Roller supportscommonUNIX andLinux �le compres-
sionandarchiving formatsandhasa simpleinterfaceandextensive helpdocumentationif you need
it. It is alsointegratedinto thedesktopenvironmentandgraphical�le managerto make workingwith
archived �les easier.

To startFile Roller click Main Menu => Accessories=> File Roller. YoucanalsostartFile Roller
from ashellpromptby typing file-roller . Figure4-1 shows File Roller in action.

Tip

If you are using a �le manager (such as Nautilus ), you can double-click the �le you wish to unar-
chive or decompress to start File Roller . The File Roller browser window appears with the decom-
pressed/unarchived �le in a folder for you to extract or browse.



Chapter 4. Managing Files and Directories 51

Figure4-1.File Roller in Action

4.3.1.1. Decompressing and Unarchiving with File Roller

To unarchive and/ordecompressa �le click theOpen toolbarbutton.A �le menupopsup, allowing
you to choosethearchive youwish to work with. For example,if youhave a �le calledfoo.tar.gz
locatedin your homedirectory, highlight the �le andclick OK. The �le appearsin the main File
Roller browserwindow asa folder, which you cannavigateby double-clickingthefolder icon. File
Roller preservesall directoryandsubdirectorystructures,whichis convenientif youarelookingfor a
particular�le in thearchive.Youcanextractindividual �les or entirearchivesby clicking theExtract
button,choosingthedirectoryyouwould like to save theunarchived �les, andclicking OK.

4.3.1.2. Creating Archives with File Roller

If you needto free someharddrive space,or sendmultiple �les or a directoryof �les to another
user, File Roller allows you to createarchivesof your �les anddirectories.To createa new archive,
click New on the toolbar. A �le browserpopsup, allowing you to specifyanarchive nameandthe
compressiontechnique.For example,you maychooseaTar Compressedwith gzip (.tar.gz) format
from thedrop-down menuandtypethenameof thearchive �le youwantto create.Click OK andyour
new archive is now readyto be�lled with �les anddirectories.To add�les to yournew archive, click
Add, which opensa browserwindow (Figure4-2) that you cannavigateto �nd the �le or directory
you wantto bein thearchive. Click OK whenyou are�nished, andclick Ar chive => Closeto close
thearchive.

Figure4-2.Creatingan Ar chive with File Roller
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Tip

There is much more you can do with File Roller than is explained here. Refer to the File Roller
manual (available by clicking Help => Manual ) for more information.

4.3.2. Compressing Files at the Shell Prompt

Compressed�les uselessdisk spaceanddownloadfasterthanlarge,uncompressed�les. In RedHat
EnterpriseLinux youcancompress�les with thecompressiontoolsbzip2 , gzip , or zip .

Thebzip2 compressiontool is recommendedbecauseit providesthemostcompressionandis found
onmostUNIX-lik e operatingsystems.Thegzip compressiontool canalsobefoundonmostUNIX-
like operatingsystems.If you needto transfer�les betweenLinux andotheroperatingsystemsuch
asMS Windows,you shouldusezip becauseit is morecompatiblewith thecompressionutilities on
Windows.

Compression Tool File
Extension

Decompression Tool

bzip2 .bz2 bunzip2

gzip .gz gunzip

zip .zip unzip

Table 4-1.CompressionTools

By convention, �les compressedwith bzip2 aregiven the extension.bz2 , �les compressedwith
gzip aregiventheextension.gz , and�les compressedwith zip aregiventheextension.zip .

Files compressedwith gzip areuncompressedwith gunzip , �les compressedwith bzip2 areun-
compressedwith bunzip2 , and�les compressedwith zip areuncompressedwith unzip .

4.3.2.1. Bzip2 and Bunzip2

To usebzip2 to compressa �le, typethefollowing commandat ashellprompt:

bzip2 filename

The�le is compressedandsavedasfilename.bz2 .

To expandthecompressed�le, typethefollowing command:

bunzip2 filename.bz2

The filename.bz2 compressed�le is deletedandreplacedwith filename .

Youcanusebzip2 to compressmultiple �les anddirectoriesat thesametime by listing themwith a
spacebetweeneachone:

bzip2 filename.bz2 file1 file2 file3 /usr/work/sch ool

The above command compresses file1 , file2 , file3 , and the contents of the
/usr/work/school/ directory (assumingthis directory exists) and placesthem in a �le named
filename.bz2 .
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Tip

For more information, type man bzip2 and man bunzip2 at a shell prompt to read the man pages for
bzip2 and bunzip2 .

4.3.2.2. Gzip and Gunzip

To usegzip to compressa �le, typethefollowing commandatashellprompt:

gzip filename

The�le is compressedandsavedasfilename.gz .

To expandthecompressed�le, typethefollowing command:

gunzip filename.gz

The filename.gz compressed�le is deletedandreplacedwith filename .

You canusegzip to compressmultiple �les anddirectoriesat thesametime by listing themwith a
spacebetweeneachone:

gzip -r filename.gz file1 file2 file3 /usr/work/scho ol

The above command compresses file1 , file2 , file3 , and the contents of the
/usr/work/school/ directory (assumingthis directory exists) and placesthem in a �le named
filename.gz .

Tip

For more information, type man gzip and man gunzip at a shell prompt to read the man pages for
gzip and gunzip .

4.3.2.3. Zip and Unzip

To compressa �le with zip , typethefollowing command:

zip -r filename.zip filesdir

In this example,filename.zip representsthe �le you arecreatingand filesdir representsthe
directoryyouwantto put in thenew zip �le. The-r optionspeci�esthatyouwantto includeall �les
containedin the filesdir directoryrecursively.

To extractthecontentsof a zip �le, typethefollowing command:

unzip filename.zip

You canusezip to compressmultiple �les anddirectoriesat the sametime by listing themwith a
spacebetweeneachone:

zip -r filename.zip file1 file2 file3 /usr/work/scho ol
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The above command compresses file1 , file2 , file3 , and the contents of the
/usr/work/school/ directory (assumingthis directory exists) and placesthem in a �le named
filename.zip .

Tip

For more information, type man zip and man unzip at a shell prompt to read the man pages for zip
and unzip .

4.3.3. Archiving Files at the Shell Prompt

A tar �le is a collectionof several �les and/ordirectoriesin one�le. This is a goodway to create
backupsandarchives.

Someof theoptionsusedwith thetar are:

• -c — createanew archive

• -f — whenusedwith the -c option, usethe �lename speci�ed for the creationof the tar �le;
whenusedwith the-x option,unarchive thespeci�ed�le

• -t — show thelist of �les in the tar �le

• -v — show theprogressof the�les beingarchived

• -x — extract�les from anarchive

• -z — compressthe tar �le with gzip

• -j — compressthe tar �le with bzip2

To createa tar �le, type:

tar -cvf filename.tar directory/file

In thisexample,filename.tar representsthe�le youarecreatinganddirectory/file represents
thedirectoryand�le youwantto put in thearchived �le.

Youcantar multiple �les anddirectoriesat thesametimeby listing themwith aspacebetweeneach
one:

tar -cvf filename.tar /home/mine/wor k /home/mine/sch ool

Theabove commandplacesall the �les in thework andtheschool subdirectoriesof /home/mine
in anew �le calledfilename.tar in thecurrentdirectory.

To list thecontentsof a tar �le, type:

tar -tvf filename.tar

To extractthecontentsof a tar �le, type:

tar -xvf filename.tar

This commanddoesnot remove the tar �le, but it placescopiesof its unarchived contentsin the
currentworkingdirectory, preservingany directorystructurethatthearchive �le used.For example,if
thetar�le containsa�le calledbar.txt within adirectorycalledfoo/ , thenextractingthearchive �le
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resultsin thecreationof thedirectoryfoo/ in your currentworking directorywith the�le bar.txt
insideof it.

Remember, the tar commanddoesnot compressthe�les by default. To createa tarredandbzipped
compressed�le, usethe-j option:

tar -cjvf filename.tbz file

tar �les compressedwith bzip2 areconventionallygiven theextension.tbz ; however, sometimes
usersarchive their �les usingthetar.bz2 extension.

Theabove commandcreatesanarchive �le andthencompressesit asthe�le filename.tbz . If you
uncompressthefilename.tbz �le with thebunzip2 command,thefilename.tbz �le is removed
andreplacedwith filename.tar .

Youcanalsoexpandandunarchive a bzip tar �le in onecommand:

tar -xjvf filename.tbz

To createa tarredandgzippedcompressed�le, usethe-z option:

tar -czvf filename.tgz file

tar �les compressedwith gzip areconventionallygiventheextension.tgz .

This commandcreatesthearchive �le filename.tar andcompressesit asthe�le filename.tgz .
(The�le filename.tar is not saved.)If you uncompressthe filename.tgz �le with thegunzip
command,the filename.tgz �le is removedandreplacedwith filename.tar .

Youcanexpanda gzip tar �le in onecommand:

tar -xzvf filename.tgz

Tip

Type the command man tar for more information about the tar command.

4.4. Manipulating Files at the Shell Prompt
Filescanbemanipulatedusingoneof thegraphical�le managers,suchasNautilus or Konqueror.
They canalsobemanipulatedusinga shellprompt,which is often faster. This sectionexplainshow
to manipulate�les at theshellprompt.

4.4.1. Creating Files

You can createnew �les either with applications(suchas text editors)or by using the command
touch , which createsanempty�le thatyou canuseto addtext or data.To createa �le with touch ,
typethefollowing ata shellprompt.

touch � filename �
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Replace� filename � with thenameof yourchoice.If you runadirectorylisting, youcanseethat
thenew �le containszero(0) bytesof informationbecauseit is anempty�le. For example,typing the
commandls -l newfile at theshellpromptreturnsthefollowing output:

-rw-rw-r-- 1 sam sam 0 Apr 10 17:09 newfile

4.4.2. Copying Files

Like somany otherLinux features,thereis a varietyof waysto manipulate�les anddirectories.You
canalsousewildcards,asexplainedin Section3.10.5Wildcards andRegular Expressions, to make
theprocessof copying, moving, or deletingmultiple �les anddirectoriesfaster.

To copy a �le, typethefollowing command.

cp � source ��� destination �

Replace� source � with thenameof the �le you want to copy, and � destination � with the
nameof thedirectorywhereyou wantthe�le to go.

To copy the�le sneakers.txt to thedirectorytigger/ in yourhomedirectory, moveto yourhome
directoryandtype:

cp sneakers.txt tigger/

You canuseboth relative andabsolutepathnameswith cp . Our homedirectoryis the parentof the
directorytigger/ ; tigger/ is onedirectorydown from ourhomedirectory.

Tip

To learn more about relative and absolute pathnames, refer to Section 3.4 Changing Directories with
cd .

Readthecp manpage(typeman cp at theshellprompt)for a full list of theoptionsavailablewith
cp . Amongtheoptionsyoucanusewith cp arethefollowing:

• -i (interactive) — Promptsyouto con�rm if the�le is goingto overwritea�le in yourdestination.
This is ahandyoptionbecauseit canhelppreventyou from makingmistakes.

• -r (recursive) — Ratherthan just copying all the speci�ed �les anddirectories,this copiesthe
wholedirectorytree,subdirectoriesandall.

• -v (verbose)— Shows theprogressof the�les asthey arebeingcopied.

Now thatyouhavethe�le sneakers.txt in thetigger/ directory, usecp -i to copy the�le again
to thesamelocation.

cp -i sneakers.txt tigger/
cp: overwrite 'tigger/sneake rs .t xt '?

To overwritethe�le that is alreadythere,press[Y] andthen[Enter]. If you do not wantto overwrite
the�le, press[N] and[Enter].
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4.4.3. Moving Files

To move �les, usethemvcommand.For moreaboutmv, referto themvmanpage(typeman mv).

Commonoptionsfor mv includethefollowing:

• -i (interactive) — Promptsyou if the �le you have selectedoverwritesan existing �le in the
destinationdirectory. This is a goodoption,becauselike the -i option for cp , you aregiven the
chanceto makesureyouwantto replaceanexisting �le.

• -f (force)— Overridestheinteractive modeandmoveswithoutprompting.Unlessyouknow what
you are doing, this option is dangerous;be very careful aboutusing it until you becomemore
comfortablewith yoursystem.

• -v (verbose)— Shows theprogressof the�les asthey arebeingmoved.

If you want to move a �le out of your homedirectoryandinto anotherexisting directory, type the
following (youneedto bein your homedirectory):

mv sneakers.txt tigger/

Alternatively, thesamecommandusingabsolutepathnameslookslike

mv sneakers.txt /home/newuser/sneakers. txt /home/newuser/tigger/

4.4.4. Deleting Files and Directories

You learnedaboutcreating�les with the touch command,andyou createdthe directory tigger/
usingmkdir .

Now you needto learnhow to delete�les anddirectories.Deleting�les anddirectorieswith the rm
commandis a straightforward process.Referto the rm manpagefor moreinformation.Optionsfor
removing �les anddirectoriesinclude:

• -i (interactive) — Promptsyou to con�rm thedeletion.This optioncanstopyou from deletinga
�le by mistake.

• -f (force)— Overridesinteractive modeandremovesthe�le(s) withoutprompting.Thismightnot
beagoodidea,unlessyouknow exactly whatyouaredoing.

• -v (verbose)— Shows theprogressof the�les asthey arebeingremoved.

• -r (recursive) — Deletesadirectoryandall �les andsubdirectoriesit contains.

To deletethe�le piglet.txt with therm command,type:

rm piglet.txt

Warning

Once a �le or directory is removed with the rm command, it is gone permanently and cannot be
retrieved.

Usethe -i (interactive) option to give you a secondchanceto think aboutwhetheror not you really
wantto deletethe�le.

rm -i piglet.txt
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rm: remove 'piglet.txt'?

You canalsodelete�les usingthewildcard* , but becareful,becauseyou caneasilydelete�les you
did not intendto throw away.

To remove a �le usingawildcard,youwould type:

rm pig*

Theabove commandremovesall �les in thedirectorywhichstartwith theletterspig .

Youcanalsoremove multiple �les usingtherm command.For example:

rm piglet.txt sneakers.txt

You can usermdir to remove a directory (rmdir foo , for example),but only if the directory is
empty. To remove directorieswith rm, you mustspecifythe-r option.

For example,if youwantto recursively remove thedirectorytigger/ you would type:

rm -r tigger/

If youwantto combineoptions,suchasforcinga recursive deletion,youcantype:

rm -rf tigger/

A saferalternative to usingrm for removing directoriesis thermdir command.With this command,
youarenotallowedto userecursive deletions,soadirectorywhichhas�les cannotbedeleted.

Warning

The rm command can delete your entire �le system! If you are logged in as root and you type the
simple command rm -rf / , you are in trouble; this command recursively removes everything on your
system.

Readthermdir manpage(man rmdir ) to �nd out moreaboutthis command.



II. Using Your System

Now thatyouhave begunexploringyour RedHat EnterpriseLinux system,youcanstartusingsome
of themany applicationsthatareincludedwith it. FromInternetsur�ng andpersonalproductivity, to
gamesandbeyond,this partdetailssomepopularsoftwareprogramsthathelpyoubecomemorepro-
ductive with yourcomputer, andtapthepower of theInternetfor your researchandcommunications.
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Chapter 5.

Web Browsing

Onceyou have con�guredyour Internetconnection,you arereadyto getonline.RedHat Enterprise
Linux comeswith several Webbrowsers, graphicalapplicationsthatuseyour Internetconnectionto
accessthe World Wide Web:news, research,shopping,banking,andmore.This chapterbrie�y ex-
plainshow to surf theWebusingMozilla. For informationaboutusingtheKonqueror Webbrowser,
referto SectionA.6 BrowsingtheWebwith Konqueror.

5.1. Mozilla
Part of themozilla.org organization's wide rangeof OpenSourceInternetapplicationdevelopments,
Mozilla is a powerful, integrated,andstandards-compliantWebbrowser, email client, news reader,
andmore.TheWebbrowsingcomponentdisplaysWebcontentsuchaswebpagesandimages.Mozilla
alsousesplug-insfor interactive multimediasuchasstreamingvideoandWebanimation.Thissection
shows youhow to usetheMozilla Webbrowserto exploretheInternet.

To startMozilla click the Mozilla Web Browser launcheron the panelor chooseMain Menu =>
Internet => Mozilla WebBrowser.

Figure5-1.Mozilla Main Browser Window

5.1.1. Using Mozilla

Mozilla functionslike any Webbrowserthatyou mayhave usedbefore.It hasthestandardnaviga-
tional toolbars,buttons,andmenus.
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Thenavigationbarhasanaddress�eld with which youcantypea Uniform ResourceLocator(URL)
— thenameor addressof awebsite— into theaddress�eld atthetopof thebrowserwindow. Mozilla
supportskeyword searchingvia theaddress�eld aswell. Typea keyword or phraseinto theaddress
�eld andclick theSearch button.Thesearchresultsappearsin themainbrowsingarea.

Figure5-2.The Mozilla Navigational Bar

Thereis alsoasidebaron theleft thatcontainsadditionaloptions,suchasintegratedsearchfunction-
ality, bookmarks,anda What' s Related option thatdisplayswebpagessimilar in topic to the page
currentlydisplayedin themainbrowsingarea.

Figure5-3.The Mozilla SideBar

At the bottom left cornerof the browser window, thereare the following small icons: Navigator,
Mail & Newsgroups, Composer, Addr essBook, andIRC Chat. Theseareseparateapplications
integratedinto theMozilla suiteandareusefulfor experiencingemail,chat,news, andotheraspects
of the Internetbesidesthe Web. For information on using the Mozilla Mail email client, refer to
Chapter6 EmailApplications.

Finally, thereis thePersonalToolbar whichcanbecustomizedwith yourown bookmarksor quickly
take you backto your homepage.ThePersonalToolbaris usefulfor keepingandcategorizing web-
pagesso thatyou do not have to type theaddressevery time you want to accessthepage.To adda
siteto your PersonalToolbar, click andhold theleft mousebuttonon thesmall icon next to theURL
in theaddress�eld anddragit directly to thePersonalToolbaror into a folder icon. You canaccess
PersonalToolbarfoldersby clicking theiconandchoosingthewebsitefrom thedrop-down menu.
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Mozilla alsoallows you to browsemultiple websiteswithin onebrowserwindow usingnavigational
tabs. Insteadof usingtwo or moreseparatewindows to readmultiple webpages,you canopena tab
by clicking File => New=> Navigator Tab or by pressing[Ctrl] and[T] at thesametime.Thisopens
thenew tabandallows you to switchbetweentabsby clicking on them.To closea tab,right-click on
thetabandchooseCloseTab from themenuor click theX at theright of thetabbarto closethetab
currentlydisplayed.

For additionalinformationonusingMozilla, click onHelp (onthetopmenupanel)andthenonHelp
Contents.

5.1.2. Mozilla Composer

YoucanuseMozilla Composerto createwebpages.Youdonotneedto know HTML to usethis tool.
To openComposer, click on Window => Composerfrom the Mozilla mainmenu,or click on the

Composericon in thelower left partof thescreen: .

TheMozilla help�les provide informationoncreatingwebpageswith Composer.

Go to Help on themainmenuandselectHelp Contents. Whenthehelpscreenopens,click on the
Contents tab andexpandthe Creating Webpagesmenuby clicking on the arrow next to it. A list
of topicsappearandclicking on any of theseprovide you with informationfor creatingandediting
webpagesusingMozilla Composer.

Figure5-4.Mozilla Composer

5.2. Web Browser Keyboar d Shor tcuts
Table5-1showssomecommonkeyboardshortcutsavailablein Mozilla. Keyboardshortcutscanhelp
youef�ciently browsetheWeb.
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Shor tcut Description

[Ctrl]-[T] Opensanew tabfor browsingmultiplewebsites
within onebrowserwindow

[Ctrl]-[N] Opensanew browserwindow

[Ctrl]-[Q] Closesall browserwindows andexits theapplication

[Ctrl]-[L] Movesthecursorto thebrowser's address�eld

[Ctrl]-[P] Printsthecurrentdisplayedwebpageor document

[Ctrl]-[right arrow] Movesforwardby onelink or page

[Ctrl]-[left arrow] Movesbackwardby onelink or page

[Ctrl]-[R] Reloadsthecurrentpage

[Ctrl]-[H] Opensthebrowsinghistory

[Ctrl]-[F] Findsakeyword or stringwithin apage

Table 5-1.KeyboardShortcuts
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Email Applications

Email is a very popularway of communicatingwith othersover theInternet.You canuseemailwith
anemail client, anapplicationthatunderstandsthevariousemail transmissionstandardsandallows
you to send,receive, andreademail.RedHat EnterpriseLinux includesseveral email applications,
includinggraphicalemailclientslike Evolution andMozilla Mail , andtext-basedclientslike mutt .
All of theemailclientapplicationsaredesignedto suit certaintypesof users;so,you canchooseone
with thefeaturesthatbestsuitsyour particularneeds.

The purposeof this chapteris to demonstratehow to usesomeof the popularemail applications
includedin RedHat EnterpriseLinux. Sinceall emailclientsperformthesamebasictasks(sendand
receive email),you shouldchooseonethatis convenientandeasyto use.

This chapterbrie�y discussesthefollowing emailclients:

• Evolution

• Mozilla Mail

• Mutt , a text-basedemailclient

Beforeyou launchan email client, you shouldhave someinformation from your InternetService
Provider(ISP)handysothatyoucancon�gure theclientproperly. Thefollowing listsafew important
thingsyoumayneedto know:

Youremailaddress

The email addressyou use to send and receive mail. This is usually in the form of
yourname@yourisp.net .

Server typefor receiving email(POPor IMAP)

In orderto receive mail, you mustknow what typeof server your network administratoror ISP
is using.ThisPOPor IMAP address,is usuallyin theform of mail.someisp.net .

POP, shortfor PostOf�ce Protocol, is usedto sendemailfrom amail serverto youremailclient's
inbox, theplacewhereincomingemail is stored.Most ISPemailserversusethePOPprotocol,
althoughsomecanusethenewer IMAP (InternetMessageAccessProtocol).

IMAP, shortfor InternetMessage AccessProtocol, is a protocolfor retrieving emailmessages
from your ISP's email server. IMAP differs from POPin that email from IMAP servers are
storedontheserverandstaysthereevenasyoudownloadandreadyourmail, whereasPOPmail
is downloadedto your emailclientdirectly anddoesnot stayon theserver.

Server typefor sendingemail(SMTP)

The SimpleMail TransferProtocol (SMTP) is a protocolfor sendingemail messagesbetween
servers.Most email systemsthat sendmail over the InternetuseSMTP to sendmessagesfrom
oneserver to another;themessagescanthenberetrieved with anemailclient usingeitherPOP
or IMAP. SMTPis alsousedto sendmessagesfrom a mail client to a mail server. This is why
youneedto specifyboththePOPor IMAP serverandtheSMTPserverwhenyoucon�gureyour
emailapplication.

If you have any questionsregardingwhat informationyou need,contactyour ISPor network admin-
istrator. Unlessproperlycon�gured, you cannotmake full useof the email clientsdiscussedin this
chapter.
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6.1. Evolution
Evolution is morethanjustanemailclient.It providesall of thestandardemailclientfeatures,includ-
ing powerful mailbox management,user-de�ned �lters, andquick searches.It additionallyfeatures
a �e xible calendar/schedulerwhich allows usersto createandcon�rm groupmeetingsandspecial
eventsonline.Evolution is a full-featuredpersonalandworkgroupinformationmanagementtool for
Linux andUNIX-basedsystems,andis thedefault emailclient for RedHatEnterpriseLinux.

To launchEvolution from thedesktoppanel,go to Main Menu => Internet => Evolution Email.

Figure6-1.Evolution WelcomeScreen

The �rst time you startEvolution you arepresentedwith the WelcomeScreen(Figure6-1), which
allows you to con�gure youremailconnection.Follow theon-screeninstructionsand�ll in theinfor-
mationyou collectedfrom your ISPor administratorin thetext boxesprovided.Whenyou aredone,
click Finish, to bepresentedwith theMain Screenasshown in Figure6-2.
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Figure6-2.Evolution Main Screen

To view whatis in your inboxor to sendanemail,click on theInbox icon.

Figure6-3.Evolution Inbox Screen

To composeamail, selectNewMessagefrom thetoolbar.
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Figure6-4.Evolution NewEmail MessageScreen

Onceyouhavecomposedamessageandenteredanemailaddressto sendtheemailto, click Sendon
thetoolbar.

While Evolution doesso much more than readand sendemail, this chapterfocusesexclusively
on its email capabilities.To learnmoreaboutusingother featuresof Evolution, suchascalender-
ing/schedulingandgroupmessaging,click Help from the main toolbarandchoosethe component
youwantto learnmoreabout.

6.2. Mozilla Mail
This sectionbrie�y coversthebasicstepsfor sendingandreceiving emailwith Mozilla. If you need
furtherinformationaboutusingMozilla Mail , theMozilla Help contentsarelocatedunderHelp on
themainmenu.

To startMozilla Mail , selectMain Menu => Internet => Mor e Internet Applications => Mozilla
Mail .

You arepresentedwith a New Account Setup screen.SelectEmail account, which allows you to
con�gure your email connection.Follow the on-screeninstructionsand �ll in the informationyou
collectedfrom your ISPor administratorin thetext boxesprovided.
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Figure6-5.Account Setup

To openMozilla Mail while in Mozilla, click on the mail icon nearthe lower left cornerof the
Mozilla screen .

Figure6-6.Mozilla Mail and News

To createanew emailmessage,click theComposebutton.
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Figure6-7.Mozilla Mail NewEmail MessageScreen

To sendanemail,click on theSendbuttonor go to File => SendNow or SendLater. If youchoose
to sendlater, youcangobackto themainmail screenandgo to File => Sendunsentmessages.

To reademail,click on themail folderyoucreatedfor yourselfto view any messageswaiting for you.
Then,click on themessageyouwantto read.

Onceyoureadamessage,youcandeleteit, save it to aseparatefolder, andmore.

6.2.1. Mozilla and Newsgr oups

NewsgroupsareInternetdiscussiongroupswith speci�c topics.Thediscussionsarein threadedformat
(which meansall topicsandresponsesto the topic aresortedandorganizedfor convenientreading)
andsubscribingto a groupis very easy. Youdo not have to postmessagesif you do not wantto; you
can just lurk, which is a Newsgroupterm for readingwithout postingmessages.Therearea great
many newsgroupsontheWebwith topicsrangingfrom politics to computergamesto randomstrange
thoughts.You canevenpostanddownloadpicturesand�les to Newsgroups(althoughyour ISPmay
restrictNewsgroupsto text-basedpostingsonly).

To join a newsgroup,you �rst needto setup a newsgroupaccount.Click onyour mail accountname
in thesidebarandselectCreatea newaccountfrom theoptionsthatappearontheright of thescreen.
TheNewAccount Setupscreenappearsagain.SelectNewsgroup accountandthenclick Next.

Enteryournameandemailaddresson thenext screenandclick Next. On thefollowing screen,enter
thenameof yournewsserver (if youdonotknow thenameof yournewsserver, contactyour Internet
serviceprovider or network administratorfor this information).On the last few screens,you can
determinethenamethatthisaccountis referredto andreview yoursettings.

Thenewsgroupaccountyoucreatedappearsin thesidebarof theMozilla mail screen.Right-clickon
this accountnameandselectSubscribe. A dialogbox appears,listing all thenewsgroupsavailable.
Selectthegroupsyouareinterestedin readingandclick Subscribe. Whenyouaredone,click onOK.

Now, click onthearrow next to thenewsgroupaccountnameandthelist of groupsyouaresubscribed
to appearsbeneath.Selectthenewsgroupyou wantto accessanda dialogbox appearswith informa-
tion aboutdownloadingandreadingexisting messages.Postingto a newsgroupis just like writing
an email, except that the newsgroupnameappearsin the To �eld ratherthanan email address.To
unsubscribefrom a newsgroup,right-click on thegroupnameandselectUnsubscribe.
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6.3. Plain Text Email Clients
Most modernemail clientsallow the userto selectwhetherthey want to sendtheir emailsin plain
text or in HTML. The advantageof HTML formattedemail is that they can containgraphicsand
interactive links to Web sites.The particularfont canbe speci�ed, the layout is very controllable,
textures,andpicturesor backgroundscanbeadded;all this makesfor a visually appealingmessage
whenit getsto therecipient.

Ontheotherhand,plaintext emailis justthat— plaintext. They is nothingfancy, therearenopictures
embeddedin theemail,andtherearenospecialfonts.Plaintext emailsaresimple.

The term plain text refersto textual datain ASCII format. Plain text (alsocalledclear text) is the
mostportableformat becauseit is supportedby nearlyevery email applicationon varioustypesof
machines.

This chapterdiscussesthemutt plain text emailclient.

6.3.1. Using Mutt

Mutt is asmallbut very powerful text-basedmail client for UNIX operatingsystems.

Mutt 's con�guration�le, ~/.muttrc , givesmutt its �e xibility andcon�gurability. It is alsothis �le
that might give new usersproblems.The numberof optionsthat mutt hasavailable to it are truly
astounding.mutt allows theuserto controlnearlyall of thefunctionsthatmutt usesto send,receive,
andreadyour mail. As is truewith all powerful software,it takestime to understandthefeaturesand
whatthey cando for you.

Most of the optionsare invoked usingthe set or unset commands,with eitherbooleanor string
values,e.g.set folder = ~/Mail .

All con�guration optionscanbe changedat any time by typing a [:] followed by the relevant com-
mand.For example :unset help turnsoff the handykeyboardcommandhints at the top of the
screen.To turn thosehintsbackon, type :set help .

If youcannotrememberthecommandyouwantto use,thereis alwaystab-completionto helpyou.

Youdonot have to typeall your preferredcon�gurationcommandseachtime you run mutt , you can
savethemin a �le which is loadedevery time theprogramstartsup.Thiscon�guration�le mustexist
in your homedirectory, it hasto benamedeither~/.muttrc or ~/.mutt/muttrc .

When you launchmutt (by typing mutt at a shell prompt),a screenappearswith a list of email
messages.This initial menuis calledtheindex.

Figure6-8.mutt Main Screen
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Thesemessagesarein a default mail folder, oftencalledthemailspool, thatyou canthink of asyour
inbox.Usethe[K] and[J] keys onyourkeyboardto movethehighlightedcursorupanddown thelist
of messages.

In theindex or pagerviews,usethe[R] key to reply to amessageor the[M] key to createa new one.
Mutt promptsfor the To: addressandthe Subject: line. A text editor (de�ned by your $EDITOR
environmentalvariablein thecon�guration�le) thenlaunchesallowing youtocomposeyourmessage.
Typeyourmessage,save your �le andexit theeditor.

After editingyour email,Mutt displaysthecomposemenu,whereyou cancustomizeyour message
headers,changetheencoding,add�le attachmentsor simply pressthe[Y] key to sendyour emailon
its way.

To learnmoreaboutmutt , refer to themanpagesfor muttrc andmutt (typeman muttrc or man
mutt at theshellprompt).You mayalso�nd themutt manualto bevery helpful. Themutt manual
is installedin /usr/share/doc/mutt-1.2. x / , wherex is theversionnumberof mutt installedon
yoursystem.
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Working with Documents

RedHatEnterpriseLinux includesseveraltoolsfor managingall of yourdocuments.Whetheryouare
preparingfor apresentation,writing a formal letter, or openingadocumentfrom anemailattachment,
RedHat EnterpriseLinux hasa tool thatsuitsyourneeds.

7.1. The OpenOf�ce .org Suite
Productivitysuitesarecollectionsof applicationsdesignedto save time andassistusersat work, at
school,andat home.Usually, productivity suitesaregraphicalandincludesuchapplicationsasword
processors,spreadsheets,andpresentationutilities.Theapplicationsthatcompriseaproductivity suite
areintegrated— which meansthatyou can,for example,write a documentwith anembeddedchart
createdby the spreadsheetapplicationaswell asa slide from a graphicalpresentationapplication.
Integrationof thesoftwarethatmake upaproductivity suitehelpsyou to give impactto yourpresen-
tations,lectures,or printedcollateral.

Red Hat EnterpriseLinux includesa powerful businessproductivity suite called OpenOf�ce.org,
which incorporatesseveralcomplementaryapplicationsinto oneintegratedpackage.UsingOpenOf-
�ce.org is muchfasterandeasierthanlearningcomplex tagsandcodeto formatyour documentsand
presentations.It allows you completecontrolover thelayoutandcontentof your documentsandlets
you seethe resultsasyou edit it. This real-time,visual form of documentformattingis calledwhat
youseeis whatyouget (or WYSIWYG) editing.

7.1.1. OpenOf�ce .org Features

TheOpenOf�ce.org suitecontainsseveral applicationsfor creatingandeditingdocuments,spread-
sheets,businesspresentations,and artwork. It includestemplates,forms, andwizardsfor creating
basicprofessionaldocumentsandpresentationsquickly. If you have ever worked with or received
.doc or .xls �les, you know they arecommonlyassociatedwith the Microsoft Of�ce suite.The
OpenOf�ce.org suiteis ableto read,edit, andcreate�les in several formats,including �les which
arecommonlyassociatedwith MicrosoftOf�ce. Table7-1showsthemany differenttypesof �les you
canuseandtasksyoucanaccomplishwith theOpenOf�ce.org suite.

Application File Compatibility Document Types

OpenOf�ce.org
Writer

.sxw , .sdw , .doc , .rtf , .txt ,

.htm/.html
Formalletters,businessforms,school
papers,resumes,newsletters,reports

OpenOf�ce.org
Calc

.sxc , .dbf , .xls , .sdc , .slk ,

.csv , .htm/.html
Spreadsheets,charts,tables,graphs,
personneldirectories,addressbooks,
budgets,simpledatabases

OpenOf�ce.org
Impr ess

.sxi , .ppt , .sxd , .sdd Businessandacademicpresentations,
Webpresentations,lectures,slide
shows

OpenOf�ce.org
Draw

.sxd , .sda ; export �les to several
imageformats,including .jpg , .bmp ,
.gif , and.png

Illustrations,line drawings,clip art,
organizationalcharts

Table 7-1.OpenOf�ce.org Features

As you cansee,the OpenOf�ce.org suitehasmany �le compatibility features,andallows you to
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accomplishseveraltasksfor academic,business,or homeuse.Thefollowing sectionsshowsyouhow
to usetheOpenOf�ce.org suite.

7.1.2. OpenOf�ce .org Writer

Writing documentsusingOpenOf�ce.org is similar to otherword processingapplicationsyou may
have usedbefore.A word processoris like a text editorbut hasseveraladditionalfeaturesthatallow
you to format,design,andprint your documentswithout theneedto memorizecomplex formatting
tagsor codes.OpenOf�ce.org Writer is a powerful word processorthat featuresWYSIWYG for-
matting— whatyouseein theOpenOf�ce.org Writer window is exactlywhatyougetif youprinted
the documentor if you gave the document�le to someoneelsefor themto view. Figure7-1 shows
OpenOf�ce.org Writer in action:

Figure7-1.OpenOf�ce.org Writer

TostartOpenOf�ce.org Writer fromyourdesktoppanel,chooseMain Menu => Of�ce => OpenOf-
�ce.org Writer ; to startit from ashellprompt,typeoowriter .

Themaininterfaceis thedocumenteditingarea(thewhite spacein themiddleof thewindow) where
youcanaddandedittext. At thetopof thewindow arevariousfunctionscollectedinto toolbarsthatlet
youchooseyour fonts,lettersizes,justi�cation (aligningthetext of yourdocumentto theleft, center,
or right margins),andmore.Thereis alsoa text box thatenablesyou to specifytheexact locationof
a documenton your machineandloadthedocumentinto theeditingarea.Therearealsobuttonsfor
opening,saving, andprintingdocuments,aswell asbuttonsfor creatingnew documents(whichopens
upanew window with ablankdocumentfor you to addcontent).

Along theleft sideof thewindow, thereis a toolbarwith buttonsfor checkingyour spelling,toggling
theautomatichighlightingof misspelledwords,keyword andphrasesearching,andotherconvenient
editingfunctions.If you hover themousecursorover a toolbarbutton,apop-upTip is displayedwith
a brief explanationof thebutton's functionality. You candisplaymoredetailedTips by clicking the
Help menuandchoosingExtendedTips.

You canimmediatelybegin typing text into the documenteditingareaat any time usingthe default
settings.To save your text, click theSave button , which opensthe pop-up�le browser. You can
choosethe �le format from the File type drop down menuat the bottom of the browser window.
Thedefault �le typeis appropriatefor �les thatyouareworkingonexclusively with OpenOf�ce.org
applications.However, for �les that you needto distribute to Microsoft Of�ce users,or if you are



Chapter 7. Working with Documents 75

editinga �le thatwassentasanemailattachmentwith the .doc extension,you cansave the�le asa
Micr osoft Word �le typethatothersareableto openin Micr osoft Word.

While OpenOf�ce.org Writer is usefulfor generaldocumentediting,you canalsoaddobjectssuch
asimages,illustrations,charts,andtablesto your documentto complementyour text or give impact
to your documents.To addanimageto thedocument,selectInsert => Graphics => From File, and
choosetheimagefrom thepop-up�le browser. Theimageappearswhereyouplacedyourcursorand
canbemadelargeror smallerby clicking ontheresizingbordersaroundtheimage.Figure7-2shows
animageaddedto adocument.

Figure7-2.Adding an Image to Your Document

Onceyou have createdyour document,you cansave it in any format that you wish. ConsultTable
7-1 for available�le formats.Notethatyoucanalsoexport your documentto HTML or PDFformat,
formatswhich canbereadby almostevery computerwith a Webbrowser(suchasMozilla) or PDF
viewer application(suchasxpdf or Adobe Acrobat Reader).

7.1.3. OpenOf�ce .org Calc

Fromlargeenterprisesto homeof�ces, professionalsin every industryusespreadsheetsfor keeping
records,creatingbusinesscharts,andmanipulatingdata.OpenOf�ce.org Calc is a softwarespread-
sheetapplicationthatallows youto enterandmanipulatedatacellsorganizedin columnsandrows.A
cell is acontainerfor individualpiecesof data,suchasaquantity, label,or mathematicalformula.You
canperformcalculationsongroupsof cells(suchasaddingor subtractingacolumnof cells)or create
chartsbasedonthequantitiescontainedin agroupof cells.Youcanevenincorporatespreadsheetdata
into yourdocumentsfor aprofessionaltouch.

To startOpenOf�ce.org Calc from the desktoppanel,selectMain Menu => Of�ce => OpenOf-
�ce.org Calc. To startOpenOf�ce.org Calc from ashellprompt,typeoocalc .

Figure7-3shows OpenOf�ce.org Calc in action.
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Figure7-3.OpenOf�ce.org Calc

OpenOf�ce.org Calc allows you to enterandmanipulatepersonalor businessdata.For example,
you cancreatea personalbudgetby enteringdatadescriptions(suchas rent , groceries , and
utilities ) into columnA andthe quantitiesof thosedatadescriptionsin columnB. OpenOf-
�ce.org Calc allows you to enterthe dataeither in the cell itself by doubleclicking the cell and
typing your information or by using the Input Line (the text box on the toolbar).Then you can
run a formula on columnB to comeup with a total. OpenOf�ce.org Calc hasseveral presetfunc-
tionsandcalculations(suchas=SUM() for addition/multiplication, =quotient() for division,and
=subtotal() for preparingreceipts).For detailedinformationaboutcreatingfunctionsfor calcu-
latingyournumericaldatain OpenOf�ce.org Calc, referto thedocumentationby selectingHelp =>
Contents.

If youneedto createchartsor graphsfor classor businesspresentations,OpenOf�ce.org hasseveral
chartandgraphtemplatesavailable.Highlight the areasyou would like to chart, thenclick Insert
=> Chart.... In the Chart window, the datarangesyou chooseis shown in the text box for you to
customizefurtherif desired.Click Next to displaythemany differentchartsandgraphsyoucancreate
usingyourdata.Choosethestyleyouwant,andclick Create. Thegraphis displayedanchoredwithin
the spreadsheetwindow. You canmove it anywhereon the screenfor printing, or you cansave the
graphasanobjectthatyoucanthenembedin OpenOf�ce.org Writer documentsor OpenOf�ce.org
Impr esspresentations.
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Figure7-4.CreatingCharts with OpenOf�ce.org Calc

Youcansavespreadsheetscreatedwith OpenOf�ce.org Calc in several�le formats,includingthena-
tive .sxc aswell asMicrosoftOf�ce compatible.xls formats.Additionally, youcanexportrendered
chartsandgraphsto severalimage�le formatsandintegratethemwith document�les, webpages,and
presentations.

For moreinformationaboutusingOpenOf�ce.org Calc, refer to the help pagelocatedin Help =>
Contentsfrom the�le menus.

7.1.4. OpenOf�ce .org Impress

Visual aidscangive your presentationsan addedimpact that catchesyour audience's attentionand
keepstheminterested.OpenOf�ce.org Impr essis a graphicaltool that canhelp you make a more
convincing presentation.

To start OpenOf�ce.org Impr essfrom the graphicaldesktop,selectMain Menu => Of�ce =>
OpenOf�ce.org Impr ess. To startOpenOf�ce.org Impr essfrom ashellprompt,typeooimpress .

OpenOf�ce.org Impr essfeaturesastep-by-stepautomatedpresentationwizardcalledAutoPilot that
allows you to createpresentationsfrom a collectionof default style templates.You canmake slides
with itemizedlists, outlines,or images.You caneven import chartsandgraphscreatedby OpenOf-
�ce.org Calc into aslide.

Figure7-5shows OpenOf�ce.org Impr essin action.
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Figure7-5.OpenOf�ce.org Impr ess

Whenyou �rst startOpenOf�ce.org Impr ess, youarepresentedwith theAutoPilot.Youcanchoose
the style of your slides,the mediumwith which you presentyour slides(plain paper, transparent
paperfor overheadprojectors,slides,or adisplaymonitor),andany animatedvisualeffectsyouwant
to applyto theslidesif you runpresentationsfrom yourcomputer.

Figure7-6.OpenOf�ce.org Impr essAutoPilot Wizard

Onceyouhavechosenyourpreferenceswith AutoPilottool, youcanchoosethetypeof slideyouwant
to create.You canselecta pre-formattedslidefrom the list or startwith a blankslideandcustomize
thelayoutyourself.To addnew slidesto yourpresentation,click Insert Slide...in the�oating toolbar,
anda pop-upwindow appearsallowing you to choosethe layout of the new slide.You canhave as
many slidesin your presentationasyouneed.

Youcanalsopreview yourpresentationatany pointby selectingSlideShow => SlideShow from the
�le menus.Thepresentationis presentedin full screen,which you canexit by cycling throughevery
slideuntil you reachtheendor by pressingthe[Esc] key atany point in theslideshow.

Your presentationcanbe saved in several �le formats.You cansave in the native OpenOf�ce.org
Impr ess format (for example, mypresentation.sxi ), the Microsoft PowerPoint format
(mypresentation.ppt ), or StarImpressformat(mypresentation.sdd ). You canalsoprint your
presentationto plain or transparentpaperformatsby clicking File => Print from the�le menu.
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To learnmoreaboutOpenOf�ce.org Impr ess, click Help => Contentsfrom the�le menus.

7.1.5. OpenOf�ce .org Draw

If you want to creategraphicsfor your documentsandpresentations,you canuseOpenOf�ce.org
Draw. Usingyourmouseasayou wouldapenor apaintbrush,OpenOf�ce.org Draw allows you to
make illustrationsandsave themin several formatsthatyou canaddto printeddocuments,placeon
websites,or attachto emails.

To startOpenOf�ce.org Draw from the desktoppanel,click Main Menu => Of�ce => OpenOf-
�ce.org Draw. To startOpenOf�ce.org Draw from ashellprompt,typeoodraw .

Figure7-7Shows OpenOf�ce.org Draw in action.

Figure7-7.OpenOf�ce.org Draw

If you arefamiliar with illustration andgraphicsapplicationssuchasThe GIMP (refer to Chapter
10 Working with Imagesfor moreinformation),noticethat OpenOf�ce.org Draw hassomeof the
samebasicfunctions.Therearetoolbarsfor creatingstraightandcurved lines,basicshapessuchas
squaresandcircles,3D objectssuchasconesandcubes,andmore.You cancreateimagesand�ll
themwith thecolorof yourchoiceusingtheAr eaStyle/Filling drop-down menuonthemaintoolbar.
Youcanadditionallyinserttext into your illustrations.OpenOf�ce.org Draw alsoallows youto open
andimport imagesandmodify themwith thetoolsprovided.

Whenyou completeyour illustrationor imagemodi�cations,you cansave the �le in oneof several
native �le formatsor export your work to several popularformatssuchas .jpg or .png . Refer to
Table7-1 for thecompletelist of compatibleimage�le formats.

For moreinformationonusingOpenOf�ce.org Draw, referto thedocumentationlocatedatHelp =>
Contentsfrom the�le menus.

7.2. Editing Text Files
RedHatEnterpriseLinux includesseveraltext editors, applicationsthatallow youto view andmodify
plain text �les. Plaintext �les are�les thatcontaintext withoutany font or styleformattingappliedto
it, suchassystemlogsandcon�guration�les.
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gedit is a graphicaltext editor. It canopen,edit, andsave plain text �les. You canalsocut andpaste
text to andfrom othergraphicaldesktopapplications,createnew text �les, andprint �les. gedit hasa
clearandunderstandableinterfacethatusestabssothatyou canopenmorethanone�le at thesame
time withoutopeningmorethanonegedit window.

To startgedit, click Main Menu => Accessories=> Text Editor . You canalsostartgedit by typing
gedit atashellprompt.

Note

gedit can only be used in a graphical desktop environment.

Figure7-8.gedit

Oncegedit is running,you arepresentedwith ablankeditingarea.Youcanbegin usinggedit imme-
diatelyor click theOpen button to locatetheplain text �le you want to edit. The �le loadsinto the
maineditingareaasshown in Figure7-8. You cannavigatethe text �le by clicking andholding the
scroll baron the right edgeof thewindow andmoving your mousecursorup anddown; or, usethe
arrow keys to navigatethroughthetext �le line-by-line.Pressthe[PageUp] and[PageDown] keys to
advancethedocumentapageata time.

Tip

gedit allows you to open multiple text �les in one window using separate tabs for each �le . If you
have a �le already open and want to copy text from another �le , click Open, choose the �le you want
to access, and the �le opens in a new tab within the gedit window. You can navigate between each
�le by clicking on the the tab associated with the particular �lename .

Onceyou have modi�ed or written your text �le, you cansave it by pressingtheSave button in the
toolbar, or by choosingFile => Save from the�le menus.If you arewriting a new text �le, a pop-up
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window promptsyou to namethe �le andsave it in the directoryof your choice.If you areediting
anexisting �le, thenany changesyou make automaticallyappearsin the �le thenext time you open
it. You canalsochooseFile => Save As... to save anexisting �le undera new nameor in a different
location,which is convenientif, for example,youareeditingacon�guration�le andyouwantto test
yourchangeswithout losingyour original con�guration.

For moreinformationaboutgedit, chooseHelp => Contentsfrom the�le menusto accessthegedit
manual.

7.2.1. Shell Prompt Text Editor s

If you arenot usingagraphicaldesktopandwantto readandmodify a text or con�guration�le, Red
Hat EnterpriseLinux includesthevi (pronouncedvee-eye) text editor. vi is a simpleapplicationthat
openswithin theshellpromptandallows you to view, search,andmodify text �les. To startvi, type
vi at ashellprompt.To opena �le with vi typevi � filename � ata shellprompt.

Figure7-9.vi

By default, vi opensa �le in Normal mode,meaningthat you canview andrun built-in commands
on the�le but you cannotaddtext to it. To addtext, press[i] (for Insertmode),which allows you to
makeany modi�cationsyouneedto. To exit insertmode,press[Esc],andvi revertsto Normalmode.

To exit vi, press[:] (which is the vi commandmode)andpress[q] then[Enter]. If you have made
changesto the text �le that you want to save, press[:] andtype [w] then[q] to write your changes
to the �le andexit the application.If you accidentallymadechangesto a �le andyou want to exit
vi without saving thechanges,type[:] andthentype [q] followedby [!], which exits without saving
changes.

More informationaboutusingvi canbefoundby typing man vi at ashellprompt.

7.3. Viewing PDFs
A PDF(PortableDocumentFormat)�le is anelectronicimageof a document.PDFcapturesformat-
ting informationfrom avarietyof desktoppublishingapplications,makingit possibleto sendformat-
teddocumentsandhave themappearon therecipient's monitoror printerasthey wereintended.To
view aPDFyou musthave aPDFreader.



82 Chapter 7. Working with Documents

An opensourceapplicationcalledxpdf is includedwith RedHatEnterpriseLinux. Thexpdf toolbarat
thebottomhasnavigationaltoolsthatlet youmovebackwardandforwardthroughthePDFdocument,
aswell asstandardzoom,print, and�nd tools.Thexpdf manpageprovidesusefulinformationonthe
xpdf options.To view thexpdf manpage,atashellprompttypeman xpdf .

Figure7-10.xpdf

To view aPDFwith xpdf:

1. In your desktopenvironment,go to Main Menu => Graphics => PDF Viewer. You canalso
launchxpdf by typingxpdf at ashellprompt.

2. Right-click in thexpdf screento displaya list of options.

3. SelectOpen to displaythe�le browser.

4. SelectthePDF�le youwantto view andclick Open.

AnotherpopularPDFviewer is Adobe Acrobat Reader. While it is not includedwith RedHat En-
terpriseLinux, youcandownloadit freeof chargeat http://www.adobe.com/.



Chapter 8.

Audio, Video, and General Amusement

This chapterpresentsyou with thelighter sideof RedHat EnterpriseLinux. Fromgamesandtoys to
multimediaapplications,RedHat EnterpriseLinux providesmany packagesto assistyou in having
somefun with yourcomputer.

8.1. Playing Audio CDs
To playanaudioCD,placetheCD in yourCD-ROM drive.TheCD Player applicationshouldappear
automaticallyandbegin playing the �rst audio track. If the interfacedoesnot appear, click Main
Menu => Sound& Video=> CD Player to launchtheCD Player application.

Figure8-1.CD Player Interface

TheCD Player interfaceactssimilar to a standardCD player, with play, pause,andstopfunctions.
Thereis evena sliding barthatallows you to adjustthevolume.PresstheNext track andPrevious
Track buttonsto skip forward or backward onetrack; you canalsousethe Track List drop down
menuto selecta trackfrom theavailablelisting.

You canedit thetracklistings for your CDsby clicking theOpen track editor button.You canalso
changetheway theapplicationfunctionsby clicking on theOpen Preferencesbutton.Hereyou can
setthemesfor theplayeraswell assetthebehavior of theCD-ROM drive whenyou openor quit the
CD Player application.

Figure8-2.CD Player Preferences
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8.2. Playing Digital Audio Files
Digital audiohasbecomevery popularin recentyears.Usersenjoy thetechnologybecausethesound
quality is excellent comparedto analogtapeor records,andthe �les arecompact(audio �les can
easilybetransferredacrosstheInternet).

To take advantageof this technology, RedHat EnterpriseLinux includesthepowerful X Multimedia
System(XMMS ), a cross-platformmultimediaplayerwhich allows you to play severaldigital audio
�le formats.

Figure8-3.XMMS Interface

XMMS canbeusedfor morethanjust playingdigital audio�les. By default XMMS canplay Ogg
Vorbis,RIFF wave, andmostmoduleformats.Additionally, XMMS canbeextendedvia pluginsto
playanumberof otherdigital multimediaformats.

To launchXMMS , go to Main Menu => Sound& Video=> Audio Player.

To launchXMMS from ashellprompt,typethecommandxmms.

8.2.1. Using XMMS

To playanaudio�le with XMMS , click theOpenbutton andchoosea�le from theLoad File(s)
window.

Figure8-4.The Load File(s)Window

In Figure8-4, you seethat thereareseveral �les to choosefrom. The�les thatendin .ogg areOgg
Vorbis �les, apopularnew audio�le format,while the .pls �le is anaudioplaylist �le. Youcanuse
XMMS to addaudio�les into a list andthensave it asa playlist.This canbeconvenientif you have
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severalaudio�les andyouwantto categorizethem(for example,by genreor artist).Highlight the�le
youwish to play(if youhavemultiple �les, click andhold themousebuttonanddragit overall of the
�les youwantto open)andclick OK. NoticethatXMMS beginsto playyouraudio�les immediately.
To adjustthevolumeclick anddragthevolumeslider(thelong sliderabove theOpen button)to the
left to lower thevolumeor to theright to increaseit like a CD player. Therearealsobuttonsto stop,
pause,andskip (backwardandforward)youraudio�les.

To learnmoreaboutusingXMMS andits many options,referto themanpageby typing man xmms
ata shellprompt.

8.3. Troub leshooting Your Sound Card
If, for somereason,youdonothearsoundandknow thatyoudohave asoundcardinstalled,youcan
run theSoundCard Con�guration Tool utility.

TousetheSoundCard Con�guration Tool, chooseMain Menu => SystemSettings=> Soundcard
Detection. A smalltext boxpopsuppromptingyou for your root password.

Note

Most sound cards are supported by Red Hat Enterprise Linux, but there are some sound cards that
are not completely compatible or may not work at all. If you are having trouble con�gur ing your sound
card, check the Hardware Compatibility List at http://hardware.redhat.com/hcl/ to see if your card is
supported.

TheSoundCard Con�guration Tool utility probesyoursystemfor soundcards.If theutility detects
a plug andplay soundcard,it automaticallytries to con�gure thecorrectsettingsfor your card.You
canthenclick thePlay test soundbuttonto play a soundsample.If you canhearthesample,select
OK andyour soundcardcon�gurationis complete.

Figure8-5.SoundCard Con�guration Tool

8.3.1. If Sound Card Con�guration Tool Does Not Work

If theSoundCard Con�guration Tool doesnot work (if thesampledoesnot play andyou still do
not have audiosounds),therearealternatives, althoughthey arenot quite assimpleasrunningthe
Sound Card Con�guration Tool. You canedit your modules.conf �le asdiscussedin the next
section(thisstrategy is not recommendedfor mostnew users)or referto thedocumentationthatcame
with yoursoundcardfor moreinformation.
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8.3.1.1. Manual Sound Card Con�guration

If yoursoundcardis notaplugandplaycard,youcanmanuallyedityour /etc/modules.conf �le
to includethesoundcardmodulethatit shoulduse.For example:

alias sound sb
alias midi opl3
options opl3 io=0x388
options sb io=0x220 irq=7 dma=0,1 mpu_io=0x300

For informationoncon�guring soundmanually, referto theLinux SoundHOWTO at theLinux Doc-
umentationProjectwebpage:

http://www.tldp.org/HOWTO/Sound-HOWTO/

8.4. Troub leshooting Your Video Card
Videocardcon�gurationis handledduringtheRedHatEnterpriseLinux installation(referto theRed
Hat Linux Installation Guidefor moreinformation).However, if you did not chooseto con�gure a
videocardat thattime,or if you needto recon�gureyour settings,you canusetheX Con�guration
Tool utility. Youshoulddo this, for example,if you install a new videocard.

Note

The X Con�guration Tool backs up your system's original video con�gur ation �le to
/etc/X11/XF86Con fig .ba ck up in case you need it to switch back to a previous con�gur ation.

To run the X Con�guration Tool, click Main Menu => SystemSettings=> Display. A pop-up
window promptsyou for your root password. You canalsostart from a shell promptby typing the
commandredhat-config-xfree86 , which thenpromptsyou to enteryour root password. If you
areworking from a shellpromptandX is not working, redhat-config-xfree86 attemptsto start
a minimal X sessionto allow you to continueyour con�guration. Follow the instructionsthat ap-
pearon the screen.The X Con�guration Tool attemptsto automaticallycon�gure your video card
andmonitorsettingsfor you. Figure8-6 shows theAdvancedtabfor con�guring your videodevice
manually.

Figure8-6.X Con�guration Tool
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To con�gure your monitormanually, click theAdvancedtab,thenclick theCon�gur e...buttonnext
to theMonitor Type entry. A pop-upwindow displaysa list of monitormodels.Chooseyour model
andclick OK. You canalsolet theX Con�guration Tool probeyour monitor for thecorrectmodel
andvertical/horizontal frequency settings.

To con�gure your video cardmanually, click the Advancedtab, thenclick the Con�gur e...button
next to the Video Card entry. A pop-upwindow displaysa list of video cardmodels.Chooseyour
modelandclick OK. Youcanalsolet theX Con�guration Tool probeyourvideocardfor thecorrect
modelandsettingsby clicking theProbeVideocardbutton.

Whenyou have �nished recon�guringyour videocardandmonitor, you shouldbeableto startanX
sessionandenjoy your graphicaldesktopenvironment.

8.5. Games
PlayinggamesunderRedHat EnterpriseLinux is a fun way to passthetime.Thegamesincludedin
RedHat EnterpriseLinux appealto quitea largenumberof videogameenthusiasts.

Gameavailablity dependson the variantof RedHat EnterpriseLinux you installed.You musthave
thosegamepackagesinstalledbeforethey appearundertheMain Menu => Gamesmenu.Referto the
RedHat EnterpriseLinuxSystemAdministration Guidefor detailson installingadditionalpackages.

To startagame,click Main Menu => Gamesandselectthegameof yourchoice.Figure8-7showsa
fun gamefor kids of all agescalledSameGNOME. In this gameyou point your mouseat matching
marblesuntil they startto spin; then,you canclick themto make themdisappear. Theobjectof the
gameis to make all themarblesdisappear.

Figure8-7.SameGNOME — Match the Marbles Game

8.6. Finding Games Online
Therearemany gamesavailablewithin RedHat EnterpriseLinux andonline.For moreinformation,
herearea few suggestions:

• http://www.linuxgaming.net/— A websitethatcoversLinux-compatiblegamesin depth.

• http://www.tuxgames.com/— A storewhereyoucanbuy gamesjust for Linux.

• http://www.linuxgames.com/— T Linux gamingnews site.

• http://happypenguin.org/ — TheLinux gamingrepository.

You can also browse the Internet for linux games using a search engine, such as
http://www.google.com/.
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Chapter 9.

Working with Digital Cameras

Digital camerashave recentlygrown in popularitybecauseof their increasingimagequalityandeasy
interactionwith desktopPCs.Digital camerascreatehigh-quality imagesthat allow you to sendto
othersovertheInternetor print onacolorprinter. RedHatEnterpriseLinux supportsseveralbrandsof
digital camerasandhasapplicationsthathelpyouaccess,view, andmodify yourdigital photographs.

9.1. Using gtKam
RedHat EnterpriseLinux supportsover 100 digital cameramodels.So,whetheryour camerauses
a USB or serialport to communicatewith your computer, it is likely thatRedHat EnterpriseLinux
supportsit.

gtKam is agraphicalapplicationthatallows you to interfacewith yourdigital camera.gtKam works
directly with your digital camera,allowing you to open,view, save, anddeleteimagesdirectly. You
canalsodownload the imagesto your computerandmodify it with imagemanipulationprograms
suchas The GIMP (refer to Chapter10 Working with Images for more information aboutimage
manipulationtools).

To start gtKam, chooseMain Menu => Graphics => Digital Camera Tool. You can also start
gtKam by typinggtkam at ashellprompt.

Beforeyou begin using gtKam, you needto con�gure it to work with your digital camera.From
themenu,chooseCamera=> Add Camera.... Fromthepop-updialog,youcanchooseyourcamera
from thedrop-down list or let gtKam automatically�nd yourcameraby clicking Detect. Click Apply
to acceptthechangesandOK to closethedialogbox.

Figure9-1.Adding a Camera in gtKam

Onceyou have addedyour camera,it will beshown asanicon on the left panelof themaingtKam
window. You only have to con�gure gtKam for your cameraonce;the settingswill be saved with
eachadditionaluse.

Directoriesshown below theiconmaydiffer dependingonyourbrandof camera.Selectthedirectory
thatcommonlystoresyour imagesandthestoredimageswill immediatelyloadasthumbnailimages
in themainpanel.Fromthispanel,click on theimagesyou want,whichyoucanthensave to diskby
choosingFile => Save SelectedPhotos. If you want to save all of thestoredimages,chooseSelect
=> All , thensave theimagesto disk.
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Figure9-2.Viewing Imageswith gtKam

For moreinformationaboutusinggtKam, referto thegtKam pageat thegPhotowebsite:

http://gphoto.sourceforge.net/proj/gtkam/
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Working with Images

Digital imageshave grown in popularitywith the developmentof the graphicalInternetandthe in-
creasingquality of digital cameras.Thereareseveral typesof image�les, someof which arecreated
usingsophisticatedillustrationsoftwarepackages,while othersaremadefrom digital sourcessuchas
a scanneror camera.You may have downloadedsomeof theseimage�les from theWebor receive
themthemasattachmentsto in anemailmessage.You mayalsowant to createyour own imagesto
sendto others.You canview andmodify the mostcommontypesof image�les usingapplications
includedin RedHat EnterpriseLinux.

10.1. Viewing Images
This sectiondiscussessomeof the commontools for viewing image�les. Certaintools includedin
RedHat EnterpriseLinux arespecializedapplicationsthatenhanceimages;while othersaregeneral-
purpose�le managersthathave integratedimageviewing functionality.

10.1.1. Using Nautilus to View Images

Nautilus is ageneral-purpose�le managerandbrowserfor thegraphicaldesktopenvironment.Nau-
tilus hasmany functionsbeyondsimpleimageviewing; however, for this section,we only useit for
basicimagebrowsing.For moreinformationaboutNautilus, referto Chapter2 UsingtheGraphical
Desktop.

Nautilus is known for its ease-of-useandit handlesimageswith thesameeaseasit doesfor other�le
types.To begin browsingyour imagecollectionwith Nautilus, double-clickyourhomedesktopicon:

This providesa view of all �les andfolderswithin your homedirectory. Double-clicka supported
image�le andNautilus opensthe �le. Figure10-1 illustrateshow Nautilus automaticallycreates
thumbnailsof any imageswithin a folder:

Figure10-1.Contentsof a Folder in Nautilus
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Double-clickon any thumbnailicon to view the imageat its native sizeandthe imageloadswithin
thebrowserwindow. To increaseor decreasethesizeof theviewed imagein Nautilus, click on the
zoombuttonsnext to theLocation: �eld asshown in Figure10-2:

Figure10-2.The Zoom Function in Nautilus

Click the+ buttonto increasethesizeof theimageor - to decreaseit.

10.2. Manipulating Images with the GIMP
TheGNU ImageManipulationProgram(GIMP ) is a powerful applicationthatcancreate,alter, ma-
nipulate,andenhancedigital image�les.

10.2.1. GIMP Basics

To usetheGIMP , youmustknow someof thebasics.StarttheGIMP from thedesktopby choosing
Main Menu => Graphics => The GIMP or from ashellprompt,starttheGIMP usingthecommand
gimp .

Figure10-3illustratesa typical GIMP session.

Figure10-3.The GIMP
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10.2.2. Loading a File

To load an existing �le, selectFile => Open, andthe Load Image dialog appears,asillustratedin
Figure10-4.

Figure10-4.The Load Image Dialog

The Load Image dialog displaysthe working directory, which is the directoryyou arein whenthe
GIMP waslaunched.Youcannavigatethe�le systemtreeby double-clickingon theDirectorieslist
on theleft, thenselectinga �le to openfrom theFiles list on theright.

File namecompletionis supportedby theGIMP . If you type the�rst few lettersof a �le nameinto
theSelection�eld andpressthe[Tab]key, theonly subdirectoriesor �les beginningwith thoseletters
remain.

Onceyou selecta �le, it appearsin the Selection�eld nearthe bottomof the dialog.On the right
sideof the dialog, a thumbnailpreview is displayed.Alternatively, a Generate Preview button is
displayed.If youwantto view a thumbnailof theimage,click on theGeneratePreview button.

After selectinga �le, click on theOK buttonto openit. You canalsodouble-clickon a �le nameto
openit.

10.2.3. Saving a File

To saveanimage�le, right click ontheimageandchooseFile => Save(or Saveas). TheSave Image
dialogappearsif youchooseSave asor if you chooseSave andthe�le hasnotbeensavedbefore.

The Save Image dialog looksalmostexactly like theLoad Image dialog andnavigationof the �le
systemtreeandchoosing�les worksin thesameway.

Whensaving an image,you mustchoosean imageformat. The GIMP supportsa wide variety of
imageformats,including.gif , .png , .jpg , and.bmp .
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10.2.4. GIMP Options

Like many applications,theGIMP providesmorethanonemethodto accomplishtasks.Theeasiest
way to work with imagesis to right-click the image,which displaysa setof menuscontainingmost
of theGIMP 'smany capabilities,includingimagesizing,rotation,and�lter application.

For exampleto make animageappearasif it wasclippedfrom anewspaper, right-click on theimage
within theGIMP andselectFilters => Distorts => Newsprint.... Selectthequantityof linesperinch
usingthesliders.Whenadesiredquantityis reached,click OK to rendertheimagewith thenew effect
applied.Figure10-5shows anexampleof animageaftertheNewsprint... �lter hasbeenapplied:

Figure10-5.An Image Modi�ed with the Newsprint... Filter

TheToolbox palettealsohasseveraleasilyaccessiblefunctions.To bring theToolbox palette,right-
click on the imageand selectTools => Toolbox. Using the Toolbox palette,you can add text to
images,eraseregionsof animage,or even�ll selectedregionswith thecolorof yourchoice.

For example,if you wish to addtext to a �le, selectthe button andclick on your image.This
loadstheText Tool dialogbox,whereyou canchoosea font andtypesometext in theprovidedtext
box.Click OK andthetext is displayedasa �oating sectionontheimage.Youcanthenmovethetext

to thepositionyou wish usingthe Move Layers tool, availableby selectingthe button.Figure
10-6shows thephotowith addedtext:

Figure10-6.Using the Text Tool on an Image
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TheGIMP is a powerful imageeditingtool andit takessometime to masterall of its functions.Try
exploringsomeof theoptionsyourself.If youmakeamistake,youcanalwaysundoyourmistakesby
right-clickingon theimageandchoosingEdit => Undo.

10.3. Additional Resour ces
While this chaptercoversimageapplicationsbrie�y , thereis muchmoredetailedinformationavail-
able.Referto thefollowing resourcesif you areinterestedin learningmoreabouttheapplicationsin
thischapter.

10.3.1. Installed Documentation

Often,softwarepackagesincludecomprehensive documentation.

• TheGIMP manualpagecontainssomeof themoreadvancedcommandline optionsandenviron-
mentvariablesassociatedwith it. You canreadthemanualpageby typing man gimp at a shellor
terminalprompt.TheGIMP alsohasahelpbrowseraccessibleby choosingHelp => Help... from
theGIMP toolbarmenu.

10.3.2. Useful Websites

TheWebhasseveralsitesof interestif you arelooking for moredetailedinformationaboutanappli-
cationcoveredin thischapter:

• http://www.gimp.org/ — Theof�cial GIMP website.

• http://www.rru.com/~meo/gimp/faq-user.html — A FrequentlyAsked Questions(FAQ) list for
questionscommonlyaskedabouttheGIMP by GIMP users(asopposedto developers).

• http://manual.gimp.org/manual/ — TheonlineGIMP UserManual.

• http://gimp-savvy.com/ — The companionwebsiteto the book Grokking the GIMP, by Carey
Bunks.Theentirebookis alsoavailableon thesitefor download

• http://tigert.gimp.org/gimp/ — TheGIMP websiteof tigert (TuomasKuosmanen).

10.3.3. Related Books

If youneedin-depthinformationaboutthemany capabilitiesof theGIMP , try yourfavoritebookstore.
Thefollowing bookswereavailableat thetimeof this writing:

• TheArtists' Guideto theGIMP by MichaelJ.Hammel;FrankKasperandAssociates,Inc.

• GIMP EssentialReferenceby Alex Harford;New RidersPublishing

• GIMP for LinuxBible by StephanieCottrell Bryant,etal; HungryMinds, Inc.

• GIMP: TheOf�cial Handbookby Karin KylanderandOlof S.Kylander;CoriolisGroup

• GrokkingtheGIMP by Carey Bunks;New RidersPublishing

• SamsTeach YourselfGIMP in 24Hours by JoshuaandRamonaPruitt; Sams
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Chapter 11.

Diskettes and CD-ROMs

Using diskettesandCD-ROMs with RedHat EnterpriseLinux requiressomeunderstandingabout
removablemedia.This chapterdiscusseshow to readandwrite �les to andfrom diskettes,how to
format diskettes,andhow to readandcopy datafrom a CD-ROM. This chapteralsocovers using
CD-writableandCD-rewritabledrives.

11.1. Using Diskettes
Diskettesareoneof theoldestremovablemediasolutionsavailablefor thepersonalcomputer(PC).
Diskettesare ideal as a portablestoragesolution for small �les that needto be physicallymoved
around.For example,if two PCsarenotonthesamenetwork, diskettesareagreatsolutionto transfer
�les from onecomputerto theother.

11.1.1. Mounting and Unmounting a Diskette

A diskettemust�rst bemountedbeforeit canbeused.To mounta diskette,insertit into thediskette
drive andtypemount /mnt/floppy/ at ashellprompt.

The diskette drive activity light should blink as the diskette's �le system is mounted to the
/mnt/floppy directory.

You can accessthe contents of the diskette by changing into that directory with the cd
/mnt/floppy/ command.

Alternatively, you canalsomounta disketteby right-clicking on thedesktopandchoosingDisks =>
Floppy. This mountsthedisketteandaddsa desktopicon which you candouble-clickto explorethe
diskettecontents.

Now thatthediskettehasbeenmountedit is availableto becopiedfrom or written to. You canopen,
save,andcopy �les to/fromit asyouwould normallydo to yourharddrive.Youcanevenexplorethe
diskette's contentsin Nautilus (asshown in Figure11-1) or Konqueror.

Figure11-1.Viewing �les on a Diskettewith Nautilus

Whenyou aredoneusingthediskette,youshouldunmountit beforeejectingit from thedrive.To do
this,closeany applicationsthatmaybeusing�les on thedisketteor exploring thediskette's contents
(suchasNautilus or Konqueror), andat ashellprompttypethefollowing command:

umount /mnt/floppy/
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If youareusingGNOME,youcanunmountthedisketteby right-clickingonthe iconandchoosing
Unmount Volume from themenu.

Youcannow safelyejectthediskettefrom thedrive.

11.1.2. Putting Lin ux Files on an MS-DOS Diskette

To copy �les from a Linux machineto an MS-DOSformatteddisketteso that a Windows machine
canreadit you shouldformat your diskettewith an MS-DOS(FAT) �le system.This canbe done
with theWindows OSor with g�oppy (seeSection11.1.3.1Usingg�oppy). Thenmountit in Linux
asdescribedin Section11.1.1MountingandUnmountinga Diskette. Copy �les usingthefollowing
command(substitutingfilename with thenameof the�le youwish to copy):

cp filename /mnt/floppy

Youcanthenunmountthedisketteandejectit from thedrive.Thenew �le onthedisketteshouldnow
beaccessiblefrom yourWindows machine.

11.1.3. Formatting a Diskette

To usea diskettespeci�cally with RedHat EnterpriseLinux, you needto format the disketteusing
theext2 �le system.ext2 is oneof the�le systemssupportedby RedHatEnterpriseLinux, andis the
default methodusedfor formattingdiskettes.

Warning

Formatting a diskette will erase all of its contents. Be sure to backup any �les that you need before
performing any of the following operations on your diskettes.

Onceyouhavecreatedanext2 �le systemonthediskette,youcanmanipulateits contentsin thesame
waysthatyoumanipulatedirectoriesand�les onyour harddrive.

11.1.3.1. Using g�opp y

To startg�oppy , chooseMain Menu => SystemTools=> Floppy Formatter. Fromashellprompt,
type /usr/bin/gfloppy . As shown in Figure11-2, theg�oppy interfaceis smallandhasfew op-
tions. The default settingsare suf�cient for most usersand needs;however, you can format your
diskette with an MS-DOS �le systemtype if necessary. You can also choosethe densityof your
diskette(if youarenotusingtheusualhighdensity3.5"1.44MBdiskette).Youcanalsoelectto quick
formatthedisketteif it waspreviously formattedasext2.
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Figure11-2.g�oppy

Inserta disketteandchangethesettingsin g�oppy to suit your needs;thenclick Format. Thestatus
boxwill appearon topof themainwindow, showing youthestatusof formattingandveri�cation (see
Figure11-3). Oncecomplete,you canejectthedisketteandcloseg�oppy .

Figure11-3.g�oppy StatusBox

11.1.3.2. Using mke2fs

The mke2fs commandis usedto createa Linux ext2 �le systemon a device suchasa harddrive
partition or (in this case)a diskette.mke2fs essentiallyformatsthe device and createsan empty,
Linux-compatibledevice whichcanthenbeusedfor storing�les anddata.

Insertyourdisketteinto thedrive andissuethefollowing commandat ashellprompt:

/sbin/mke2fs /dev/fd0

On Linux systems,/dev/fd0 refersto the �rst diskettedrive. If your computerhasmorethanone
diskettedrive,your primarydiskettedrive is /dev/fd0 , yoursecond/dev/fd1 , andsoon.

Themke2fs utility hasa numberof options.The -c optionmakesthemke2fs commandcheckthe
device for badblocksbeforecreatingthe �le system.The otheroptionsarecoveredin the mke2fs
manpage.

Onceyou have createdanext2 �le systemon the diskette,it is readyto beusedwith your RedHat
EnterpriseLinux system.
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11.2. CD-ROMs
TheCD-ROM format is a popularmediumto deliver typically largesoftwareapplicationsaswell as
multimediagamesandpresentations.Most of the softwarethatcanbepurchasedfrom retail outlets
comein the form of CD-ROMs. This sectionshows you how to useCD-ROMs on your RedHat
EnterpriseLinux system.

11.2.1. Using CD-ROMs with Your File Manager

By default, CDs areautomaticallymountedand the �le manageris displayedallowing you to ex-
plorethecontentsof theCD. Figure11-4shows thecontentsof a CD-ROM within theNautilus �le
manager.

Figure11-4.Contentsof a CD-ROM in Nautilus

A CD desktopicon alsoappears,which you canuseto unmountandejectyour CD-ROM after
use.Right-click on the icon to view all of theavailablechoices.For example,to unmountandeject
theCD-ROM, chooseEject from themenu.

11.2.2. Using CD-ROMs From a Shell Prompt

You canalsomanuallymountandunmountyour CD-ROMs from a shell prompt.Inserta CD into
yourCD-ROM drive,openashellprompt,andtypethefollowing command:

mount /mnt/cdrom

TheCD-ROM shouldnow bemountedandavailablefor usewith your �le manager. You canaccess
yourCD-ROM by clicking thehomeicononthedesktopandtyping /mnt/cdrom in thelocationbar.

After workingwith yourCD, youmustunmountit beforeyou canejectit from your CD-ROM drive.
Closeany applicationsor �le managersthatareusingtheCD-ROM andtypethefollowing command
ata shellprompt:

umount /mnt/cdrom

Youcannow safelypresstheejectbuttononyourCD-ROM drive to retrieve your CD.

11.3. CD-Rs and CD-RWs
CD-writable(CD-R) driveshave grown in popularityasan inexpensive way to backupandarchive
several megabytesof data,including applications,personal�les, andeven multimedia(audio/video
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andstill image)presentations.RedHat EnterpriseLinux includesseveral tools for usingCD-Rsand
CD-rewritable(CD-RW) drives.

11.3.1. Using CD Creator

If youwantto performaquick �le or directorybackupto a CD-Ror CD-RW, thereis a tool included
in theNautilus �le managercalledCD Creator.

CD Creator allows you to draganddrop�les from aNautilus window to theCD Creator interface.
To accesstheCD Creator featurein Nautilus, inserta blankCD-R(W) into your drive andtheCD
Creator window will automaticallydisplay. Youcanalsodoubleclick yourhomedirectoryicon from
thedesktopandchooseGo => CD Creator from thewindow menus.Youcanalsotypeburn: in the
Location barto startCD Creator.

Figure11-5.The CD Creator Interface in Nautilus

Opena new Nautilus window andselectthe �les or directoriesyou want to write to CD-R(W). To
selectmultiple �les, pressandhold the[Ctrl] key, andclick on the�les andfolders.Thenreleasethe
[Ctrl] key, pressandhold the left mousebutton, anddragthe �les andfolders to the CD Creator
window.

Whenyou arereadyto write the �les to your CD-R(W), click the Write to CD button in the CD
Creator window, which displaysa dialogbox whereyou canselectthewriting speed,nametheCD,
andchooseotheroptions.

Figure11-6.The CD Creator Write Dialog Box
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Click theWrite �les to CD buttonto startburning.A statuswindow displaysthewriting progress,as
shown in Figure11-7.

Figure11-7.The CD Creator Write StatusWindow

By default, the CD-R(W) shouldautomaticallyejectfrom your drive whenit is �nished. Sinceit is
generallyrecommendedto periodicallybackuppersonal�les, the CD Creator canhelp you do so
quickly.

11.3.2. Using CD-Rs and CD-RWs with Command Line Tools

If youwantto useashellpromptto write imagesto CD-Ror CD-RWs,therearetwo utilities available:
mkisofs andcdrecord . Theseutilities have severaladvancedoptionsthatarebeyondthescopeof
thisguide;however, for basicimagecreationandwriting, thesetoolssavesometimeoverthegraphical
alternativessuchasX-CD-Roast.

11.3.2.1. Using mkisofs

Themkisofs utility createsISO9660image�les thatcanbewritten to a CD-R(W).Theimagescre-
atedby mkisofs canincludeall typesof �les. It is mostusefulfor archival and�le backuppurposes.

Supposeyou wish to backupa directory called /home/joeuser/ , but exclude the subdirectory
/home/joeuser/junk/ becauseit containsunnecessary�les. You want to createan ISO image
calledbackup.iso andwrite it to CD-R(W)sothatyoucanuseit onyourRedHatEnterpriseLinux
PCat work andyour Windows laptopfor trips. This canbedonewith mkisofs by runningthe fol-
lowing command:

mkisofs -o backup.iso -x /home/joeuser/junk/ -J -R -A -V -v /home/joeuser/

The image is createdin the samedirectory that you ran the command.Table 11-1 explains each
commandline option.For moreinformationon usingmkisofs , refer to the additionalresourcesin
Section11.4AdditionalResources.

You cannow usethe ISO image�le with cdrecord , thecommandline basedCD recordingutility.
For moreinformationaboutusingcdrecord , referto Section11.3.2.2Usingcdrecord .

Option Function

-o Speci�esanoutput�le nameof theISOimage.

-J GeneratesJolietnamingrecords;usefulif theCD is usedin
Windows environments.

-R GeneratesRockRidge(RR) namingrecordsto preserve �lename
lengthandcasing,especiallyfor UNIX/Linux environments.

-A SetsanApplicationID — atext stringthatwill bewritten into
thevolumeheaderof theimagewhichcanbeusefulto determine
whatapplicationsareon theCD.
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Option Function

-V SetsaVolumeID — anamethatis assignedto it if theimageis
burned,andthediscis mountedin SolarisandWindows
environments.

-v Setsverboseexecution,which is usefulfor viewing thestatusof
theimageasit is beingmade.

-x Excludesany directoryimmediatelyfollowing this option;this
optioncanberepeated(for example,... -x /home/joe/trash-x
/home/joe/delete...).

Table 11-1.mkisofs Options

11.3.2.2. Using cdrecord

Thecdrecord utility writesaudio,data,andmixed-mode(acombinationof audio,video,and/ordata)
CD-ROMs usingoptionsto con�gure several aspectsof the write process,including speed,device,
anddatasettings.

To usecdrecord , youmust�rst establishthedeviceaddressof yourCD-R(W)deviceby runningthe
following commandasrootat ashellprompt:

cdrecord -scanbus

This commandshows all CD-R(W) deviceson your computer. It is importantto rememberthe de-
vice addressof thedevice usedto write your CD. The following is anexampleoutputfrom running
cdrecord -scanbus .

Cdrecord 1.8 (i686-pc-linux-gnu) Copyright (C) 1995-2000 Jorg Schilling
Using libscg version 'schily-0.1'
scsibus0:

0,0,0 0) *
0,1,0 1) *
0,2,0 2) *
0,3,0 3) 'HP ' 'CD-Writer+ 9200 ' '1.0c' Removable CD-ROM
0,4,0 4) *
0,5,0 5) *
0,6,0 6) *
0,7,0 7) *

To write thebackup�le imagecreatedwith mkisofs in theprevioussection,switchto theroot user
andtypethefollowing at ashellprompt:

cdrecord -v -eject speed=4 dev=0,3,0 backup.iso

Thecommandsetsthewrite speed(4), thedeviceaddress(0,3,0),andsetswrite output(verbose[-v]),
which is useful for trackingthe statusof the write process.The -eject argumentejectsthe CD-
ROM afterthewrite processis complete.Thesamecommandcanalsobeusedfor burningISOimage
�les downloadedfrom theInternet,suchasRedHatEnterpriseLinux ISO images.

Youcanusecdrecord to blankCD-RW discsfor reuseby typing thefollowing:

cdrecord --dev=0,3,0 --blank=fast
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11.4. Additional Resour ces
Thischapterbrie�y coversseveralapplications.Referto thefollowing resourcesfor moreinformation
abouttheapplicationsin thischapter

11.4.1. Installed Documentation

• cdrecord manpage— Discusseshow to burn data,audioandmixed-modeCD-ROMs. Offers
all optionsandcommandsin detail, including someexamplecommandsfor commonCD-R(W)
burningtasks.

• /usr/share/doc/cdrecord- � version � (where � version � is the versionof cdrecord
installedon your system)— Several documentation�les areincludedwith generalusageandli-
censinginformation.

• mkisofs manpage— Comprehensive detailof theutility, includingsomewarningsaboutcreating
certaintypesof ISO images.Offersall optionsandcommandsin detail, includingsomeexample
commandsfor creatingcommonISO image�les.

• /usr/share/doc/mkisofs- � version � (where � version � is theversionof mkisofs in-
stalledonyour system)— Severaldocumentation�les areincludedwith generalusageandlicens-
ing information.

• /usr/share/doc/dvdrecord- � version � / (where � version � is the version of
dvdrecord installedon your system)— For userswho have DVD-R(+W) devices, this set of
documentationhelps you get startedmasteringDVD-ROMs for data backup and multimedia
presentation.

11.4.2. Useful Websites

• http://freshmeat.net/projects/cdrecord/ — The cdrecord projectpageon Freshmeatis regularly
updatedwith thenewestreleases,news,andusercommentary.

• http://www.freesoftware.fsf.org/dvdrtools/ — The of�cial website of the dvdrtools project,
which includesthedvdrecord utility for writing DVD-R(+W) discs.



III. Troub leshooting Your System

If you ever run into problemsusingyour RedHat EnterpriseLinux system,therearestepsyou can
take andtools you canuseto recover from issuesthatget you backto usingyour systemnormally.
From booting into rescuemodeto changinga forgottenpassword, this part canshow you how to
troubleshootseveralcommonissuesthatyou mayrun into in thecourseof usingRedHat Enterprise
Linux.
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Chapter 12.

Frequentl y Asked Questions

This chapteranswerssomeof the most commonquestionsaboutusingRed Hat EnterpriseLinux
thatyou mayaskasyou becomemorefamiliar with it. Fromrecovering forgottenpasswordsto trou-
bleshootingpackageinstallationproblems,this chapterguidesyou step-by-stepthroughsomecom-
montasksto getyouonyour way.

12.1. Localhost Login and Password
I haveinstalled RedHat EnterpriseLinux. After rebooting, I get a message telling me it needsa
localhostlogin andpassword. Whatare these?

Unlessyouspeci�edahostnamefor yourcomputer, or receivedthatinformationfrom anetwork con-
nection,yourRedHatEnterpriseLinux installationnamesyourmachinelocalhost.localdomain
by default.

Whenyou get to that initial prompt,it is askingyou to log in to your system.If you createda user
accountwith theSetupAgent, youcanlog in usingthatusernameandpassword.If youdid notcreate
a useraccount,thenyou canlog in asthesuperuser, alsoknown asroot . Theroot password is the
systempassword youassignedduringinstallation.

It is highly recommendedthat you createat leastoneuseraccountfor regular useof your RedHat
EnterpriseLinux system.You cancreatea new userafter loggingin asroot with theUser Manager
graphicaltool or theuseradd shellpromptutility. For moreinformation,referto Section1.6Creating
a UserAccount.

12.2. Error Messages During Installation of RPMs
HowdoI install anRPMfroma CD or theInternet?I keepgettinganerror messagewhenI useRPM.

If you aregettinganerrormessagesimilar to failed to open /var/lib/rpm/packages.rpm ,
it is becauseyoudonot have properpermissionto installRPM �les.

Whenyou install software,you areoftenrequiredto make system-widechangeswhichonly root can
make, suchascreatingnew directoriesoutsideof your homedirectoryor makingchangesto your
systemcon�guration.If youareusingyournormaluseraccount,youdonothavepermissionto make
suchchangesby default.

Youneedto betherootuserto installRPM�les. At ashellprompt,switchto therootuserby running
thefollowing command:

su -

After enteringthe root password whenprompted,you shouldthen be able to install the RPM �le
without further errors.For more information aboutusing RPM and PackageManagement Tool,
referto theRedHat EnterpriseLinux SystemAdministration Guideon theRedHat EnterpriseLinux
DocumentationCD or onlineat http://www.redhat.com/docs/.

12.3. Star ting Applications
I installedanapplicationI downloadedfromtheInternet,andeverythingseemedto go �ne, but I still
get command not found whenI typeits name. I think I havethe right name, so why doesit not
start?
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If you are trying to start an application from the shell prompt and it is not working, try
typing out the full directory path before the name of the application's executable (such as
/usr/local/bin/my-executable ).

For example,imaginethatyouhavedownloadedthesetiathome clientapplicationandwantto try
it out.Youfollow thedirectionsfor installingthesoftware,whichcreatesasubdirectoryin yourhome
directorycalledseti/ . Now, starttheapplicationusingthefull pathto theexecutable�le asshown
below:

/home/joe/set i/ se ti at home

The reasonyou may needto type the full pathnamesin orderto startan applicationis becausethe
executablewasnot placedin a directorywhereyour usershell environmentknew it couldbe found
(suchas/usr/local/bin ).

You can customizeyour settingsso that you are not requiredto usethe type the full path to the
applicationeachtime.To do this,youmustedit yourPATH environmentvariable.

12.3.1. Editing Your PATH

If you frequentlystart programsthat are not locatedin a directory that your usershell hasbeen
con�gured to search,you mustedit your usershell con�guration �le to addthedirectorycontaining
theexecutableyou wish to run. You cando this by addingthedirectoryto your PATH environment
variable.

Caution

These instructions are intended only for user accounts. Avoid modifying �les such as the root user's
.bash_profile , because of the potential security risks.

Startatext editor, suchasgedit or vi , atashellprompt.Youcanopenthe�le called.bash_profile
by typing thefollowing:

gedit .bash_profile

Look for aPATH statement,similar to theoneshown below.

PATH=$PATH:$HOME/ bi n: /us r/ lo ca l/ bi n:

To theendof this statement,add$HOME/seti asshown below:

PATH=$PATH:$HOME/ bi n: /us r/ lo ca l/ bi n/ :$ HOME/s et i:

Save the�le andexit thetext editor.

You canthenmake thechangesto .bash_profile take effect immediatelyby typing thefollowing
command:

source .bash_profile

By addingpathsto your .bash_profile , you canplaceutilities andprogramsin your pathandbe
ableto executethemwithout having to type ./ in front of thecommand.
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Tip

For more information about using and con�gur ing your shell prompt refer to Chapter 3 Shell Prompt
Basics.

12.4. Accessing a Windo ws Partition
I havea dual-bootsystemwith RedHat EnterpriseLinux andWindows98. Is there a wayto access
myWindowspartition while I amrunningLinux?

Youcanaccessanotherpartitiononyour system(for example,a Windows partition),in two different
ways.

Youshould�rst determinewhereyourWindowspartitionis locatedbydeterminingwhatphysicalhard
disk your Windows partitionis locatedin (suchastheprimarymasterIDE drive or thethe�rst SCSI
drive).To �nd this information,youcanusetheHardwareBrowser, whichlistsdetailedinformation
aboutthehardwarein yourRedHat EnterpriseLinux system.

To start the Hardware Browser, chooseMain Menu => SystemTools => Hardware Browser.
Figure12-1shows Hardware Browser in action.

Figure12-1.Hardware Browser hard disk device listing

SelectHard Dri ves from the paneland �nd your Windows partition from the Disk Information
displayed.Windows partitionsnormallyusetheFAT or FAT32 �le systemtype.This �le systemtype
canbe mountedand readwithin Linux; however, if your Windows partition usesNTFS, thenyou
cannotmountandreadfrom it asRedHatEnterpriseLinux doesnotsupportNTFS�le systems.Note
theDevice informationfor yourWindowspartition,asthis is thedevice thatyoumountto accessyour
Windows data.

OnceyouhavedeterminedwhereyourWindows partitionis locatedonyourharddrive, log in asroot
(typesu andthenentertheroot password)at ashellprompt.

Createadirectoryin which theWindows partitionis mountedby typing thefollowing command.For
example:

mkdir /mnt/windows
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Beforeyoucanaccessthepartition,youmustmountit in thedirectoryyou just created.As root, type
thefollowing commandatashellprompt(where/dev/hda1 is theWindows partitionyou foundvia
Hardware Browser):

mount -t vfat /dev/hda1 /mnt/windows

Youmaythenlogoutof root usermodeandaccessyourWindows databy changinginto themounted
Windows partition:

cd /mnt/windows

To automaticallymounta Windows partition every time you boot your RedHat EnterpriseLinux
system,you must modify the /etc/fstab �le, which con�gures all �le systemsanddisk device
mountingoptions.

At ashellprompt,su - to root, following theabove example.

Next, openthe /etc/fstab in a text editorby typing (for example):

gedit /etc/fstab

Add the following on a new line (replacing/dev/hda1 with the Windows partition you found via
Hardware Browser):

/dev/hda1 /mnt/windows vfat auto,umask=0 0 0

Save the�le andexit your text editor.

The next time the systemis rebooted,the /etc/fstab �le is read,and the Windows partition is
automaticallymountedin the directory /mnt/windows . To accessthe partition at a shell prompt,
typethecommandcd /mnt/windows . To navigatethroughdirectoriesor �les with spaces,surround
thenameof thedirectoryor �le with quotationmarks,asin ls "Program Files" .

12.5. Finding Commands Quic kly
I waslookingat a manpageyesterday, but I cannotrememberthenameof thecommandI wasreading
about,andI did notwrite it down.Howdo I get themanpage back?

Thecommandyouusedis storedin a �le called.bash_history . By default, this �le recordsthelast
500commandsyou typedat theshellprompt.

Youcanglimpsethehistoryof yourcommandsby typinghistory at theshellprompt,but theresults
aredisplayedtooquickly for you to readevery line.

Anotherway to view .bash_history is with autility suchasless. Typeless .bash_history
at theshell promptandthe resultswill displayonepageat a time. To move forwarda screen,press
the[Space]bar;to movebacka screen,pressthe[b] key, andto quit, press[q].

Pagingthrough.bash_history to �nd a commandcanbe tedious.Alternatively, you cansearch
throughthe�le for keywordsusinggrep , apowerful searchutility.

Say you were readingthe man pagethe day before,but cannotrecall its name.To searchfor the
command,type:

history | grep man

All thecommandsyou typedwhichhave theword manin themarenow highlighted.

Therearemany waysto useyourcommandhistory. For othertipsandtricks,seeSection12.6Tipson
UsingCommandHistory.
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12.6. Tips on Using Command Histor y
WhataresomeotherwaysI canusecommandhistory?

If you type history , a numberedlist scrollsby very quickly, showing you theprevious 500com-
mandsyouhave used.

Youprobablydonotneedto seeall of thelast500commands,sothecommandhistory 20 might
beuseful.Thisway, only theprevious20commandsyoutypedaredisplayed(youcanuseany quantity
asanargumentof thehistory command).

12.6.1. Other Shor tcuts

Hereareothercommandhistoryshortcutswhichmaybeusefulto you:

• "Bang,bang":Typing !! (called"bangbang")executesthelastcommandin thehistory.

• "Bangnumber ": Typing ! number (asin !302 ) executesthecommandwhich is numbered302in
thehistory�le.

• "Bangstring ": Typing ! string (asin !rpm ) executesa commandwith themostrecentmatch-
ing stringfrom thehistory�le.

• [Up arrow] and[down arrow]: At the shell or GUI terminalprompt,you canpressthe up arrow
to move back throughprevious commandsin your history list (the down arrow moves you for-
ward throughthe commands)until you �nd the commandyou want.Press[Enter] to executethe
command,just asif youhadtypedit on thecommandline.

12.7. Keep ls Output from Scrolling
Whenever I typels I canbarelyseetheoutputof thedirectorybecauseit scrolls by tooquickly. How
canI actuallyreadtheoutput?

To preventtheoutputof ls from scrollingby tooquickly, pipetheoutputto autility suchasless or
more . Youarethenableto seetheoutputonescreenatat time.

To readthecontentsof /etc with less , typethefollowing commandat theshellprompt:

ls -al /etc | less

To move forwarda screen,press[Space]bar; to move backa screen,pressthe[b] key; to quit, press
[q].

Youcanachieve thesameresultswith more , anotherpagingutility.

12.7.1. Printing ls Output

You canalsoprint directorylistingsby piping theoutputto a printer in thesameway thatyou piped
theoutputto your screen.If you have con�gureda printer, typethefollowing to pipetheoutputof a
commandto theprinter:

ls -al /etc | lpr
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12.8. Forgotten Password
Help! I forgot myrootpassword. Howdo I log in now?

Youcanlog in usingsingle-usermodeandcreateanew root password.

To entersingle-usermode,rebootyour computer. If you usethedefault bootloader, GRUB, you can
entersingleusermodeby performingthefollowing:

1. At theboot loadermenu,usethearrow keys to highlight the installationyou want to edit and
type[A] to enterinto append mode.

2. Youarepresentedwith a promptthatlookssimilar to thefollowing:
grub append> ro root=LABEL=/

3. PresstheSpacebaronceto addablankspace,thenaddthewordsingle to tell GRUB to boot
into single-userLinux mode.Theresultshouldlook like thefollowing:
ro root=LABEL=/ single

4. Press[Enter] andGRUB will bootsingle-userLinux mode.After it �nishes loading,you will
bepresentedwith ashellpromptsimilar to thefollowing:
sh-2.05b#

5. Youcannow changetherootpassword by typing
passwd root

Youwill beaskedto re-typethepassword for veri�cation. Onceyouare�nished, thepassword
will bechanged.You canthenrebootby typing reboot at theprompt;thenyou canlog in to
root asyounormallywould.

12.9. Password Maintenance
I forgotor wantto change myuseraccountpassword.

Openashellpromptandtypethefollowing:

passwd username

Replaceusername with yournormalusername.

Thepasswd commandwill thenaskfor thenew password, which you will needto entertwice. You
cannow usethenew password to log in to youruseraccount.

12.10. Changing Login from Console to X at Star tup
Howdo I change mylogin fromtheconsoleto thegraphicalscreen?

Insteadof logging in to your systemat the consoleandtyping the startx commandto startthe X
Window System,youcancon�gure your systemsothatyoucanlog in directly to X.

You mustedit one�le, /etc/inittab , by changingjust onenumberin therunlevel section.When
you are �nished, reboot the computer. The next time you log in, you will have a graphicallogin
prompt.

Opena shellprompt.If you arein your user(home)account,changeto theroot userby usingthesu
command:

su -

Now, type gedit /etc/inittab to edit the �le with gedit. The �le /etc/inittab will open.
Within the�rst screen,youwill seea sectionof the�le which lookslike this:
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# Default runlevel. The runlevels used by RHS are:
# 0 - halt (Do NOT set initdefault to this)
# 1 - Single user mode
# 2 - Multiuser, without NFS (The same as 3, if you do not have networking)
# 3 - Full multiuser mode
# 4 - unused
# 5 - X11
# 6 - reboot (Do NOT set initdefault to this)
#
id:3:initdefa ul t:

To changefrom a console to a graphical login, you should changethe number in the line
id:3:initdefault: from a 3 to a 5.

Warning

Change only the number of the default runlevel from 3 to 5.

Yourchangedline shouldlook like thefollowing:

id:5:initdefa ul t:

Whenyou aresatis�edwith yourchange,saveandexit the�le usingthe[Ctrl]-[x] keys.Youwill see
a messagetelling you that the �le hasbeenmodi�ed, andaskingyou to con�rm your change.Type
[Y] for yes.

Now, your next login afterrebootwill befrom thegraphicalscreen.
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Appendix A.

KDE: The K Desktop Envir onment

A.1. Introducing KDE
TheK DesktopEnvironment(KDE) is a graphicaldesktopthatusescommongraphicalobjectssuch
asicons,windows, menus,andpanels;it allows you to accessyour RedHat EnterpriseLinux system
andapplicationsusingyourmouseandkeyboard.

Thisappendixcoversthebasicsof usingKDE: systemnavigation,workingwith �les andapplications,
andcustomizingthedesktopto suit yourneeds.

If youwould like to learnmoreaboutKDE, visit theof�cial websiteathttp://www.kde.org.

A.2. Finding Help
Youcanaccessacomprehensive setof documentationaboutKDE throughtheHelpCenter.

FigureA-1. The HelpCenter

YoucanaccesstheHelpCenter from theMain Menu by selectingHelp. To accessHelpCenter from
thedesktop,right-click on thedesktopandselecttheHelp => K DesktopHandbook.

The openingscreenof the HelpCenter browserappearslike FigureA-1. Fromthis main page,you
canview helpdocumentationon topicssuchasusingandcon�guring thedesktop,working with the
many applicationsincludedwith KDE, andworkingwith theKonquerer �le manager.

A.3. Using The Desktop
OnceyoustartKDE, yourdefault desktoplookssimilar to FigureA-2.
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FigureA-2. A Typical KDE Desktop

TheKDE desktopdisplaysapplicationlaunchers,documentwindows, �le folders,andsoon.Youcan
alsoaccessthemainmenuandcon�gure thedesktopto suit yourneeds.

Thelong baracrossthebottomof thedesktopis thepanel. Thepanelcontainsapplicationlaunchers,
statusindicators,andthedesktopmanager. Youcanhave up to 16 desktopsrunningat thesametime
in KDE. Thepaneltaskbarshows yourcurrentlyrunningapplications.

Iconslocatedon thedesktopcanbe�les, folders,device links, or applicationlaunchers.Click on an
icon to opentheassociatedresource.

The KDE desktopworks similarly to othergraphicaldesktopenvironments.You candraganddrop
�les andapplicationiconsto any locationon the desktop.You canalsoaddnew iconsfor all types
of applicationsandresourcesto thedesktop,panel,or �le manager. Thedesktopitself is alsohighly
customizable.You canchangetheappearanceof buttons,window andframedecorations,andback-
grounds.Con�guration tools arealsoavailablewhich allow you to customizethe way the desktop
behavesat eventssuchassingle-anddouble-clickingmousebuttonsandchordingkeystrokesto cre-
atetime-saving shortcuts.

Thedefault KDE desktopdisplaysiconsfor thetrashcan,your homedirectory, theStart Here icon
for applicationsandcon�gurationtools,andadisketteicon.Youcanaccessany oneof theseresources
by double-clickingon theassociatedicon.

Whenyou right-click on theseicons,you seeseveral optionsfor working with theseresources,such
asDelete, Rename, Move to Trash, andCopy.

Youcandraganddropunwanteditemssuchas�les youno longerneedto theTrash icon.Right-click
on thetrashcanandselectEmpty Trash Bin to deletetheitemsfrom your systempermanently.

A.4. Using The Panel
Thepanelstretchesacrossthebottomof thedesktop.By default, it containsthemainmenuicon and
quick-launchicons for startinga Web browser, email client, word processor, andother commonly
usedapplications.
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FigureA-3. The Panel

The panelis highly con�gurable.You canaddandremove buttonsthat launchapplicationseasily.
Right-click on the panelandselectCon�gur e Panel to openthe panelSettings. You cancon�gure
panelorientationandsize,setapanelhidingcon�guration(wherethepanelremainshiddenuntil you
hoveroverthepanelarea),andcustomizeyourmainmenu.Click Help atany timeto learnmoreabout
con�guring yourpanel.

FigureA-4. Panel Settings

Othertabsin Settingscontainoptionsto furthercustomizeyourpanelandtaskbar. Click onHelp for
moreinformationon theseoptions.

Applicationsandutilities canbeaddedeasilyto thepanel.To addanapplicationlauncherto thepanel,
right-click onthepanelandchooseAdd. ThenselectApplication Button andmakeyourchoicefrom
themenus.

A.4.1. Using The Main Menu

TheMain Menu is thecentralpointfor usingKDE. Clicking ontheMain Menu icononthepanel
displaysalargemastermenufrom whichyoucanperformtaskssuchaslaunchapplications,�nd �les,
andcon�gureyourdesktop.Themainmenualsocontainsseveralsubmenusthatorganizeapplications
andtoolsinto severalcategories,includingGraphics, Internet, Of�ce , Games, andmore.

FromtheMain Menu, you canlock your screen,which displaysa password-protectedscreensaver.
Youcanalsorunapplicationsfrom acommandline aswell aslogoutof your KDE session.

A.4.2. Using Applets

Appletsaresmall applicationsthat run on the panel.Thereareseveral typesof appletsperforming
functionssuchas systemmonitoring, time and datedisplay, and launchingapplicationsby typing
commandsin a text box.

Therearesomeappletsthatrunon thepanelby default.This sectioncoversthemin detail.
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A.4.2.1. Working with Multiple Desktops

By default, KDE provides four desktopsthat you canuseto displaymultiple applicationswithout
having to crowd all of themontoonedesktop.Eachdesktopcanhold icons,openapplications,andbe
individually customized.

For example,while you arewriting a messagein Evolution on desktopone,you canhave Mozilla
browsingtheWebondesktoptwo, theOpenOf�ce.org Writer wordprocessoropenondesktopthree,
andsoon.

Youcanchangethenumberandnamesof desktopsavailablein KDE by makingtheseadjustments:

1. Right-click on thedesktop;abrief menuof actionsis displayed.

2. SelectCon�gur e Desktop; theKDE desktopcon�gurationtool is displayed.

3. Click theMultiple Desktopsicon (seeFigureA-5).

FigureA-5. Virtual DesktopCon�guration

Youcanchangethenamesof yourdesktops(from Desktop1, Desktop2, etc.)by deletingthedefault
namesandtypinganew namein eachdesktop's correspondingtext box.

You canalsochangethenumberof desktopsavailableto you by adjustingtheslider in theNumber
of Desktops. For moredesktops,dragthebarto theright; for fewer desktops,dragthebarto theleft.

The Appearance, Behavior, andPaths, and Background icons are whereyou can make various
desktopcon�gurationchanges.For example,to customizeeachvirtual desktopto havedifferentback-
grounds,click theBackgroundicon, unchecktheCommon Background checkbox,click thevirtual
desktopyouwantto change,andchoosethecoloror imageyouwantto makeyourbackgroundusing
theassociatedtabs.
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FigureA-6. DesktopBackground Con�guration

After youmakeany adjustmentsto yourdesktopcon�guration,click Apply to savethechanges.Click
OK to closethedesktopcon�gurationtool.

Buttonsfor your desktopsappearon the panelin the Desktop Pager. Click on a tile to move to a
differentdesktop.

Tip

You can use the keyboard combination of the [Ctrl] and Function keys to switch desktops. For exam-
ple, [Ctrl]-[F2] switches to desktop two, [Ctrl]-[F3] takes you to desktop three, and so on.

A.4.2.2. Viewing The Taskbar

Thetaskbardisplaysall runningapplications,bothminimizedanddisplayed,onall desktops.

FigureA-7. Applications on the Taskbar

Youcanmaximizerunningapplicationsor bring themto thefront of yourworkingwindowsby click-
ing on theassociateditemon thetaskbar.

Tip

Another way to bring minimized or background windows to the front is to use the [Alt] and [Tab] keys.
To pick an item from the taskbar, hold down both the [Alt]-[Tab] key. To scroll through the tasks, hold
down the [Alt] key, while tapping the [Tab] key. When you have found the task you want to maximize
and bring to the front, release both keys and the application appears on the desktop.
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A.4.3. Adding Icons and Applets to the Panel

To furthercustomizethepanelfor yourparticularneeds,youcanincludeadditionallaunchericonsto
startapplicationswithout usingthemainmenuor Start Here.

To addanew launcherto thepanel,right-click thepanelandchooseAdd => Application Button and
choosetheapplicationor resourceyouwishto addto thepanel.Thisautomaticallyaddsanicononthe
panel.Youcanmovetheiconanywhereyouwantonthepanelby right-clickingtheiconandchoosing
MoveApplication Button, whereApplication is thenameof theapplicationassociatedwith
theicon.

A.4.4. Con�guring the KDE Panel

You canhide the panelautomaticallyor manually, placeit on any edgeof your desktop,changeits
sizeandcolor, andchangetheway it behaves.To alterthedefault panelsettings,right-click thepanel
andchooseCon�gur ePanel. TheSettingswindow appears,allowing youto adjustall panelsettings,
or any oneof thespeci�c properties(Arrangement, Hiding, Menus, andsoon).ChoosetheHiding
tab,click Hide automatically, andadjustthenumberof secondsto elapsebeforethepanelis hidden.
Click Apply thenOK to closetheSettingsdialog.Thepanelremainshiddenuntil youhoverover the
panelareato make it reappear.

A.5. Managing Files
Konqueror is the �le manageranda Webbrowserfor theKDE desktop.Konqueror allows you to
con�gureyourKDE desktop,con�gure yourRedHatEnterpriseLinux system,playmultimedia�les,
browsedigital images,surf theWeb,andmorefrom oneinterface.This sectionexplainssomeof the
waysKonqueror canhelpyouwork with andenjoy yourRedHat EnterpriseLinux system.

To startKonqueror for �le management,click onyourhomedirectoryicon .

Konqueror opensup in a window on your desktop,allowing you to navigate throughyour home
directoryandthroughoutyour RedHat EnterpriseLinux �le system.After exploring,you canreturn
to your homedirectoryby clicking theHome buttonon thetoolbar.

FigureA-8. The Konqueror File Manager
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You cannavigate throughthe �le systemby clicking on folderswithin the main window frameor
throughthehierarchical�le systemviewer on thenavigationpanelasshown in FigureA-8. Filesand
foldersin themainwindow framecanbemovedor copiedto anotherfolder or sentto thetrash.You
canalsodelete�les andfoldersby right-clicking on theitem andchoosingDelete.

Konqueror alsodisplaysthumbnailiconsfor text, images,PostScript/PDF�les, andWeb�les. It can
alsopreview soundsfrom digital audio�les.

A.5.1. The Navigation Panel

Anotherusefulfeatureof Konqueror is thenavigationpanel. This panelappearson the left sideof
the Konqueror �le browser window by default. The navigation panelmakes many of your sytem
resourcesavailableto you in convenienttabbedicons.FigureA-9 shows thenavigationpanel.

FigureA-9. Working with the Navigation Panel

Thenavigationpanelletsyou accessyour Webbookmarks,browsinghistory, network resources,�le
system,andhasabuilt-in mediaplayerfor playingmultimedia�les withouthaving to openaseparate
application.ThenavigationpanelmakesKonqueror anef�cient solutionfor userswhowantfastand
easyaccessto all of their �les andinformation.

A.6. Browsing the Web with Konquer or
Konqueror not only allows you to browseyour local andnetwork �le system,but with component
technologyusedthroughoutKDE, Konqueror is alsoafull featuredWebbrowser, whichyoucanuse
to exploretheWorld Wide Web.

To launchKonqueror chooseMain Menu => Internet => Mor e Internet Applications => Kon-
queror WebBrowser.
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FigureA-10. Welcometo Konqueror

To begin yourWebsession,enteraURL in theLocation �eld. For example:

http://www.redhat.com

Press[Enter] to connectto the webpage.You cannavigatethewebpageusingyour mouseandkey-
board.To scroll up anddown a webpage,click the the scroll bar on the right sideof the browser
window asyou dragthemouseup anddown. You canalsopressthearrow keys on your keyboardto
moveupanddown thewebpage.

If youwantto loadany new contenton thewebpage,click theRefreshbuttonon thetoolbaror press
[F5], which reloadsthepagealongwith any new contentavailable.

To stopapagefrom loading,click theStop buttonon thetoolbaror press[Esc].

To move backto a previously loadedwebpageor move forward to a recentlyloadedpage,click the
Back andForward buttonsor press[Alt] andtheleft or right arrow key to movebackwardor forward
onewebpage,respectively.

Konqueror alsoallows you to loadmultiple pageswithin onebrowserwindow, alleviating theneed
to havemultiplebrowserwindowsopenat thesametime.Konqueror usestabsto accomplishloading
multiple pagesin onewindow. To opena link in a new tab,right-click the link andchooseOpen in
NewTab (or Openin Background Tab if youwantto keepyourcurrenttabontop).Thetabsappear
with theheaderof thewebpagedisplayedfor easyreference.Click thetabof thewebpageyou want
to display. To closea tab,right-click on thetabandchooseCloseTab from themenu.

For additionalinformationon usingKonqueror, click on Help (on thetop menupanel)andthenon
Konqueror Handbook.
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FigureA-11. The KonquerorHandbook

A.7. Using Konquer or to View Images
YoucanalsousetheKonqueror �le managerto view images.If youchoseKDE asyourdefaultdesk-
top environment,click on your homedirectorydesktopicon to accesstheKonqueror �le manager:

.

Using Konqueror asan imagebrowserworks similarly to Nautilus (seeChapter10 Working with
Imagesfor moreinformation).Image�les automaticallygeneratethumbnailimageiconsfor you to
preview within the �le browserwindow. Whenyou double-clickon a thumbnailicon, the browser
displaystheimagein its native size,asshown in FigureA-12.

FigureA-12. Viewing an Image in Konqueror
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To zoomin andout of an image,you �rst needto changethe way Konqueror rendersthe image.
Fromthewindow menu,chooseView => View Mode => Image Viewer Part. This re-displaysthe
imageandallow you to rotateandzoomin on theimageusingthetwo magnifyingglassiconsor the
magni�cationpercentagedrop-down menuon thetoolbar, asshown in FigureA-13.

FigureA-13. Image viewing con�guration on the Konqueror Toolbar

Youcanalsoopentheimagewith moreadvancedimageviewers,aswell aswith The GIMP . Right-
click ontheimage,chooseOpenWith..., thenOther.... A pop-upmenuappearsallowing youto open
the applicationyou wish to use.To launchthe GIMP , chooseGraphics andscroll down the list of
applications.Click on theGIMP iconandclick OK, asseenin FigureA-14.

FigureA-14. The Open With... Dialog Box

A.8. KMail
KMail is anemailtool for KDE. It hasanintuitivegraphicalinterfacesimilar to Evolution thatallows
you to sendandreceive emailusinga graphicalinterface.To openKMail , click on theMain Menu
=> Internet => Mor e Internet Applications => KMail .

Beforeyou canreally useKMail , you mustcon�gure it so it cansendandreceive mail. To run the
con�gurationtool, selectSettingsfrom theKMail toolbar, andclick onCon�gur e KMail .

The Con�gur e Mail Client window consistsof the following sections:Identities, Network, Ap-
pearance, Composer, Security, andFolders. To begin sendingandreceiving messages,you have
to changethe settingsin the Identities andNetwork tabs.Have your email informationfrom your
serviceprovideror administratorhandysothatyoucan�ll in therequiredinformationto begin using
KMail . For additionalinformation,refer to theKMail usermanual(Help => KMail Handbook) or
visit KMail 's homepageathttp://kmail.kde.org.
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FigureA-15. KMail Main Screen

Onceyouhaveyouremailsettingscon�gured,youcanbegin sendingandreceiving email.Thefolders
on the left sideof theKMail screenallow you to view emailsyou have received,emailsreadyto be
sent,emailsyouhave sent,andmore.

To composeamail, click on thenew messageicon in thetool bar:

FigureA-16. KMail NewEmail MessageScreen
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Onceyou have composedamessageandenteredanemailaddressto sendtheemail to, click Sendin

thetoolbar: .

A.9. Customizing KDE
KDE allows you to con�gure the desktopandyour systemto suit your needs.The KDE Control
Center, available by selectingMain Menu => Control Center, lets you customizethe look and
behavior of thedesktop.Thefollowing list explainssomeof thecon�gurationoptionsin detail.

KDE Components

Thissectionletsyoucon�guretheKonqueror �le managerandcustomizecertain�le operations.
You canalsoassociate�les to applicationsthat you prefer (for example,assigningall digital
music�les to openin XMMS insteadof thedefault player).

Appearance& Themes

This sectionsallows you to customizethevisual aspectof your desktopenvironment.You can
customizebackgroundimagesandcon�gure fonts,themes,icons,panelelements,screensavers,
andwindow borderappearance.Youcanalsocustomizemouseandkeyboardeventswhichmakes
workingwith thedesktopasef�cient for your needsaspossible.

Regional& Accessibility

This sectionallows you to setcountryandlanguageoptionsto your particularlocale.For users
with sightor hearingimpairments,you canalsocon�gure accessibilityfeaturessuchasaudible
andvisualcuesandkeyboard/mousecustomization.

SystemAdministration

This sectionis an advancedsystemcon�guration interface.You needyour root password to
con�gure mostof theseoptions.This sectionallows you to install new fonts, con�gure login
management,setsystempaths,andmore.It is stronglyrecommendedthatyouleavethesesettings
at their default valuesunlessyou understandtheconsequencesof changingthem.

WebBrowsing

This sectionallows you to con�gure the Konqueror Web browser. You cancon�gure options
suchascachesizes,websitecookies,plugins,proxy settings(if available),andenhancedbrows-
ing usingkeyword shortcuts.

A.10. Log ging Out of KDE
Therearetwo waysto log out of your KDE session.From the Main Menu, selectLogout User ,
whereUser is your accountusername.To log out from thedesktop,right-click on thedesktopand,
from the menu,selectLogout User whereUser is your accountusername.In either caseclick
Logout andyoursessionends.

FigureA-17. KDE Logout Screen
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Getting Star ted with Gnu Priv acy Guard

Have you ever wonderedif your emailcanbereadduringits transmissionfrom you to otherpeople,
or from otherpeopleto you?Unfortunately, completestrangerscouldconceivably interceptor even
tamperwith youremail.

In traditional(alsoknown as"snail") mail, lettersareusuallysealedwithin envelopes,stampedand
deliveredfrompostof�ce branchto branchuntil they reachtheirdestination.But sendingmail through
theInternetis muchlesssecure;emailis usuallytransmittedasunencryptedtext from server to server.
No specialstepsaretakento protectyour correspondencefrom beingseenor tamperedwith by other
people.

To help you protectyour privacy, RedHat EnterpriseLinux 3 includesGnuPG,the GNU Privacy
Guard, which is installedby default duringa typical RedHat EnterpriseLinux installation.It is also
referredto asGPG.

GnuPGis a tool for securecommunication;it is a completeandfree replacementfor theencryption
technologyof PGP(PrettyGoodPrivacy, awidely popularencryptionapplication).UsingGnuPG,you
canencryptyour dataandcorrespondenceaswell asauthenticateyour correspondenceby digitally
signingyourwork. GnuPGis alsocapableof decryptingandverifying PGP5.x .

BecauseGnuPGis compatiblewith otherencryptionstandards,yoursecurecorrespondenceis proba-
bly compatiblewith emailapplicationsonotheroperatingsystems,suchasWindows andMacintosh.

GnuPGusespublic key cryptography to provide userswith a secureexchangeof data.In a public
key cryptographyscheme,yougeneratetwo keys: a public key andaprivatekey. Youexchangeyour
public key with correspondentsor with akeyserver; youshouldnever revealyourprivatekey.

Encryptiondependsupontheuseof keys. In conventionalor symmetriccryptography, bothendsof
thetransactionhave thesamekey, which they useto decodeeachother's transmissions.In public key
cryptography, two keys co-exist: a public key anda privatekey. A personor an organizationkeeps
theirprivatekey asecret,andpublishestheirpublickey. Dataencodedwith thepublickey canonly be
decodedwith theprivatekey; dataencodedwith theprivatekey canonly bedecodedwith thepublic
key.

Impor tant

Remember that your public key can be given to anyone with whom you want to communicate securely,
but you must never give away your private key.

For themostpart,cryptographyis beyond the scopeof this publication;volumeshave beenwritten
aboutthesubject.In this chapter, however, we hopeyou gainenoughunderstandingaboutGnuPGto
begin usingcryptographyin yourown correspondence.If youwantto learnmoreaboutGnuPG,PGP
andencryptiontechnology, seeSectionB.8 AdditionalResources.

B.1. Con�guration File
The �rst time you run a GnuPGcommand,a .gnupg directory is createdin your homedirectory.
Starting with version 1.2, the con�guration �lename has change from .gnupg/options to
.gnupg/gpg.conf . If .gnupg/gpg.conf is not foundin your homedirectory, .gnupg/options
is used.If you only useversion1.2or higher, it is recommendedthatyou renameyour con�guration
�le with thefollowing command:
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mv ~/.gnupg/options ~/.gnupg/gpg.conf

If you areupgradingfrom a versionprior to 1.0.7,you cancreatesignaturecachesin your keyring to
decreasethekeyring accesstime.To performthisoperation,executethefollowing commandonce:

gpg --rebuild-keydb-caches

B.2. Warning Messages
WhenexecutingGnuPGcommands,youmayseethefollowing message:

gpg: Warning: using insecure memory!

Thiswarningis becausenon-rootuserscannotlock memorypages.If userscouldlock memorypages,
they could perform out-of-memoryDenial of Service(DoS) attacks;thus, it is a possiblesecurity
problem.For details,referto http://www.gnupg.org/(en)/documentation/faqs.html#q6.1.

Youmightalsoseethefollowing message:

gpg: WARNING: unsafe permissions on configuration file "/home/ username /.gnupg/ gpg. con f"

This messageis shown if the �le permissionsof your con�guration �le allows othersto readit. If
you seethis warning,it is recommendedthatyou executethe following commandto changethe�le
permissions:

chmod 600 ~/.gnupg/gpg.conf

Anothercommonwarningmessagesis asfollows:

gpg: WARNING: unsafe enclosing directory permissions on configuration file
"/home/ username /.gnupg/g pg.c onf "

Thismessageis shown if the�le permissionsof thedirectorythatcontainsthecon�guration�le allows
othersto readits contents.If you seethis warning,it is recommendedthatyou executethefollowing
commandto changethe�le permissions:

chmod 700 ~/.gnupg

If youupgradedfrom a previousversionof GnuPG,youmight seethemessage:

gpg: /home/ username /. gnupg/g pg.c onf: 82: deprecated option "honor-http-pr ox y"
gpg: please use "keyserver-opt io ns honor-http-pr ox y" instead

This warningis becauseyour~/.gnupg/gpg.conf �le containstheline:

honor-http-pr ox y

Version1.0.7andhigherprefersadifferentsyntax.Changetheline to thefollowing:

keyserver-opt io ns honor-http-pro xy

B.3. Generating a Keypair
To begin usingGnuPG,youmust�rst generateanew keypair: apublic key andaprivatekey.

To generateakeypair, atashellprompt,typethefollowing command:
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gpg --gen-key

Sinceyou work with your useraccountmostfrequently, youshouldperformthis actionwhile logged
in to your useraccount(not asroot).

You seean introductoryscreen,with key options,including onerecommendedoption (the default),
similar to thefollowing:

gpg (GnuPG) 1.2.1; Copyright (C) 2002 Free Software Foundation, Inc.
This program comes with ABSOLUTELYNO WARRANTY.
This is free software, and you are welcome to redistribute it
under certain conditions. See the file COPYING for details.

Please select what kind of key you want:
(1) DSA and ElGamal (default)
(2) DSA (sign only)
(5) RSA (sign only)

Your selection?

Mostof thescreenswhichrequireyouto chooseanoptionlists thedefault option,within parentheses.
Youcanacceptthedefault optionsby pressing[Enter].

In the�rst screen,youshouldacceptthedefault option:(1) DSA and ElGamal . Thisoptionallows
youto createadigital signatureandencrypt(anddecrypt)with two typesof technologies.Type1 and
thenpress[Enter].

Next, choosethe key size,or how long the key shouldbe. Generally, the longer the key, the more
resistantagainstattacksyour messagesare.Thedefault size,1024bits, shouldbesuf�ciently strong
for mostusers,sopress[Enter].

Thenext optionasksyou to specifyhow long you wantyour key to bevalid. Usually, thedefault (0
= key does not expire ) is �ne. If youdochooseanexpirationdate,rememberthatanyonewith
whomyou exchangedyour public key alsohave to beinformedof its expirationandsuppliedwith a
new publickey. If youdonot chooseanexpirationdate,thenyou areaskedto con�rm your decision.
Press[y] to con�rm your decision.

Yournext taskis to provide auserID thatconsistsof your name,youremailaddress,andanoptional
comment.Whenyouare�nished, youarepresentedwith asummaryof theinformationyouentered.

Onceyouacceptyourchoices,youmustenterapassphrase.

Tip

Like your account passwords, a good passphrase is essential for optimal security in GnuPG. For
example, mix your passphrase with uppercase and lowercase letters, use numbers, or punctuation
marks.

Onceyou enterandverify your passphrase,your keys aregenerated,anda messagesimilar to the
following is displayed:

We need to generate a lot of random bytes. It is a good idea to perform
some other action (type on the keyboard, move the mouse, utilize the
disks) during the prime generation; this gives the random number
generator a better chance to gain enough entropy.
+++++.+++++.+ +++++++. ... ++++++++++.. +++++. +++++. +++++++. +++++++
+++.+++++++++ +++++++++++++++++++++++++++++.. .. .. .. .. .. .. .. .. .. .. .. .. ++++



132 Appendix B. Getting Started with Gnu Privacy Guard

Whentheactivity on thescreenceases,your new keys aremadeandplacedin thedirectory.gnupg
in your homedirectory. To list your keys,usethecommand:

gpg --list-keys

Youwill seesomethingsimilar to thefollowing:

/home/ usernam e/ .g nupg/pu br in g. gpg
------------- -- -- -- -- --- -- -- -- -- -- -- -- -- -
pub 1024D/B7085C8A 2000-06-18 Your Name � you@example.c om 

sub 1024g/E12AF9C4 2000-06-18

If you createda GnuPGkey with version1.0.6or lower, exportedyour privatekey, andimportedit
into a new one,you have to explicitly trustyour own key to sign itemswith version1.0.7or higher.
To trustyourkey, typethefollowing command(replace! user-id " ):

gpg --edit-key # user-id $

At theCommand>prompttypetrust andselect5 = I trust ultimately to trustyourown key.

B.4. Generating a Revocation Certi�cate
Onceyou have createdyour keypair, you shouldcreatea revocationcerti�cate for your public key. If
you forgetyour passphrase,or if it hasbeencompromised,you canpublishthis certi�cate to inform
usersthatyour publickey shouldno longerbeused.

Note

When you generate a revocation certi�cate , you are not revoking the key you just created. Instead,
you are giving yourself a safe way to revoke your key from public use in case you forget your
passphrase, switch ISPs (addresses), or suffer a hard drive crash. The revocation certi�cate can
then be used to disqualify your public key.

Your signatureis valid to otherswho readyour correspondencebeforeyour key is revoked,andyou
areableto decryptmessagesreceivedprior to its revocation.To generatea revocationcerti�cate, use
the--gen-revoke option:

gpg --output revoke.asc --gen-revoke you@example.co m

Notethatif youomit the--output revoke.asc optionfrom theabove,your revocationcerti�cate
is returnedto the standardoutput,which is your monitor screen.While you cancopy andpastethe
contentsof the outputinto a �le of your choiceusinga text editor, it is probablyeasierto sendthe
outputto a �le in your login directory. Thatway, you cankeepthecerti�cate for uselater, or move it
to adisketteandstoreit someplacesafe.

Theoutputlookssimilar to thefollowing:

sec 1024D/823D25A9 2000-04-26 Your Name # you@example.com $

Create a revocation certificate for this key?

Press[Y] to createa revocationcerti�cate for the listedkey. Next, you areaskedto selectthereason
for revocationandprovide anoptionaldescription.After con�rming thereason,enterthepassphrase
youusedto generatethekey.
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Onceyour revocationcerti�cate hasbeencreated(revoke.asc ), it is locatedin your login directory.
Youshouldcopy thecerti�cate to adisketteandstoreit in asecureplace.(If youdonot know how to
copy a �le to a diskettein RedHat EnterpriseLinux, seetheRedHat EnterpriseLinux StepBy Step
Guide.)

B.5. Expor ting your Public Key
Beforeyou canusepublic key cryptography, otherpeoplemusthave a copy of your public key. To
sendyour key to correspondentsor to akeyserver, youmustexport thekey.

To export your key, soyou candisplayit on a webpageor pasteit in email,typethefollowing com-
mand:

gpg --armor --export you@example.com % mykey.asc

Youdonotseeany output,becausenotonly did youexportyourpublickey, youredirectedtheoutput
to a �le called,for example,mykey.asc . (Without the additionof % mykey.asc , the key would
have beendisplayedasthestandardoutputon themonitorscreen.)

Now, the �le mykey.asc canbe insertedinto emailor exportedto a keyserver. To seethekey, type
less mykey.asc to openthe �le in a pager(type [q] to quit the pager).It shouldlook like the
following:

-----BEGIN PGP PUBLIC KEY BLOCK-----
Version: GnuPG v1.2.1 (GNU/Linux)
Comment: For info see http://www.gnu pg.o rg

mQGiBDkHP3URBACkWGsYh43pkXU9wj /X 1G67K8/D Sr l8 5r 7dNt HNfL L/ ewil 10k2
q8saWJn26QZPsDVqdUJMOdHf J6 kQTAt9 NzQbgc Vr xL YNfg eBsv kHF/ POtn YcZRgL
tZ6syBBWs8JB4 xt 5V09iJ SGAMPUQE8Jp dn2aRXPApdoDw179LM8Rq6r+ gwCg5ZZa
pGNlkgFu24WM5wC1z g4QTbMD/3 MJCSxf L99Ek5 HXcB3y hj +o0LmIrGAVBgoWdr Rd
BIGjQQFhV1NSwC8YhN/ 4nGHWpaTxgEtn b4CI 1wI/ G3DK9olY MyRJin kGJ6 XYfP 3b
cCQmqATDF5ugIAmddit nw7deXqn/ eava MxRXJM/R QSgJ Jy VpbAO2OqKe6L6I nb5H
kjcZA/9obTm49 9dDMRQ/C NR92f A5pr 0z ri y/ zi LUow+cqI 59nt +bEb9nY1mfmUN6
SW0jCH+pIQH5l er V+Eook yOyq3oc Udje RYF/ d2jl 9x meSyL2H3tD vn uE6v gqFU/N
sdvby4B2Iku7S /h 06W6GPQAe+pzd yX9v S+Pnf8 os u7W3j6 0Wpr QkUGF1bCBHYWxs
YWdoZXIgPHBhdWxnYWxsQHJl ZGhhdC5j b20+iF YEExECABYFAj kHP3UECwoEAwMV
AwIDFgIBAheAA AoJEJECmvGCPSWpMj QAoNF2zv RgdR/8 or 9pBhu95z eSnk b7AKCm
/uXVS0a5KoN7J 61/1 vEwx11poLkBDQQ5Bz+MEAQA8z tc WRJj W8cHCgLaE402jy qQ
37gDT/n4VS66n U+YI tz DFScVmgMuFRzh ib Lblf O9TpZzxEbSF3T6p9hLLnHCQ1bD
HRsKfh0eJYMMqB3+HyUpNeqCMEEd9AnWD9P4rQtO 7Pes 38sV0l X0OSvs TyMG9wEB
vSNZk+Rl+phA5 5r 1s 8c AAwUEAJjq az vk 0bgFrw 1OPG9m7f EeDl vPSV6HSA0f vz 4w
c7ckfpuxg/URQ Nf 3TJA00Acprk 8Gg8J2 Ct ebAyR/ sP5I sr K5l1 lu Gdk+l0 M85FpT
/cen2OdJtToAF /6 fG nI ke CeP1O5aWTbDgdAUHBRykp dWU3GJ7NS6923f Vg5k hQWg
uwrAiEYEGBECAAYFAjk HP4wACgkQkQKa8YI9 Ja ml iw Cf Xox/ Hj lo rMKnQRJk eBcZ
iLyPH1QAoI33F t/ 0HBqLt qdt P4vWYQRbib jW
=BMEc
-----END PGP PUBLIC KEY BLOCK-----

B.5.1. Expor ting to a Keyser ver

If you areonly writing to a few correspondents,you canexport your public key andsendit to them
personally. If you correspondwith many people,however, distribution of your key canbetime con-
suming.Instead,youcanuseakeyserver.

A keyserver is a repositoryon the Internetwhich canstoreanddistribute your public key to anyone
whorequestsit. Many keyserversareavailable,andmosttry to remainsynchronizedwith eachother;
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sendingyourkey to onekeyserver is like distributing it to themall. A correspondentcanrequestyour
public key from a from a keyserver, import that key to their keyring, andthey arereadyfor secure
correspondencewith you.

Tip

Because most keyservers are synchronized, sending your public key to one keyserver is usually as
good as sending it to them all. You can, however, locate different keyservers. One place to begin your
search for keyservers and more information is Keyserver.Net available at http://www.keyserver.net.

Youcansendyour public key from eithertheshellpromptor from abrowser;of course,youmustbe
onlineto sendor receive keys from akeyserver.

• Fromtheshellprompt,typethefollowing:
gpg --keyserver search.keyserver.ne t --send-key you@example.com

• From your browser, go to Keyserver.Net (http://www.keyserver.net) andselectthe option to add
your own PGPpublic key.

Yournext taskis to copy andpasteyourpublickey into theappropriateareaonthewebpage.If you
needinstructionsonhow to do that,usethefollowing:

• Openyour exportedpublic key �le (suchasmykey.asc , which was createdin SectionB.5
ExportingyourPublicKey) with apager— for example,usethe less mykey.asc command.

• Usingyour mouse,copy the�le by highlightingall the lines from theBEGIN PGPto END PGP
notations(seeFigureB-1).

• Pastethecontentsof the�le mykey.asc into theappropriateareaof thepageonKeyserver.Net
by middle-clickingwith your mouse(or left- andright-clicking if you areusinga two-button
mouse).ThenselecttheSubmit buttonon thekeyserver page.(If youmake a mistake,pressthe
Resetbuttonon thepageto clearyourpastedkey.)
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FigureB-1. Copying Your Public Key

Note that if you aresubmittingyour key to anotherWeb-basedkeyserver, the above transactionis
essentiallythesame.

That is all you needto do. Regardlessof whetheryou usethe shell promptor the Web, you seea
messagethatyour key wassuccessfullysubmitted— eitherat theshellpromptor at thekeyserver's
website.Fromnow on,userswhowantto communicatesecurelywith youcanimportyourpublickey
andaddit to their keyring.

B.6. Impor ting a Public Key
Theotherendof key exchangeis importingotherpeople's public keys to your keyring — is just as
simpleasexporting keys. Whenyou import someone's public key, you candecrypttheir email and
checktheir digital signatureagainsttheirpublic key onyour keyring.

Oneof theeasiestwaysto import akey is to downloadthekey or save it from awebsite.

After downloadinga key andsaving it to the �le key.asc , usethefollowing commandto addit to
yourkeyring.

gpg --import key.asc

Anotherway to save a key is to usea browser's Save As feature.If you areusinga browsersuch
asMozilla, andyou locatea key at a keyserver, you cansave the pageasa text �le (go to File =>
Save PageAs). In thedrop-down boxnext to Files of Type, chooseText Files (*.txt) . Then,you can
import thekey — but rememberthenameof the�le you saved.For example,if you saveda key asa
text �le callednewkey.txt , to import the�le, at ashellprompt,typethefollowing command:

gpg --import newkey.txt

Theoutputlookssimilar to thefollowing:
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gpg: key F78FFE84: public key imported
gpg: Total number processed: 1
gpg: imported: 1

To checkthattheprocesswassuccessful,usethegpg --list-keys command;youshouldseeyour
newly importedkey listedonyourkeyring.

Whenyou importapublickey, youaddthatkey to yourkeyring (a�le in whichpublicandsecretkeys
arekept).Then,whenyoudownloadadocumentor �le from thatentity, youcancheckthevalidity of
thatdocumentagainstthekey youaddedto your keyring.

B.7. What Are Digital Signatures?
Digital signaturescanbe comparedto your written signature.Unlike traditionalcorrespondence,in
which it mightbepossibleto tamperwith yourwritten signature,digital signaturescannotbeforged.
That is becausethe signatureis createdwith your uniquesecretkey and can be veri�ed by your
recipientusingyour publickey.

A digital signaturetimestampsa document;essentially, thatmeansthat thetime you signedthedoc-
umentis part of that signature.So if anyone tries to modify the document,the veri�cation of the
signaturefails. Someemailapplications,suchasExmh or KDE's KMail , includetheability to sign
documentswith GnuPGwithin theapplication's interface.

Two usefultypesof digital signaturesareclearsigneddocumentsanddetachedsignatures. Both types
of signaturesincorporatethesamesecurityof authenticity, without requiringyourrecipientto decrypt
yourentiremessage.

In a clearsignedmessage,your signatureappearsasa text block within the context of your letter;a
detachedsignatureis sentasaseparate�le with yourcorrespondence.

B.8. Additional Resour ces
Thereis moreto encryptiontechnologythancanbecoveredin oneslim introductionto GnuPG.Here
aresomeresourceswhereyoucanlearnmore.

B.8.1. Installed Documentation

• man gpg andinfo gpg — QuickReferenceof GnuPGcommandsandoptions.

B.8.2. Useful Websites

• http://www.gnupg.org — The GnuPGwebsitewith links to the latestGnuPGreleases,a compre-
hensive user's guide,andothercryptographyresources.

• http://hotwired.lycos.com/webmonkey/backend/security/tutorials/tutorial1.html — Visit the
Encryption Tutorial from Webmonkey to learn more about encryption and how to apply
encryptiontechniques.

• http://www.eff.org/pub/Privacy — TheElectronicFrontierFoundation,"Privacy, Security, Crypto,
& Surveillance"Archive.
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B.8.3. Related Books

• TheOf�cial PGPUser's Guideby Philip R. Zimmerman;MIT Press

• PGP:PrettyGoodPrivacyby SimsonGar�nkel; O'Reilly & Associates,Inc.

• E-Mail Security:Howto KeepYour ElectronicMessagesPrivateby BruceSchneier;JohnWiley &
Sons



138 Appendix B. Getting Started with Gnu Privacy Guard



Appendix C.

Applications

The following table shows someof the Red Hat Linux applicationsthat are available to perform
many commontasks.Thisis nota completelist of all applicationsavailable. Applicationsin between
(parentheses)denotestheformal nameof theapplication.

Categor y Recommended
Application

Extras

WordProcessors OpenOf�ce.org Writer

Spreadsheets OpenOf�ce.org Calc

Presentations OpenOf�ce.org Impr ess

Chartsand
Diagrams

Dia Kchart , Ki vio, XFig

Graphics The GIMP Icon Editor (K Icon Editor)

ImageViewers Nautilus Eye of Gnome

Digital Cam-
eras/Scanners

Digital CameraTool
(gtKam), Scanning
(XSane)

Scanand OCR Program (Kooka), The GIMP

PDAs Jpilot Evolution

CD Recording CD Creator, cdrecord

Text Editors Text Editor (gedit) nano , vi

EmailClients Evolution Mozilla Mail , mutt

WebBrowsers Mozilla Konquerer links

Chat/Instant
Messaging

MessagingClient (GAIM) IRC Client (X-Chat), KSir c

PDF/PostScript
Viewers

xpdf GNOME Ghostviewer

Project
Management

Project Management
(MrPr oject)

Fax Fax Viewer (KFax)

Sound Audio Player (XMMS) ,
CD Player (GNOME CD),
SoundRecorder
(GNOME Sound),Volume
Control (GNOME Volume
Control)

Kaboodle, aumix , KDE SoundMixer , KMid

Table C-1. Applications
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Appendix D.

A Comparison of Common DOS and Lin ux
Commands

Many Linux commandstypedat ashellpromptaresimilar to thecommandsyouwould typein DOS.
In fact,somecommandsareidentical.

This appendixprovidescommoncommandsusedat the DOS prompt in Windows andtheir coun-
terpartsin Linux. Basicexamplesof how the commandareusedat the Linux shell promptarealso
provided. Note that thesecommandsusuallyhave a numberof options.To learnmore abouteach
command,readits associatedmanpage(for example,typeman ls at theshellpromptto readabout
the ls command).

Command' s
Purpose

MS-DOS Lin ux Basic Lin ux Example

Copies�les copy cp cp thisfile.txt /home/ thisdirectory

Moves�les move mv mv thisfile.txt /home/ thisdirectory

Lists �les dir ls ls

Clearsscreen cls clear clear

Closesshell
prompt

exit exit exit

Displaysor sets
date

date date date

Deletes�les del rm rm thisfile.txt

"Echoes"outputto
thescreen

echo echo echo this message

Editstext �les edit gedit (a) gedit thisfile.txt

Comparesthe
contentsof �les

fc diff diff file1 file2

Findsastringof
text in a �le

find grep grep word or phrase thisfile.txt

Formatsa diskette format a:
(if diskette
is in A: )

mke2fs /sbin/mke2fs /dev/fd0 (/dev/fd0 is the
Linux equivalentof A: )

Displayscommand
help

command
/?

manor
info

man command

Createsadirectory mkdir mkdir mkdir directory

Views contentsof a
�le

more less (b) less thisfile.txt

Renamesa �le ren mv(c) mv thisfile.txt thatfile.txt
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Command' s
Purpose

MS-DOS Lin ux Basic Lin ux Example

Displaysyour
locationin the�le
system

chdir pwd pwd

Changesdirectories
with aspeci�ed
path(absolute
path)

cd
pathname

cd
pathname

cd /directory/directory

Changesdirectories
with a relativepath

cd.. cd .. cd ..

Displaysthetime time date date

Shows amountof
RAM in use

mem free free

Notes:
a. Gedit is agraphicaltext editor;othereditorsyoucanusein placeof Gedit includenanoand
vi .
b. Themore pagercanalsobeusedto pagethrougha �le onescreenat a time.
c. Themv commandcanbothmovea �le and,if youwantto renamea �le in thesamedirectory,
"move" that�le to thesamedirectorywith anew name.

Table D-1. Similar Commands
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System Directories

This is a list of theprimaryRedHat EnterpriseLinux systemdirectories.Eachdirectoryis described
brie�y . For additionaldirectoryinformation,refer to theRedHat EnterpriseLinux SystemAdminis-
trationGuideandtheRedHat EnterpriseLinuxReferenceGuide.

• /bin/ — Usedto storeusercommands.Thedirectory/usr/bin/ alsostoresusercommands.

• /sbin/ — Locationof many systemcommands,suchasshutdown . Thedirectory/usr/sbin/
alsocontainsmany systemcommands.

• /root/ — Thehomedirectoryof root, thesuperuser.

• /misc/ — This directory is usedfor automaticallymountingdirectorieson removeabledevices
(suchasZip drives)andremotedirectories(suchasNFSshares)usingautofs . Referto theautofs
manualpage(typeman autofs atashellprompt)for moreinformation.

• /mnt/ — This directory typically containsthe mountpoints for �le systemsmountedafter the
systemis booted.For example,thedefault CD-ROM mountpoint is /mnt/cdrom/ .

• /boot/ — Containsthekernelandother�les usedduringsystemstartup.

• /lost+found/ — Usedby fsck to placeorphaned�les (�les without names).

• /lib/ — Containsmany devicemodulesandlibrary �les usedby programsin /bin/ and/sbin/ .
Thedirectory/usr/lib/ containslibrary �les for userapplications.

• /dev/ — Storesdevice �les.

• /etc/ — Containscon�guration�les anddirectories.

• /var/ — For variable(or constantlychanging)�les, suchaslog �les andtheprinterspool.

• /usr/ — Contains�les anddirectoriesdirectly relatingto usersof thesystem,suchasprograms
andsupportinglibrary �les.

• /proc/ — A virtual �le system(not actuallystoredon thedisk) thatcontainssysteminformation
usedby certainprograms.

• /initrd/ — A directorythatis usedto mounttheinitrd.img image�le andloadneededdevice
modulesduringbootup.

Warning

Do not delete the /initrd/ directory. You will be unable to boot your computer if you delete the
directory and then reboot your Red Hat Enterprise Linux system.

• /tftpboot/ — Contains�les andapplicationsneededfor PrebootExecutionEnvironment(PXE),
aservicethatallows clientmachinesandmachineswithoutharddrivesto bootanoperatingsystem
from animageonacentralPXEserver.

• /tmp/ — Thetemporarydirectoryfor usersandprograms./tmp/ allowsall usersonasystemread
andwrite access.

• /home/ — Default locationof userhomedirectories.

• /opt/ — Directorywhereoptional�les andprogramsarestored.This directoryis usedmainlyby
third-partydevelopersfor easyinstallationanduninstallationof their softwarepackages.
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Appendix F.

Keyboar d Shor tcuts

Herearea few keyboardshortcutsyou canuseto performcommontasksquickly. Many moreare
availablein additionto whatis listedhere.For morecommandline andkeyboardshortcuts,visit:

http://sunsite.dk/li nux -ne wbi e/l nag_c ommands.h tml #sh ort cut s

• [Ctrl] + [Alt] + [Backspace]= kills your currentX session.Kills your graphicaldesktopsession
andreturnsyou to thelogin screen.Usethis if thenormalexit proceduredoesnotwork.

• [Ctrl] + [Alt] + [Delete]= shutdown andrebootsyour RedHat EnterpriseLinux systemat a non-
graphicalshellprompt.Useonly whenthenormalshutdown proceduredoesnot work. In a graph-
ical desktopsession,this shortcutdisplaysthe desktoplogout screenthat allows you to logout,
reboot,or shutdown yoursystem.

• [Ctrl] + [Alt] + [Fn] = switchesscreens.[Ctrl]+[Alt] + oneof thefunctionkeysdisplaysanavailable
screen.By default, [F1] through[F6] aretext-modeshellpromptscreensand[F7] is thegraphical
desktopscreen.

• [Alt] + [Tab] = switchestasksin a graphicaldesktopenvironment. If you have more than one
applicationopenata time,youcanuse[Alt] + [Tab] to switchamongopentasksandapplications.

• [Ctrl] + [a] = movescursorto the beginning of a line. This works in mosttext editorsandin the
URL �eld in Mozilla.

• [Ctrl] + [d] = logoutof (andclose)shellprompt.Usethis quick shortcutinsteadof typing exit or
logout .

• [Ctrl] + [e] = movescursorto endof a line. This worksin mosttext editorsandin theURL �eld in
Mozilla.

• [Ctrl] + [l] = clearstheterminal.This shortcutdoesthesamething astyping clear at a command
line.

• [Ctrl] + [u] = clearsthecurrentline. If you areworking in a terminal,usethis shortcutto clearthe
currentline from thecursorall theway to thebeginningof theline.

• [Middle MouseButton] = pasteshighlightedtext. Usethe left mousebutton to highlight the text.
Point thecursorto thespotwhereyou wantit pasted.Click themiddlemousebuttonto pasteit. In
a systemwith a two-buttonmouse,if you con�guredyour mouseto emulatea third mousebutton,
you canclick boththeleft andright mousebuttonssimultaneouslyto performapaste.

• [Tab] = commandautocomplete.Usethis commandwhenusinga shellprompt.Typethe�rst few
charactersof a commandor �lename andthenpressthe [Tab] key. It will automaticallycomplete
thecommandor show all commandsthatmatchthecharactersyou typed.

• [Up] and[Down] Arrow = shows commandhistory. Whenusinga shellprompt,pressthe[up] or
[down] arrow to scroll througha historyof commandsyou have typedfrom thecurrentdirectory.
Whenyouseethecommandyou wantto use,press[Enter].
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Index

A
accounts

creating,9
appendingstandardoutput,34
applets

addingto KDE panel,122
addingto thepanel,18
on thedesktoppanel,16
panel

in KDE, 119
applications

andRedHatEnterpriseLinux, 139
startingfrom shellprompt,107

archiving �les, 50

B
bunzip2,52
burningCDs,100

additionalresources,104
with CD Creator, 101
with cdrecord,102
with mkisofs,102

bzip2,52

C
cat,32
cd,26
CD-rewritable(CD-RW), 100

additionalresources,104
andCD Creator, 101
andcdrecord,102
andmkisofs,102

CD-writable(CD-R),100
additionalresources,104
andCD Creator, 101
andcdrecord,102
andmkisofs,102

cdrecord,103
CDs,playing,83
chmod,41

numericalsettings,45
clear, 31
commandhistory, 39

tips,111
commands

(Seeshellprompt)
cat,37
cat,using,32
cd,26

changedirectories,26
chmod,41

numericalsettings,45
clear, 31
cron,31
DOS,141
�nding, 110
grep,37
head,37
history, 110
locate,30
ls, 29

keepingoutputfrom scrolling,111
ls -a,29
ls -al, 29
ls, commonoptionswith, 30
multiple,40
print workingdirectory(pwd),26
pwd,26
reset,31
rm

(See�les, deleting)
rm -r

(Seedirectories,deleting)
stringingtogether, 40
su-, 28
tail, 37

commonuserquestions,107
compressing�les, 50
conventions

document,ii
copying andpastingtext

whenusingX, v
creatinggraphics

with OpenOf�ce.org Draw, 79
creatinguseraccounts,9

D
decryption

with GnuPG,129
desktop

(Seegraphicaldesktop)
applets,16
background

changing,20
KDE, 117

desktops
multiple

KDE, 120
devices

digital cameras,89
gtKam,89

digital cameras,89
gtKam,89
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directories
changing,26
copying, 56
deleting,57
descriptions,143
listing contents,29
managing

from shellprompt,25
moving, 57

diskettes,97
formatting,98

mke2fs,99
mounting,97
unmounting,97
using,97

documents,73
OpenOf�ce.org,73
OpenOf�ce.org Writer, 74
PDF, 81
text �les, 79

dot �les
(Seehidden�les)

draganddrop,v
drawing

OpenOf�ce.org Draw, 79

E
emailclients,65

Evolution,66
KMail, 126
Mozilla Mail, 68

Newsgroups,70
mutt,71
plain text, 71

mutt,71
encryption

with GnuPG,129
environmentvariables

PATH, 108
Evolution

(Seeemailclients)
ext2 �le system

and�oppy disks,98

F
FAQ, 107

accessinga Windowspartition,109
�nding previoususedcommands,110
historytips andtricks,111
keepingls outputfrom scrolling,111
login problems,112
permissionsfor installingRPMs,107
startingapplications,107

feedback

contactinformationfor this manual,v

FHS

(SeeFilesystemHierarchyStandard)

�le, 49

�le manager

for KDE, 122

Nautilus,19

�le managers,47

File Roller, 50

�le system

understanding,47

�le types,48

�les

archived,48

archiving,50

with File Roller, 50

compressed,48

compressing,50

with File Roller, 50

copying, 56

copying ata shellprompt,55

creating

touch,55

deleting,57

deletingatashellprompt,55

formats,48

managing

from shellprompt,25

moving, 57

moving atashellprompt,55

renamingatashellprompt,55

typesof, 48

FilesystemHierarchyStandard,48

�oppy disks

(Seediskettes)

formattingdiskettes,98
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G
gamesandamusements,87

�nding moreonline,87
gettingstarted

loggingin, 6
SetupAgent,1

GIMP, 92
openinga �le, 93
saving a �le, 93

GNOMEdesktop
(Seegraphicaldesktop)

GnuPrivacy Guard
(SeeGnuPG)

GnuPG
additionalresources,136
digital signatures,136
exportingpublic key, 133

to keyserver, 133
generatingakeypair, 130
generatinga revocationcerti�cate,132
importinga publickey, 135
insecurememorywarning,130
introduction,129, 129
warningmessages,130

GPG
(SeeGnuPG)

graphicaldesktop,15
applets,18
background

changing,20
customizing,20
loggingoutof, 22
mainmenu,16
Nautilus,19
panel,16
StartHere, 19
using,15
workspace,15

graphicallogin
changingto, 112

graphics
GIMP, 92

gtKam,89
gunzip,52
gzip,52

H
HardwareBrowser, 109
help

with KDE
�nding, 117

hidden�les, 29
history

�nding commandsusing,110

I

images

additionalresources,95

manipulation,91

GIMP, 92

viewing,91, 91

Konqueror, 125

Nautilus,91

introduction,i

K

KDE, 117

applets

adding,122

multiple desktops,120

customizing,128

desktop,117

desktopicons,118

desktops

multiple,120

switching,121

documentation,117

Konqueror

navigationpanel,123

mainmenu,119

panel,118

applets,119

switchingtasks,121

Taskbar, 121

website,117

keyboardshortcuts,145

Webbrowser, 63

KMail

(Seeemailclients)

Konqueror

(SeeWebbrowsers)

KDE �le manager, 122

navigationpanel,123

viewing imageswith, 125
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L

less,36
linux commands

(Seeshellprompt)
listing directories

(Seecommands,ls)
log in, 6
loggingin, 6

graphical,112
graphicallogin, 8
virtual consolelogin, 7

loggingout,12
from thedesktop,22
KDE, 128

login problems
usingsingle-usermode,112

ls, 29
printing output,111
viewing output,111

M

mainmenu
in KDE, 119
on thedesktop,16

mke2fs,99
mkisofs,102
mouse

how to use,v
Mozilla

(SeeWebbrowsers)
Mozilla Mail

(Seeemailclients)
music

OggVorbis,84
Wave,84
XMMS, 84

using,84
mutt

(Seeemailclients)

N

Nautilus,19
disablingtext icons,19
disablingthumbnails,19
viewing imageswith, 91

new users
creatingaccounts,9

Newsgroups
(Seeemailclients)

O

O'Reilly & Associates,Inc.,137
OpenOf�ce.org,73

Draw, 79
features,73
Impress,77
Writer, 74, 75

ownershipandpermissions,41

P

pagers,36
less,36
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